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In This Manual

This document is the self-paced training manual to help you to understand how to use the
Agilent EasyEXPERT software.

Module 1. Getting Started

This module explains the basic operations of the EasyEXPERT. You will learn how to
perform application test, quick test, and tracer test.

Module 2. Data Display and Management

This module explains the data display and analysis capabilities of the EasyEXPERT
software. You will learn how to use analysis tools, how to change display setup, and
how to print/export test result data.

Module 3. Classic Test Environment

This module explains the classic test mode of the EasyEXPERT. You will learn how to
create the classic test setup in the course exercises.

Module 4. Measurement Functions

This module explains the measurement functions available with the EasyEXPERT. You
will learn how to use various measurement functions in the course exercises.

Module 5. Modifying Application Test Definitions

This module explains a modification example of an application test definition. You will
learn how to modify the definition in a course exercise.

Module 6. Creating Your Test Definitions

This module explains about the application test definition. You will learn how to create
your application test definition in a course exercise.

Module 7. Advanced Definitions and Operations

This module explains how to control external GPIB devices, how to call an execution
file, how to perform a repeat measurement, and how to use the prober control script.

Module 8. Miscellaneous Operations

This module explains what is the status indicator, what is the automatic data export
function and the automatic data record function, how to perform selftest and
calibration, how to perform SMU zero offset cancel, and such.



Class Exercises

Class exercises use the test setup listed below. The test setup data are only examples and
included in the Demo.xpg file stored in Agilent B1500 Series Manual CD.

Module Exercise Device Test setup/definition/data Page
Module 1 Id-Vd measurement MOSFET | Id-Vd 1-19
Id-Vg, gm-Vg measurement MOSFET | Vth gmMax 1-27
1d-Vd measurement MOSFET | Trace IdVd 1-31
B2200/E5250 switch control - - 1-54
Module 2 Id-Vg, gm-Vg measurement MOSFET | GMMAX 2-30
Using Preview window - - 2-33
Module 3 Id-Vd measurement MOSFET | Trng Id-Vd 3-27
Multi Channel I/V Sweep Bipolar Tr | Trng Multi 3-39
Measurement LED
I/V List Sweep Measurement MOSFET | Trng List 3-51
I/V-t sampling measurement 0.1 pF Trng Sampling 3-65
C-V sweep measurement MOSFET | Trng CV 3-79
B2200/E5250 switch control - Trng Switch 3-84
Direct Control (C-f measurement) 0.1 uF Trng C-f 3-91
Module 4 SMU pulse mode MOSFET | IDVD-Pulse 4-7
RC measurement 0.1 uF and | RC-sampling-log 4-15
511 kohm
Negative hold time 511 kohm | R-sampl-neg-hold 4-21
Auto analysis MOSFET | GMMAX 4-27
Bias hold function LED LED 4-38
Module 5 Modifying application test MOSFET | Trng IdVd Vth 5-14
definition Trng idvd idvg2 5-29
Trng idvd idvg3 5-32
Using auto analysys twice MOSFET | Vth gmMax and Id 5-34
Using vector data MOSFET | Trng Cgg-Vg 5-42




Module

Exercise Device Test setup/definition/data Page

Module 6

Creating application test definition MOSFET | Trng idvd idvg 6-17

Module 7

no exercise

Module 8

no exercise

NOTE

Demo.xpg file

Demo.xpg file is required to create the Demo preset group which contains the test setup
data used by the class exercises. And it is stored in the \data folder on Agilent B1500 Series
Manual CD.

The Demo preset group should be created before starting the class exercise. To create the
preset group, launch EasyEXPERT and import the file by using the Preset Group Import
dialog box opened by clicking My Favorite Setup > Preset Group > Import Preset Group.
The test setup data are only examples for the class exercises.

Before importing the Demo.xpg file, import the .xtd files stored in the same folder.

NOTE

xtd files

The \data folder stores some .xtd files. They are the application test definitions used by
some class exercises. To use the definition file, import the file by using the Test Definition
Import dialog box opened by clicking Library > Import Test Definition. The test definition
data are only examples for the class exercises.

NOTE

xtr files

The \data folder also stores some .xtr files. They are the sample test results created by
executing the test setup which has the same name as the result data. To display these
sample test results, import the files by using the Test Result Import dialog box opened by
clicking Results > Transport Data > Import.

NOTE

About sample data

The test setup data described in this manual are only examples. If these example data
damage your devices, Agilent is NOT LIABLE for the damage.




Required Devices for Class Exercises

To perform the class exercises, you need the device set (Agilent part number 04156-87001)
which contains the following devices.

Description Quantity
N-channel MOSFET 2 ea.
NPN Bipolar Transistor 1 ea.
Red Miniature LED 1 ea.
0.1 pF Capacitor 50 V 1 ea.
1.0 Q Resistor 1/8 W 1 ea.
1.1 kQ Resistor 1/8 W 1 ea.
511 kQ Resistor 1/8 W 1 ea.
N-ch MOSFET NPN bipolar Transistor LED
Brown Brown
Black Brown
Black Black
Silver i éé Brown
1 ohm Resistor 1.1 kohm Resistor
Green
Brown
Brown
Orange

— S—

511 kohm Resistor 0.1 uF Capacitor



Required Accessories for Class Exercises

To perform the class exercises, you need the following accessories. Prepare the accessories
shown below.

Designation Description Model No. Qty.
1 Test Fixture 2 16442A or 1 ea.

28 pin socket module B 1;(6)34;-2 5F) 1 ea.

Connection wire 6 ea.

2 Triaxial Cable 16494A 4 ea.

3 Interlock Cable 164931 1 ea.

a. The 16058A Test Fixture for the 4145A/B may be substituted for the
16442 A/B Test Fixture. If you use the 16058 A, you also need the 16435A
Interlock Adapter.

28 pin DIP Socket Module (1ea.)
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0000
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000000

° smootmsomny
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Connection Wire (6ea.)

16442A/B Test Fixture (lea.) @ OiC——==—=I0
Triaxial Cable (4ea.)

INTLK Cable (1ea.)






Module 1. Getting Started

* To Launch EasyEXPERT

* To Specify/Create Workspace

* To Perform Application Test

* To Save/Recall Your Test Setup

* To Export/Import Your Preset Group
* To Export/Import Test Record

* To Perform Quick Test

* To Perform Tracer Test

* To Control Switching Matrix

* To Manage Data Display Window

Module 2. Data Display and Management

* Data Display window

*  Graph Analysis Tools

* Data Status

* To Change Graph/List/Display Setup
* To See Print Preview

* To Print Display Data

* To Copy Graph Plot/List Data

* To Save Analysis Result

e To Use Preview Window
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Module 3. Classic Test Environment

* Classic Test Execution Mode

* I/V Sweep Measurement

*  Multi Channel I/’V Sweep Measurement
* I/V List Sweep Measurement

* I/V-t Sampling Measurement

* C-V Sweep Measurement

*  Switching Matrix Control

* Direct Control

Module 4. Measurement Functions

*  SMU Pulsed Sweep Measurement

* I/V-t Sampling Measurement

* Negative Hold Time for High Speed Sampling
* Auto Analysis

* SMU Filter

* Standby Function

* Bias Hold Function
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Module 5. Modifying Application Test Definitions

* To Open Application Test Definition

* To Modify Test Definition

* To Use Debug Tools

* To Use Built-in Functions

* To Add Data Display

* To Use Auto Analysis

* To Use Test Setup Internal Variables

* To Use Auto Analysis twice (as Class Exercise)

* To Use Vector Data (as Class Exercise)

Module 6. Creating Your Test Definitions

*  What is Test Definition

*  What is Test Contents

* To Open Test Definition Editor
* To Define Test Specification

* To Define Test Contents

* Available Elements

* Available Variables

* To Define Test QOutput
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Module 7. Advanced Definitions and Operations

* To Control External GPIB Devices
* To Call Execution Files

* To Perform Repeat Measurements
* Prober Control Script

* Thermo-trigger

Module 8. Miscellaneous Operations

* Function Status Indicator

*  Run Option

* Automatic Data Export and Data Record
* Calibration

¢  Configuration

* XSLT Samples

* To Enable System Controller

* To Start Desktop EasyEXPERT

* To Use 415x Setup File Converter
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Getting Started




In This Module

To Launch EasyEXPERT

* To Specify/Create Workspace

* To Perform Application Test

* To Save/Recall Your Test Setup

* To Export/Import Your Preset Group
* To Export/Import Test Record

* To Perform Quick Test

* To Perform Tracer Test

* To Control Switching Matrix

* To Manage Data Display Window
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Module 1
Getting Started

To Turn on/off BIS00A/B1505A

The Standby button works to turn on the BIS00A/B1505A when it is turned off. When the
B1500A/B1505A is turned on, the Standby button works to terminate the EasyEXPERT software,
Windows, and turn off the B1500A/B1505A.

After the BISO0OA/B1505A is turned on, log on Windows.
The default user is Agilent B1500 User with no password.
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To Launch EasyEXPERT

o Start EasyEXPERT icon

-

e

e s
ol

After logging on, click Start EasyEXPERT button to launch the EasyEXPERT software.

If you do not see the Start EasyEXPERT button, double click the Start EasyEXPERT icon to open
the Start EasyEXPERT window.

This window has the File menu and the Option menu. The File menu is used to close this window.
The Option menu provides the following functions.

*Auto Start of EasyEXPERT: Enables or disables the automatic start function. If this label is
checked, the function is enabled. From the next boot or logon, the Start EasyEXPERT window will
be skipped and EasyEXPERT will be launched. To disable this function, use the Start EasyEXPERT
window opened by the File > Exit menu on the EasyEXPERT main screen. This function is not
effective for Desktop EasyEXPERT.

*Backup EasyEXPERT Database: Used to make backup of the EasyEXPERT database.
*Restore EasyEXPERT Database: Used to restore the EasyEXPERT database.

Note:
Desktop EasyEXPERT provides the following additional functions in the Option menu.

Execution Mode: Used to change the software execution mode.
Move EasyEXPERT Database: Used to move the EasyEXPERT database.
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To Specify Workspace

Case 1 |

Case 2

Case 3

After launching the EasyEXPERT, you will see one of the above screens.
Case 1: If this is the first time to launch the EasyEXPERT

The LCD displays the EasyEXPERT main screen.

Case 2: If the B1500 has one workspace only

Select Yes, and click OK if you use the existing workspace.

The EasyEXPERT main screen is displayed.

Select No, and click Next if you want to create a new workspace.

See next slide.

Case 3: If the B1500 has some workspaces (more than one)

Select workspace you want to use, and click Continue.

The EasyEXPERT main screen is displayed.

If you create workspace, check the Create a new Workspace radio button, and click Continue.

To create a public workspace, check the Allow other users to access this workspace box. The public
workspace can be used by all users.

To create a private workspace, delete the check from the Allow other users to access this workspace
box.

Workspace is the space created in the B1500 internal hard disk drive, and is used to store the test
setup, measurement result data, and so on. The workspace can be created and allocated for each
user.

Work on the same setups and data in the next time and Choose the same Workspace in the next time:

If this check box is checked, the workspace selection screen will be skipped at the next startup and
EasyEXPERT will be launched with the workspace used at the last operation. To perform this setup
again, click the File > Close Workspace menu on the EasyEXPERT main screen.
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Module 1
Getting Started

To Create Workspace

Fle Hep

Agilent EasyEXPERT software manages setups and data in
enclosures known as "Workspaces." Since you want to
start a new session, you should create a new Workspace
with a distinctive name. Please specify a name for the new
workspace:

1 ‘ g =
Mo access this Workspace.

You can also rename a previously definedwory Check this bOX fOr

I = .
2 mm) (O T rer— Public workspace

o

1: New workspace name to create

2: New workspace name to rename

Enter the workspace name and click OK to create/rename the workspace.
If you want to create a public workspace, check the Allow other users to access this workspace box.
The public workspace can be used by all users.

If you want to create a private workspace, delete the check from the Allow other users to access this
workspace box.
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Online Hel
Fie Data uwsulay-
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NanoTech | El
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Conterts | index | Search | . . I~
Agilent EasyEXPERT Online Help
@ Using EzsyEXPERT
4 Classic Test Defintion o “Introduction
@ Application Test Defintion -
@ Funciion Detais ® “Using EasvEXPERT'
A®: Buitn Programming Tool
@ Uity and Software Fumished ® “Classic Test Definition’
@ f You Have a Problem
Precautionary Statemert.  “Application Test Defnition”
www agilent com
s “Function Details
+ “Buittin Proeremmine Toof
e “Utility and Software Fumished'
« “IF You Have a Problem
® Precautionary Statement
@A =
Edition 11: October 2012, for EasyEXPERT revision A05.02
| _[Flag [ Setup
»
To get the latest information:
- To get the latest fimware/software/manual/support information. 2o to
3 www agilentcom and type in EasyEXPERT in the Search field at the top of
& the page.
ritisl Workspace Agilent Technologies _bon

Online Help is available for the B1500 and EasyEXPERT. Select Help > Agilent EasyEXPERT
Help menu to display the online help window. The online help provides the following information.

eIntroduction describes overview, front view, rear view, and measurement units of the B1500.
*Using EasyEXPERT provides the reference information of the Agilent EasyEXPERT software.
*Classic Test Definition provides the reference information of the classic test setup GUI.

*Application Test Definition provides the reference information of the application test definition
setup GUI.

*Function Details explains the measurement functions of the B1500 with EasyEXPERT.

*Built-in Programming Tool provides the reference information of the built-in function, read out
functions, and script programming statements.

+Utility and Software Furnished introduces the utility programs and software furnished with the
B1500 and EasyEXPERT.

*If You Have a Problem describes the problem solving information, the B1500 system maintenance
information, and the error messages.
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File Data Display Help

Application Test

category | (@)1d-Vg Setup Name: [1d-Vg
] BJT = Parameters
g

[ uick Test | Tracer Test | classic Test [Appiication Test

%

1d-Vgl3]

IdRdsGds J

Primary S

IntegTime: W [Description]
Measures the drain currant vs gate voltage characteristics of MOSFET.

[Device Under Test]
MOSFET, 4 terminals

Gata: [slf [Device Parameters’
K Polarity: Nch (

. [ speciied value).
Vvgstart: |— Lg: Gate length

Fbiscrete || olarity: [fich | Lg: [loorm 6] Wg: [10.0 um

| Exercise

[ GenericTest mp: [25.0deg & IdMax: [10.0 mA B

0] Memory

[ Mixedsignal =

Library - |[Fest Parametery T
About Id-Ve B

1d-Va Td-Vg: Id-Vg Characteritics (A.03.20) A

ters]
(SMUs force the specified value) or Pch (SMUs force the negative

Vth gmiax

HEEEEN

% Vastop: E Wg: Gate width | «
Tonloffslope vastep: [ = i | TE Trng 1d-vd
%L/J Source: [SMUS:MP x = N
ALl 7
. 2 )
B = Ting samping
#| [Flag [ Setup Name | Date | Count | Device ID | Remarks lfi
3 I/V Trace 2009/09/18 16:59:38 1 Id-vd
" Vth gmMax and Id 2008/10/02 16:20:46 1
==‘ Charge Pumping 4T 0.1V step  2008/02/05 11:24:50 1
&2 ALWG monitor 2008/02/01 20:36:02 1
ALWG monitor 2008/02/01 20:36:02 1
L PG monitor 2008/02/01 20:35:43 1 =]
finital Workspace ] hermometer OFF [/ Multi Display OFF ] Standby OFF [10] SMU Zero OFF || Auto ExportOFF [ 5€] Auto Record OFF

Application Test tab sets the application test mode.

Test definition can be selected by using Category and Library.

To know about the application test, click the (1) icon. This icon displays the message box that
explains the application test definition. This function will help you to know what is and how to use

the application test.
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Typical Value Selection
.
You do not need to hit the keyboard.
File Data Display  Help
i [category - r@\m-Vg Setup Name: [1-Vg = =
4 B - i
floans > %y
= M0 Diserete J Polarity: [Nch B g: [100om 8] wg: [10.0um B[ Run Option
2 |01 exercise "—J
0] GenericTest Temp: [5.0deg 8] IdMax: [(00mA 8] Count:[0 8] of . Y.
£ |5 wemar e =_Right clicking
3 |0 mixedsignal «
I [ - |[Test Parameters Extended Setup L i S thls ﬁeld
5 xercise
& B = .
i m e isplays th
i| = y A .| displays the
g 1d-vg Drain: [SMU4HR =) 1é-vd menu.
é |E IntegTime: |MEDIUM | vd: o
= . G Secondary Sweep | cut ey 2w
1d-vgl3] oy 50 my. lax
Primary Swee, subs: [SMUBMY pocte ;:g :\‘j |
daL . § e
] Gate: [sMUZHR 2] Q) mr=== v o F s0mv
IdRdsGds vgstart: [soomv & | Vsubsstop: [1.00V & 120y
150 W
éé vgstop: [200V B Vsubsstep: [200 mv 8 v The ValueS are
. amy 100mv
- vostep: [ E] ™ o | defined as
source: [susate 2] Ty
P 500V 1
KU — _’l_l e o s 200 | typlcal Values
al = g samping .
. 3 in the Test
| [Fiag [ Setup Name | Date | Count | Device ID | Remarks [=] e
y 1/V Trace 2009/09/18 16:59:38 1 1d-vd = stomy Definition.
. Vth gmMax and 1d 2008/10/02 16:20:46 1
H Charge Pumping 4T 0.1V step  2008/02/05 11:24:50 1
H ALWG monitor 2008/02/01 20:36:02 1 MORE
ALWG monitor 2008/02/01 20:36:02 1 13
I PG monitor 2008/02/01 20:35:43 1
fnital Workspace [ thermome: ter OFF ||| Multi Display OFF [[0] Standby OFF [0] SMU Zero OFF || Auto Export OFF | E] Auto Record OFF

When you set a test condition of application test, you do not need to use keyboard. You can select
the value from the typical values as shown below.

*Click the entry field of a setup parameter by using the touch screen or the mouse. This displays the
typical values for the specified parameter on the softkeys.

*Select one of the softkeys.

Also you can use the following manner.

*Point the entry field of a setup parameter by using the mouse.

*Right click the mouse to display the popup menu.

*Click the Select menu to display the typical values for the specified parameter.
*Select one from the typical values.

Note:

The typical values are defined in the test definition. And you can change the values by using the
Define typical values window opened by clicking the Typical Values button on the Test Specification
screen of the Test Definition window. For the Test Definition window, see Module 5.
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Screen Keyboard

. Numeric KeyPad ﬁ

v I
L inaanE Py BE
OODON ... 0=
] = e

Variable

A I I

Function

== =

=3 On-Screen Keyboard Q {m
File Keyboard Settings Help
esc F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12 psc = brk
E‘ *11/2 3/ 4/5 6|78 9 0 - = bksp ins| hm pup [nllg] /

tab glwle|r |t y|luli olp|I 1 % del endpdn 7 8 9
alsldlflalnlilelo]:] ] em 4]s]e]”

z|lx]clv]lbln]im]. o) st 1 112]13
ol o BLEOEIED RN E 0 WL

When you need to enter numeric characters in an entry field, you will see the icon at the right side of
the entry field. This icon opens the Numeric KeyPad. You can use this screen keypad instead of the
USB keyboard.

When you need to enter alphabetic characters in an entry field, you will see the icon at the right side
of the entry field. This icon opens the On Screen Keyboard. You can use this screen keyboard
instead of the USB keyboard.

Note that the On Screen Keyboard is not available for DesktopEasyEXPERT runs on Windows 7 64-
bit version.
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To Perf Application Test
e Data Display Help
Category @|1d-vd Setup Name: [i-vd
Device Parameters
Polarity: [ich Il g [lonm 6] we: [l00um 8]
L Temp: 25.0deg 8 IdMax: [10 mA. B
MixedSignal
ibrary [Test Parameters. ‘ Extendedsetup ] || My Favorite Setup-
T-vd pulse u Primary S xercse =
- E rimary Sweej = -
I Drain: [sMuarR_+| And £
= 1d-Vd [(1) : 2006/11/08 13:17:59] - Agilent EasyEXPERT N [l e
16-d pulsel3 T T — = =
CIEAE @ FA-EEL
. Select )| [}
2 19.Vd Charscteristics (A03.20) | SetupName:  [1d-Vd [(1) ; 2006/11/08 13:17:59] X
SECONTIY SWeen
- [X-¥ Graph Plot roper e [Parameters ]
. Gate: [SMUHR ! ¢ Agilent
- 'm MARKER( 1.7000000000E4000 V' 2.3732000000E-002A —— )
L am
op: 200V 8 .
r = 632400 mA-
ﬁ vgstep: [s00 v & Eha Gradient: Gradient:
| S L2300 002
1d-Vg pulse
sm
(]
IE I ’ am
sm
Al | Flag |SetuQ Name |Date
> GUMMEL 2006/11/16 11
. IV Trace 2009/09/18 16 o
= 1dd 2006/ 110813 imercgts-s17578my
g 2006/11/10 14: 0 =
IDVD-Pulse 2006/11/22 19: U el = 22 &) =3 & = e
1DVG 2006/11/15 17: Varain (V) 0 m/dv
Initial The It I
il Workspace '\ Tremmneter GFF [ Wult Display 0 —=——c —
Index | Vagate | Vsource | Vdrain | Vsubs| Idrain | Idrainp enig :H
1 336 5.000 V. ov 1.6000 V ov 22.6840 mA  2.268400000 m...
Test Record List area |3 ov oV i saiamumn
338 5000V oy L7y &y BLN W L3N0 Mm... 7|

Step 1: Click Application Test tab.

Step 2: Select one or more technology categories, and select a desired test from the list of tests
associated with the selected technology categories.

Step 3: Change the setup parameters (Device parameters and Test parameters) if you want.

Step 4: Connect DUT, and click the Single button. The B1500 starts the selected test.
After the measurement, the test result data is displayed on the Data Display window. And the Test
Result Editor shown in the next page is displayed on the lower left area of the B1500 screen if the

Auto Record function or the Auto Export function is set to ON. Check the status indicator at the
bottom of the screen.

Step 5: Analyze the measurement result data.
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Test Result Editor

v Flags: | Important | valid | Questionable |
Delete || ¥ Remaris: | = oK |
* Save/Delete

« ! Important

# Valid

? Questionable

Remarks

OK

The Test Result Editor provides the following GUI to set a flag and remarks to the test result record.

Set the flag and remarks to the test record.

*Save button and Delete button

Divides test records into groups, Save and Delete.

Test records in Save-group are always listed in the lower area of the EasyEXPERT main screen.
Test records in Delete-group can be listed when Results > Filter > Show Deleted Data is checked.
*Flags buttons

The following buttons are available while the left check box has been checked. You can set one of
the following flags.

eImportant ! Button

Sets the important flag (!) to the test result record.

*Valid # button

Sets the valid flag (#) to the test result record.

*Questionable ? Button

Sets the questionable flag (?) to the test result record.

*Remarks field

This field is effective while the left check box has been checked. You can enter characters into this
field. The characters will be recorded as the Remarks value of the test result record.

*OK button

Applies the setup on the Test Result Editor, and closes this dialog box.
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Test Record List Area
Results > Filter > Show Deleted Data
Flag |Setup Name
Flag [ Setup Name ﬂ # |Vth amMax
..|# |Vth gmMax A |# Vth gmMa
ID-VD1 S |? [Vth gmMax
ID-VD1 S |? Vth gmMa
& ! Vth gmMax A 1D-VD1
*_| 1D-VD1 | A ID-VD1
S ID-VD1
L [ ID-VD1
Expand Application Test Results 1 |vth gmMax
! Vth gmMax
F}@g Setup Name * ID-vVD1
#\ Vth gmMax
.[# | Vthgmmay Show All Append Data
ID-VD1
1 |vth
! Vth gmMa
* ID-VD1

The test result records are listed in the test record list area. The area also lists the following data.
*Append measurement data marked with ...

*Deleted data marked with * if Results > Filter > Show Deleted Data is checked

*Test name defined in the application test definition if Results > Filter > Expand Application Test
Results is checked

If Results > Filter > Show All Append Data is checked, all append data will be listed and the symbol
will be changed to A for the data obtained by the Append measurement or S for the data obtained by
the Single measurement.
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e Data Display Help

Category

o = Choose test categories from the left area
] GenericTest

] Memary

01 Mvedsional |«

Library -|

| Quick Test [ Tracar Test | classic Tect | Application Test

w =

a0

My Favorite Setu

-

| Date | Count | Device ID | Remarks

(= [Fiag [ Setup Name
y
"
é

fws1 | I hermameter GFF | Multi Display OFF ()] Stancby OFF |71/ SMUZeo OFF |1, Auto Export GFF | %] Auto Record ON

Single/Append/Repeat measurement

L | <— Single
Append — ISR/ <— Repeat

/

El

EEEEEEN

[

Counter reset

The EasyEXPERT provides three execution modes, Single, Append, and Repeat.

Single button triggers a single measurement.

Append button triggers an append measurement. The measurement results will be appended to the
Data Display window that shows the previous measurement results. The Data Display window can

have maximum 10 layers for displaying measurement results.

Repeat button opens the Repeat Measurement Setup dialog box used to set the repeat measurement

condition. To perform the repeat measurement, see Module 7.

To abort measurement, click Stop button that appears instead of the Single button.

To reset the counter, click the reset button.
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To Save/Recall Your Test Setup

My Favorite Setup button

Fie Dot Denly FoR
§ [caegon_+] O1éva Setup Name: [1£v8 e > |mm
5 [OBr | [Device Parameters T
2 [VERS "+ <
2 [fbseme | Poarity: [ich ] Lg:[100nm 8] wo: [100um  §] SaGioa]
=5 Goneneret Tomp: 07 8] tamax: [0E 6] Counto
2 |0 Memory Device ID:
§ |0 xedsional -] [ 4
S library | -|[Testparameters Extendeasetwp -] ||My Favorite Setup-
8 ~ Al Primary Sweep == —
3 E‘ (2]
E = oraie: [f0m 5] flaf G5
E| wvapuse ~! ALWG monitor
5 4 “u O e
& " D 5 H L
3 @l | 2
=l s °
—| 1¢-vd pulse[3 [ Subs Charge Pumping
- J Socondary Sweep & “} seo Preset Group name.
L] Gate: [SHUZHRI =] . = C;ﬂ Use this field to select
VgStart: [SI0mV & Subs: [SHUBIMP <) iz
= ? 3 [ ] X « preset group.
E vgstop: 200V 8 T \ Q
1d-vd3] vgstep: [foomv 8 Pa ? emo-s-NorFL.
. 3 Endurance
;IH _>ll‘
# ,ﬁ Fowler-Nord... =
L
=| [Flag [ Setup Name | Date | Count | Device ID | Remarks |ﬂ
) IV Trace 2000/09/18 16:50:38 1 1d-vd
. Vth gmMax and 1d 2008/10/02 16:20:46 1
3 Charge Pumping 4T 0.1V step  2008/02/05 11:24:50 1
H ALWG monitor 2008/02/01 1
ALWG monitor 2008/02/01 20: 1
[ PG monitor 2008/02/01 20:. 1 [=]
vl Workepace 2] Thermometer OFF: [ Multi Display OFF 0] Standby OFF [b0] MU Zero OFF 551 Auto Export OFF _[55] Auto Record ON

The test setups you create or modify MUST be saved in a preset group (My Favorite Setup).
To save the setup, click the Save button.

To recall the setup, click the Recall button.

You can organize the setups by using the My Favorite Setup button.

To select the available preset group, use the field below the My Favorite Setup button. In the above
example, the Demo group is selected and listed in the My Favorite Setup list.

To rename, duplicate, or delete the setups, and to add, rename, duplicate, delete, import, or export the
preset group, use the function of the My Favorite Setup button menu or the Organize Preset Group
dialog box shown in the next page.
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To organize preset group for test setup

[ My Favorite Setup] button

File Data Display Help
| category - @ vth gmMax Setup Name: |Ven gmivax
Bl ~|[pevice Parameters
& f|lv Cvos
= M0 oiscrete Polarity: [Nch I} Lg: [100 nm = wg: [100um &
2l pecse
= |0 GenericTest Temp: [25.0 deg [] IdMax: [10.0 mA’ [
# |01 Memory
Mixedsignal x|

§ Osncel

- Preset Group List.

Add

Duplicate
Rename rain: Delete Al Impert Preset Group .
Export D
— vd: [loorv & = Export This Preset Group

Subs: [SMULHP ¥

Vsubs: [0 v (]

Preset Group: Preset Group:
[ = [Exercse =
Setup Name I Setup Name =
Bl BVCES B 1d-vd
B vth gmMax a
e 1to7 (]
all Tmg 1d-vd - ngmmg
@ Tmg Samping 5
» | latmer . -
;é”gmi:’:l:‘ | Count_| Device ID | Remarks |i|
7 & ALWG monkor /09/18 16:59:38 | 1 1d-vd
i Charge Pumping 4T 0.... /10/02 16:20:46 1
43 Demo-S-NorFlash Endu... x| /02/05 11:24:50 1
SelectAll | Unselect Al Select All|  Unselect A /02/0120:36:02 1
(el (| s /02/01 20:36:02 1
Rename)| |[Duplicate| | Delete Rename | |[Duplicate |\ Delete /02/01 20:35:43 1 =l
Multi Display OFF [0 Standby OFF [0 SMU Zero OFF ||5;) Auto Export OFF |[] Auto Record ON

This dialog box is opened by clicking the My Favorite Setup > Preset Group > Organize Preset
Group... menu, and is used to organize the preset group.

*Preset Group List

Lists the preset groups saved in the workspace. The Add, Rename, Duplicate, Delete, Import, and
Export buttons are available to organize the preset groups.

*Copy

Sets the operation of the >> button and the << button. They work as Copy when this check box is
checked, and as Move when this check box is blank.

o>

Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group box.

o<

Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group box.

*Close

Closes the Organize Preset Group dialog box.

*Preset Group

Lists the preset setups saved in the preset group. The Select All, Unselect All, Rename, Duplicate,
and Delete buttons are available to select or organize the setups saved in the preset group.
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File Data Display Help

category _~| @[ Vth gmMax

Setup Name: [Vth gmiax

To Export/Import Your Preset Group

= | —

IntegTime: [MEDIUM ~]

18-Vd pulse]

o Delete
Drain: [SU¢ pelete Al

e B

va: [oomy 8]

Export This Preset Group

i > E

s [Oer - [Device parameters J _ i

2 |w cvnos Py | D a0y

5 ¥ ceeete Polarity: [ich ] P T W [0 ] 1 My Favorite Setup
2. L =
=5 Goneneret Temp: p5des ] ramax: oo ] comtp 5] o] button
# ] Memory Device ID: =

5 |01 Mixedsignal |
O [Gbrary - | [TestParameters Extendeas Oarcel v Favorite Setup- || "

K] = Add New Preset Group

g 2 o Rename This Preset Group

8 " reme Duplicste This Preset Group

| v puse Lrfi= Delete This Preset Group

8

Il

Oreanizs Presst Group

GMax
m,ﬁ Gate: [SMU:HR ¥ Subs: [SMULHR 7] hi<]
_ vgstart: [s00mv 8] | Vsubs: 1V 8 o7
£ Vgstop: 200V 8 « o  —
1-vd[3] vgstep: Frv H] d Preset Group Export BE
. swer: [Gpmseone 5] « ECkEy
]
| - Dero
Ml 1.2
A = Documerts
Z|__|Flag | Setup Name | Date Deson |
y IV Trace 2000/09/18 16:59:31
Y Vth gmMax and Td 2008/10/02 16:20:4
3 Charge Pumping 4T 0.1V step  2008/02/05 11:24:5 4, pocimenss |
g ALWG monitor 2008/02/01 20:36:0:
ALWG monitor 2008/02/01 20:36:0:
[ PG monitor 2008/02/01 20:35:4] 15, Computer
T — [ Trermoeter oFF [t oisplayoFt [of
he
My Fegane = -
Savesstpe:  [EanEXPEART Frese Group Fles

=)

You can export/import your preset group.

To export the present preset group, click the My Favorite Setup > Preset Group > Export This Preset

Group..., and specify the folder and the name of the preset group to export.

To import the preset group, click the My Favorite Setup > Preset Group > Import Preset Group..., and

specify the preset group to import.
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To Export/Import Test Record

Flag | Setup Name

[ Date

[count_[D
T

13:17:59

Gy 7] Olidva Setup Wames [iava L[
Do ~| [Device Parameters ] z
[ cos >
o polarity: ich ] ig: [ooom 8] Wg: [ooum 8] ~ ."
Temp: [50des 8] tamax: oma 8] Counto ] of
Device 10:
=
[Test Parameters. My Favorite Setup~
- - Demo =
& - [
1d-Vd pulse Drain: [SMULHP v »
vdstart: [0V [l o ALWe m -
¢4 vdstop: 500V ) H ﬁﬁ
16-Vd pulsel3’ -
" 5 vstep: [V 8] charge Pumping
Socondany T o e
B Secondary Swoep A 8 S D £ E s H L
1-vd ek i -
vgstart: F50V ] [} 2 SetupTitle Id-vd
b 3 Application Ti-vd Public
E‘; vosop= 207 _H] 4 TestParam Name  Gate Source  Drain  Subs  VeStat  VeStap  VeSten Vs
I VgStep: [L.00V 8 5 TestParam Value SMUZ:HPE SMUSHRE SMUT HPE SMU4:HRE 2 5
2 6 DutParame Neme  Polarity Lg wg Temp  lMax
‘f 7 DutParame Value 1 1.00E-07 1.00E-05 25 004
ol o 8 MetaData TestRecal true
# ] 5 MetaData TestRecol 11/08/2006 131758

10 MetaData TestRecol
11 MetaData  TestRecol 1
12 MetaData TestRecol true

T
ﬂ‘ Parallel 2006/11/08 18:27:18 3 floR e taDsta | TestRe ool
REKELV 2006/11/09 15:21:31 2 14 |MetaData  TestRecol
IDVD 2006/11/10 14:52:24 1 15 MetaData TestRecol 99c92a1 c-65 k-4 081 ~5747-0cck53 02690
Zero-check 2006/11/13 18:20:05 1 16 |AnalysisSe: Analysis i true
17 AnalysisSe Analysis St 0
18 AnalysisSe Analysis St 0
19 AnalysisSe Analysis St -1

-

1. Select data record to export, and right click.
2. Select Transport Data > Export As xxxx.

To export multiple data, select Transport Data > Folder Export.

To export the test result record, specify the data records and select the Transport Data > Export As
XXXX ment.

You can save the data records as an EasyEXPERT file, a CSV file, a XML spreadsheet file, or a
XML file created by using the specified XML style sheet.

You can import the data record exported as the EasyEXPERT file or the XML spreadsheet file.

To import the file, select the Transport Data > Import... Then the Test Result Import dialog box is
opened. On the dialog box, select the file to import.

You can read by using a text editor or a spreadsheet software as shown above. This example reads a
test record exported to a CSV file.

Note:

To export multiple test records, select Transport Data > Folder Export..., and specify the destination
folder and file names automatically set. Then the multiple test records can be exported to the
specified folder.
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Class Exercise

Perform Application Test.

. Connect device (MOSFET). See the following pages.
. Open Id-Vd test definition in the CMOS library.

1
2
3. Change the setup (SMU, output value, etc.)
4.
5
6

Create your preset group, and save your setup.

. Click =3 button to start a single measurement.

. Perform this exercise for the Vth gmMax test

definition.

Note:
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SMU Triax Connection

Force Lines to Fixture 1,2,3,4 Ports

Force side Sense side
AW V4

|

CMU ©060 /

SMU4 -0 ° ©®.@®

16442A/B Fixture

SMU3 ot o

SMU2 & ° i —0.® -
T 0,0

SMU1 o - ©.® -

GNDU @®

B1500A Rear View

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers. On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 - 3.

Your B1500A may not match the SMU configuration shown in this figure. Note that SMU1 is the
module top of the GNDU (ground unit). The SMU number become large from bottom to top as
shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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Jumper Leads - MOS transistor

GNDUE
rO fn®)
s©

O

25 DDDDDDDDDDDDDDD 16088-60002

27 Dy Dual in line package

00000000000000) (28 pin)

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force

and sense, or six SMUs with force only. For this class example we will use the six (6) SMU scheme.

On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is
shown in white reverse background lettering.
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Device Orientation and Insertion

15

s \Ne 00000000

Jgpuoooouooood

Insert the transistor last, 1: Substrate 1
AFTER connecting the 2: Source

cables and leads. Remove 3: Gate

the shorting wire after 4: Drain

insertion in the socket.

The MOS FET leads must be re-arranged into a straight line as shown.

IMPORTANT:

The MOS FET is highly sensitive to electrostatic damage. Touching the bare leads can definitely
destroy the device. The device comes with a special shorting wire attached. Bend the leads the way
you want, insert the device in the socket, and then remove the shorting wire. The wire has a tab. Just
grab the tab and pull straight out. The wire will spiral out as you pull.

Once the shorting wire is removed, you must use a wrist strap when handling the device.
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Result Example

Category _~| @[ 1d-vd Setup Name: [1d-vd
1. check EED -] [Device Parameters
v CMOS
D Discrete J Polarity: [Nch il Lg: [100 nm | wg: [[00um 8|
0 Exercise
0 GenericTest Temp: [25.0 deg ] TdMax: [10 mA’ (]
] Memory
| Mixedsignal »|
Library ~ | [Test Parameters Extended Setup
2. select -
JJE Primary Sweep
select %] [ ] 3, change
d-Vd; 1-Vd Characteristics (A.03.20 Vdstop: [y B
Subs vdstep: [5omv 8]

vgStart: [S00mV B Subs [ExEmE]

lEs | Secnndzy Sweep.
‘%]J Gz. E=aE) Chang‘l 3. change

E Vgstop: [2.00V Vsubs: «
1d-g pulse vgstep: [500mv 8 ?
e
’EE Sollrce {[swuz:r ]|
“ >
- .C ange s L
T
| Flag | Setup Name | Date | Count | Device ID | Remarks |i|
Id-vd 2006/11/08 13:17:59 1
IRVR 2006/11/08 15:59:57 1
Parallel 2006/11/08 18:27:18 3
REKELV 2006/11/09 15:21:31 2
IDVD 2006/11/10 14:52:24 1
Zero-check 2006/11/13 18:20:05 1 ]

Test result data (record) is automatically saved after measurement.

1. Check the CMOS check box.
2. Select Id-Vd (or Vth gmMax) and click the Select button.

3. Change the SMU setting as follows.
Substrate: SMU1
Source: SMU2
Gate: SMU3
Drain: SMU4
4. Create your preset group (ex. Exercise).

5. Save the changed setup to your preset group.

After this class exercise, the Id-Vd setup and the Vth gmMax setup will be saved in your preset
group.
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Result Example

© 1.d - Agilent EasyEXPERT mER|
View Marker Cursor Line Window Help
o e = | Tl mm = 5 N = ey m |;
DaQRX@- WM EREsE-P- 570
Setup Name: |Id*Vd\ X
X-V Graph Plot properties... | |
% Agilent
(&)
10m
E
E)
=]
1.00m
Jdiv
0
1] vdrain (V) 200 m /div 2.
List Display Properties...
Index | Vgatel Vsource | Vdmlnl Vsust Idrain | IdrainPerViig S
1 500 mv oV av ov -3.78 pA -378 fA/um
2 500 mv ov 50 mv ov 1.376 nA 137.6 pAfum [s|
< 12

This is the Id-Vd measurement result example of the following source setup.

Gate voltage: 0.5 Vto2 V, 0.5V step
Drain voltage: 0 Vto 2 V, 0.05 V step
Source voltage: 0 V

Substrate voltage: 0 V
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To Perform Quick Test

Fiie Data Display Help
% My Favorite setup  ~ a ‘
4
Preset Group: [{Dema ~ T

Setup Name Quick TestList —

B
B vth gmMax < Select Al
L '

I Quick thl'rraca Test | Classic Test [ Application Tes

A
‘ Softkeys
v for
{e)
single
/ Down measurement

S

f

© Vor_gmax - Aglnt EasySOERT
dit View Marker Cursor Line Window Help

BB Q (@ - 1 o 5 - FA
I SetupName: [Vi_gmmax x

Proverties... | ]| Y Graph
ot i Aol

x

vt [Czasiy,
amMax [110751 ms

Step 1: Click Quick Test tab.

Step 2: Select the Preset Group.

Step 3: Set the execution ON/OFF and the data record ON/OFF for each test.

Step 4: Connect DUT, and click the Single button. The B1500 starts the selected tests from top to
bottom in the list.

After the measurement, the test result data is displayed on the Data Display window. And the Test
Result Editor is displayed on the lower left area of the B1500 screen if the Auto Record function or
the Auto Export function is set to ON. Check the status indicator at the bottom of the screen.

Step 5: Analyze the measurement result data.

The softkeys placed right side of the LCD are used to trigger a single measurement of the associated
test.
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To organize preset group for test setup

/ My Favorite Setup banner

Fie Dats Display Help

Cancel ]

Duplicate This Preset Group B
Quick Test List
’7 Select All —|‘

Import Preset Group ...
Export This Preset Group ..

ol |
el

Organize Preset Group ...

Organize Preset Group

=
ooy
[FoN

jQuick Test | Tracer Test [ Classic Test | Application Test

Preset Group List
add
Demo Import
g 1d-vil
) |
[edes]
Vth
LEE) omiax
Preset Group: Preset Group:
[ = | [pem |
Setup Name ] Setup Name
g 1d-vd
Vth gmMax
Foomy | [ g7
»
& [Flag [setup Name 3 3‘
4 Vth gmMax
. 1d-vd
3 Trng idvd idvg3 ey
g Trng idvd idvg2
Trng idvd idvg
|| Trng idvd idvg =l
initial Warkspace [T Thermometer :cord ON

This dialog box is opened by selecting the Organize Preset Group function of the My Favorite Setup
banner menu, and is used to organize the test preset group.

*Preset Group List

Lists the preset groups saved in the workspace. The Add, Rename, Duplicate, Delete, Import, and
Export buttons are available to organize the preset groups.

*Copy

Sets the operation of the >> button and the << button. They work as Copy when this check box is
checked, and as Move when this check box is blank.

o>

Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group box.
<<

Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group box.
*Close

Closes the Organize Preset Group dialog box.

*Preset Group

Lists the preset setups saved in the preset group. The Select All, Unselect All, Rename, Duplicate,
and Delete buttons are available to select or organize the setups saved in the preset group.
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Class Exercise

Perform Quick Test.
1. Use the device connection of the previous exercise.
2. Open your preset group.

3. Edit your preset group as you want (changing the test
execution order etc.).

4. Save your preset group.

5. Perform Quick Test.

Note:

1-27



p [ vtn_grmes - Agitent EasyEXPERT B[
File Edit View Marker Cursor Line Window Help
i s - EEHER |5~ FA - ¥ =
R ] EE DR Q 8 - [0 B P o8 5 - BA- 7 i ] 5
% [My Favorite Setup = St e X
L ph Proverties... | | [Parameters ]
5 Preset Group: [Demo = % Aailont N
2 e ey ssoroaan e ) o v
: Narne G | s | e
= S
il am £ N
] sy
B i
z
& 475 4 89
so0m Voats () 20mian 2
3 <] 3]
g [Tt Display. broverties—. ||
= ndex | Voaze] Vource Vo] Vauos] o] am i
e 3 v ov o0 oy o0 Lowizems
3 155V av 1 ov 32un 1a031mS (v
< - {5
I I m—
Vd - Agil 3
fle Edit View Marker Cursor Line Window Help
[] HaQRd-#
Sotup Name: [ivd]
[V Graph piot
S Aaient
®
m
/ é
=] [Fidg [send na __~~ |pae
> th gmM. 4/3/2006 7:07:37 PM || veor
" 1d-V 4/3/2006 7:01:40 PM
= g idvd idvg3 3/31/2006 9:21:00 PM
g Trng idvd idvg2 *
Tmg idvd idvg o Viran (V) 200m/a 2
- Trng idvd idvg 3/31/2006 3:58:54 PM |(stpipiay ]
inital Workspace. [ ] Thermometer OFF [ Multi Display OFF [ idex | vgate| Vsource | varan | veubs | 1dan | raipenvig 4]
1 S0y oV oy ov T 578 e
1] 500 MV, ov 50 mv ov 1376 nA \37SDA’4‘~\‘V\
< i B

Note:
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To Perform Tracer Test

File Data Display Option Help

I/V Trace Setup Name: [|/V Tracel

To add a channel parameter, press the [Add] button in this area.

A Flag | Setup Name | Date | Count | Device ID

» I/V Trace 2009/09/18 16:59:38 1 Id-vd

Y Vth gmMax and Id 2008/10/02 16:20:46 1

= Charge Pumping 4T 0.1V step  2008/02/05 11:24:50 1

g ALWG monitor 2008/02/01 20:36:02 1

ALWG monitor 2008/02/01 20:36:02 1

- PG monitor 2008/02/01 20:35:43 1
fInitial Workspace. |1 Thermometer OFF [ Multi Display OFF [[] Standby OFF  [»0] SMU Zero OFF 5] AutoExport OFF 1] Auto Record ON

Step 1: Click Tracer Test tab.
Step 2: Select and define the source and measurement channels.
Step 3: Set the source output parameters.

Step 4: Connect DUT, and click the Single button to start a single measurement.

After the measurement, the test result data is displayed on the graph area. And the Test Result Editor
is displayed on the lower left area of the B1500 screen if the Auto Record function or the Auto
Export function is set to ON. Check the status indicator at the bottom of the screen.
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Setup Example

@| 1V Trace Setup Name: [I/V Trace

101 &

Compliance:
10oms B

Unit:
SMUZIHR. -

Source:

oy @
= Compliance:
|
!ﬂﬂ- 3 100mA &
¥ Name: I Name: Mode: Function: Meas. Time:
SMOLHF = Vb = [ET] Vo= GOl v = 2us B
=] Add 2
$ SMUZIHR Vs @ Is = Yo COMST w Time:
- SMUSHR = Vg =@ Ig = Vo VARZ v — -2 | si0us B
£ SMUGHR - vd_m Id_m v v VARl ~ T

You can complete the measurement setup by the following steps.
1. Click Add button and add SMU1, SMU2, SMU3, and SMU4.
2. Set the channel definition. See below.

3. Set the X axis parameter, polarity and maximum value.

4. Set the Y axis parameter, polarity and maximum value.

5. Define the VARI1, VAR2, and CONST setup. See below.

Channel definition:
SMUI1: Vsub, Isub, V mode, CONST
SMU2: Vs, Is, V mode, CONST
SMU3: Vg, Ig, V mode, VAR2
SMU4: Vd, Id, V mode, VAR1

Source setup:
VARTI: Stop 0 V, Compliance 100 mA
VAR2: Start 2 V, Stop 5 V, NOS 4, Compliance 10 mA
CONST: Compliance 100 mA

This is the MOSFET Id-Vd measurement setup example.

This measurement setup is effective for the device connection of the Application Test class exercise.
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Class Exercise

Perform Tracer Test.

1.

2
3.
4

Complete the measurement setup shown in the previous page.

Highlight the VAR1 Stop entry field and leave it.
Click button to start a repeat measurement.

YAR1

%

Rotate the rotary knob to change sweep range.

2m

Mode:

I

NDS:

LIN-5GL »

01 B

Compliance:

100 ma &

YAR2

¥

Stark:

Stop:

Step:

NDS:

2w B

SY @

+ &8

Note:
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®|1/v Trace Setup Name: [I/V Trace =
YAR1 ¥
Maode:
LIN-5GL =
Stop:
—
NOS:
101 8
Compliance:
100ms @
VARZ ¥
Start:
zv |
Stop:
sv H
Step:
1v
NOS;
+ B
CONST =
Unik:
SMUZIHR. =
Source:
: oy &
o I BT - [ = Compliance:
BN EERE S el - s g
Unit: ¥ Name:  IName: Mode: Function: (= Meas. Time:
9 SMULHP Wsub Em Isub BB Y ow  CONST v = add 2us B
L SMUZHR = ¥s B Is = ¥ v  CONST Step Time:
8 SMUZHR = vy =@ Ig & Vo VARZ ~ so0us B
8 SMUSHR » vl = Id e v - VARI v

Note:
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Graph Setup and Option Tools

Select reference traces
Capture a reference trace Select tracking traces

Replay traces Marker

Set stop condition area \ / Tangent line
Cancel zoom Regression line
Line/Dot Oscilloscope view (B1505A)
\\‘ 1l / / lColor and thickness
- . V Name:  IName: Mode: Function: . -
To add a channel parameter, press the [Add] button in this ar/

\ .7
Y axis setup X axis setup

Sample setups

Xor Y axis setup: Used to set the X or Y direction forward or reverse, the variables for X-Y plot, the
graph scale linear or log, and the plot polarity positive, negative, or both.

Line/Dot: Used to switch line or dots of trace.

Cancel zoom: This button is available for the graph zoomed in, and is used to return the graph scale
to the original setting. The graph can be zoomed in by the point and drag operation.

Set stop condition area: See “To Use Stop Condition” page.
Replay traces: Opens/closes the dialog box used for managing the record and replay of traces.

Capture a reference trace: Used to capture the trace as the reference trace. Up to 10 traces can be
captured.

Select reference traces: Opens/closes the dialog box used for managing the reference traces.
Select tracking traces: Opens/closes the dialog box used for managing the tracking traces.
Marker: Enables/disables the marker.

Tangent line: Enables the marker and enables/disables the tangent line.

Regression line: Enables the marker and enables/disables the regression line.

Oscilloscope view: Opens/closes the Oscilloscope View window used for monitoring the waveforms
of output signals.

Color and thickness: Opens/closes the dialog box for changing graph color and trace thickness.

Sample setups: See “Sample Setups” page.
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For B1500A

Diode:
BJT:

For B1505A

Diode:
IGBT:
BJT:

MOSFET:

MOSFET:

Sample Setups

ID-VDS, ID-VGS, ID(off)-VDS, BVDSS
IF-VF, IR-VR
IC-VCE, IC-VBE, IC-VCEO, BVCEO

ID-VDS, ID-VGS, ID(off)-VDS, BVDSS

IF-VF, IR-VR

IC-VCE, IC-VGE, IC(off)-VCE, BVCES
IC-VCE, IC-VCEO, BVCEO, IC-VCBO, BVCBO

GaN FET (N1267A): ID-VDS, ID(off)-VDS,

ID-VDS Current Collapse,
FET Current Collapse Oscilloscope View

GaN Diode (N1267A): IF-VF, IR-VR, IF-VF Current Collapse,

Diode Current Collapse Oscilloscope View

The Sample setup button displays the sample setup menu. Clicking a setup name in the menu applies

its setup to the tracer test environment.
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Arithmetic Operation for Tracer Test

| Operator +, -, *, or / is set by clicking here. |

@ I/ Trace Setup Name: [Rd-vGs

Maximum 3 operations
can be defined by using
this area.

Click the Option > Arithmetic Operation > Operation N (N: 1, 2, or 3) menu, the arithmetic operation
area appears at the top of the graph. This area is used to define arithmetic expressions using the
measurement result data. This function is useful to graphically display parameters given by the
expressions.

An expression can be defined by two operands and an operator + (addition), - (subtraction), *
(multiplication), or / (division). The following elements can be the operand.

*Measurement data

*Source data

*Real literal constant (e.g. 2, 0.123, or 100E-3)

*Operation 1 result, for the expression of Operation 2 and/or Operation 3

*Operation 2 result, for the expression of Operation 3

Note: "NaN" is returned for the invalid calculation results.

Note: To disable the operation, click the Option > Arithmetic Operation > Operation N menu and
uncheck the Operation N menu.
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Line/Dot

Setup Name: |1V Trace

®|[1/V Trace

Setup Name: [V Trace

I/V Trace

5 ma/div.

500 mv/div.

4 T B B 1 i e O R

5 mi/di.

Clicking Line/Dot button

toggles the line type between
dotted and solid lines. 500 rC:.mw.
3 i A A

Note:
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Zoom in and Cancel zoom

|P0int and drag operation zooms in the graph.

5 ma/div.

500 mv/div.

Clicking the Cancel zoom
button returns the graph scale
to the original setting.

150 mv/div.

vd

Note:
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Graph Minimum and Maximum

100 mA

Clicking the minimum or
maximum scale number
pops up a dialog.

Enter the
number and
close the dialog.

5 mA/div,

e.g. Maximum is
changed on Y-scale.

100 mA

500 mv/div.

PR

Clicking the Cancel zoom
button returns the graph scale
to the original setting. 500 mv/div.

vd

Note:
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Marker

Marker position Marker

@| 1/V Trace / Setup Name: |D-vDs

ID - VDS

To move the marker:
* Rotate the knob.

¢ Click somewhere on the
graph.

* Use the mouse scroll button.

100 mA/div

Click the Marker button
to display the marker.

Note:
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Tangent Line

Tangent line

@| 1/V Trace

Marker( 2.6(

=
5
<
E
o
&
=1

Marker

Setup Name: |[ID-vDS

Line parameters:
* X-intercept
* Y-intercept
* Gradient

Click the Tangent line button
to display the marker and the
tangent line.

Note:
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RegreSSion Line 2. Point and drag to specify the data

used for the regression calculation.

s e Line parameters:
e s v Calerss ) )
* X-intercept
3. Click the trace to draw * Y-intercept
the regression line. * Gradient

100 mA/div

2 V/div
VDS

1. Click the Regression line
button to display the marker.

2 V/div
VDS

i BN RS

Note:
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Oscilloscope View — B1505A

@|/1/V Trace Setup Name: [ID-VDS Pulse G 3.5kW =
LIN-5GL
45V B
21 B
Rectangular marker e —
S01A B
VAR2 v
Start:
48V B
Stop:
v E
Step:
366.666 mV
NOS:

5 V/div
VDS
KEP -

Oscilloscope View

File

Nus B
Data Setup Window Measurement duration Pulse Period:
aUTO B

. Remarks

Marker

Tr—ATnt

Oscilloscope view is opened/closed by clicking the Oscilloscope View button or selecting the Option
> QOscilloscope View menu on the Tracer Test screen.

This function monitors a point of the pulsed sweep measurement or the pulsed spot measurement and
displays its waveform. The monitoring point is specified by a rectangular marker on the trace. This
function is used for monitoring the time relationship between multiple channel
outputs/measurements, the change of the output level for the gate drive channel, and so on.

This function is valid for using one or more VPULSE or IPULSE channels. And this function is not
available for the following measurement resources.

*HRSMU, HPSMU, MPSMU
*MFCMU

*WGFMU

*SPGU

*GNDU

Data names set in the V Name and I Name fields of the channel area are used to specify the target
monitored signals.

During executing the tracer test, the waveforms within the specified duration are displayed in this
window graphically.
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To Use Stop Condition

WA [ ]i i i i
‘ﬁ 1. Click the Set stop condition area button. |
| 5 1% O O

@ 2. Point and drag to specify the abnormal region. |

Sweep measurement is stopped
if the measurement data enters
into the abnormal region.

150 V/div

945

v

Note:
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To Use Replay Function

Automatic trace record ON/OFF
Open trace record
\ | Save trace record

/
\ v/

H o J
[«— Selects recorded trace.

ETETGICH -

eplay Interval:

100ms @ N: Trace number
s 0 M: Total number of recorded traces
Recording Interval:
0s A

|Click the Replay traces button to open this dialog box.

¥ Name: I Name: Mode: Function:

To add a channel parameter, press the [Add] button in this area,

Use the slide bar or the arrow buttons (<<, <, >, >>) to select the recorded trace to display.

Long-clicking the << or >> button changes the trace sequentially.

Replay Interval is used to set the time interval of the long-click operation of the << and >> buttons.

Maximum Records is used to set the maximum record count. After the record number reaches this
value, the record numbers are shifted to the newer side and the oldest record is deleted. This number
is always assigned to the last record.

Recording Interval is used to set the time interval of the automatic trace record operation.
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To Use Reference Trace

Setup Name: |ID-VDS
Comparing with reference trace
expressly shows difference in such
as thermal drift effect.

@®|1/V Trace Setup Name: [ID-VDS

2 V/div

100 ma/div

VDS

2 v/div

Click the Capture a reference trace
button to capture the trace as the
reference trace.

VDS

Note:
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Select reference traces and
Select tracking traces

Show/hide selected trace
Inversion

Erase selected trace
Open a trace
Slave selected trace

Erase selected trace

. v ) " a
A [ T G
VISR |OE B
| Time _Trace | | Time _Trace |
[ 16027 PM ¢ vi-in BJ26/2000 52706 M vi-1
3/26/2000 5:27:02 PM  V1-T

| Select reference traces |

Select tracking tracesJ

Z 1509 o =] B IFS

B2 -1 ) R

S LI
Ello =188 [ oy
Unit: Y Name: I Name: Mode: Function: [EF'
Add

To add a channel parameter, press the [Add] button in this area,

Reference trace means the trace set as the reference by using the Capture a reference trace button.
Up to 10 traces can be captured.

The Select tracking traces button is available for the measurement result which contains at least two
traces by the append measurement. Tracking trace means each trace of this measurement result.
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¥

Point and drag
operation slides the
source setup area.

¥

Hidden parameters

are displayed.

Click title bar to display hidden parameters.
VARL = VAR1L 2 OFF ~
Mode: Mode: Hold Time:
LINSGL + LINSGL + 0s B
Stop: e Start: e VARE ~
NOS: Stop: Start:
101 B 5v B 2v B
Compliance: Step: Stop:
100mA B 50 mv. 5V B
NOS: Step:
MARD g 101 8 1v
Start: Interlacing: NOS:
2v B 18 4R
Stop: Compliance: Compliance:
5V B 100mA B 00uA B
Step: Pwr Comp.: Pwr Comp.:
1v oFF § OFF B
NOS: V Compliance: Hold Time:
48 oFF B s B
Dual Polarity: =
CONST v oFF - CONST e
Unit: Hold Time: Unit:
0s B SMUZ:HR %
Source:
Sourd
VAR2 and VAR2 2 ov B
Comp . Start: Compliance:
CONST hide v @ 100mA B
. Ston:
meas| Dehind. |/ Meas. Time: Meas. Time:
[E: | 2us B 2us @
Step Time: Step Time: Step Time:
s00us 8@ s00us B S00us B

The source setup area is too small to display all setup parameter. So the source setup area provides
two display mode, short and full. To switch the mode, click the title bar, VAR1, VAR2, or CONST.
You can see the hidden setup parameters. Also use the point and drag operation to display the hidden

parameters.
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VARI1 Setup Parameters

VAR *
Mede:  vsa o| «———Mode: LIN-SGL (linear single sweep)
Start: o B LOG-SGL (log single sweep)
Stop: s LIN-DBL (linear double sweep)
Step: LOG-DBL (log double sweep)
500 mvV’
NOS: . .———NOS (numbers of steps)
11
ol ) Interlacing Baselilne of Plilse Period
comp"a"i:u mA B Power Compliance 3
Pwr Comp.: . 3 i
o E /Voltage Compliance |
Pulse B OFF B Pulse Base: i 3 i
u ase: -— H 3
oo | || ot wite: v - Pulse Base — = :
tms 8 | o b Pulse Width{ == | <: Measurement
Pulse Delay: u ¥ [ H
s @ e Pulse Delay !
Dual Polarity: R
arF Meas. Delay =,
e /
AUTO H
Meas. Time:
puice perod. = & - Pulse Period
AUTO H

In the short mode, the VAR setup area shows Mode, Stop, MOS, and Compliance only.

In the full mode, Start, Step, Interlacing, Pwr Comp., V Compliance, Dual Polarity, and Hold Time
are added.

For the VPULSE/IPULSE source, Pulse Base, Pulse Width, Pulse Delay, and Meas. Delay are also
added.

When a pulse source is set, Pulse Period is available instead of Step Time.

V Compliance is effective only for UHCU, UHVU, or HVMCU. This is the limit value for the
voltage sweep output. The output voltage of the measurement resource is automatically measured,
and the measured voltage is compared with this limit value. And then, if it exceeds the limit, the
measurement status is set to the compliance status, and the sweep measurement stops. Voltage range
and setting resolution depend on the measurement resource.

If Dual Polarity is set to ON, the VAR channel performs positive sweep from start to stop and
negative sweep from -start to -stop in this order. For the pulsed negative sweep, the pulse base value
is -1*(Pulse Base).
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NOS and Interlacing

For “NOS = 3” and “Interlacing = 5”

Output Total 11 points
Stop ~TTTTTT M . T T " 2peints
Y 2 points 2 points
2 points Rough plots
3 points 2 points

Center ----r==t-f----1-F----}------f4----- .

w ottt

Sweep 1 2 3 4 5

For “NOS =11” and “Interlacing =1”

Output
IS 10 1

Complete plots
11 points
Start -—-t-r-4-1-t-F4-1-t4-1-r-F1-1-F4-1-
HHHHH

Sweep 1

This slide explains the effect of the Interlacing parameter. The NOS parameter sets the number of
steps in a sweep operation. And the Interlacing parameter sets the number of sweep operations
performed in a single measurement.

This is the example of NOS=3 and Interlacing=5. At first, the sweep measurement is performed for
the Start, Center, and Stop values. After that, the sweep measurement is repeated four times to
narrow the sweep step. This results the same sweep steps as the sweep output of NOS=11 and
Interlacing=1 although the timing is not same for some steps. By using the Interlacing, you can see
the rough characteristics in the early stages. This is effective for the measurement such as the total
pulsed sweep time is so long.

For NOS=N and Interlacing=M, the sweep is repeated M times so that the final sweep step is equal to
Step/M. Total number of steps will be N+(N-1)*(M-1).

The Interlacing is the function only for the Tracer Test environment. This function is not available
for the other test environment. Also this function is not covered by the FLEX command set.
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Pwr Comp. — Power Compliance

@|1/v Trace Setup Name: |D-VDs

100 mA/div

SMUZ:HP
SMUHC v

LIN-S6L +

200 mv

Interlacing:

Compliance:

Meas, Time:

Step Time:

ov B

2wy 8

01 B

toSW.

18

2us

500us @

Power limit is set

Power compliance is effective to limit power consumption in the device.
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To Control Switching Matrix

@ Switching Matrix Operation Panel

Setup Name: :I 1to7 a

M= %]

l

Export to Current My Favorite Group |

Open All
e h R 11”" Apply Switch Setup

Read Switch Setup

H
3
b
&
2

Preset List -
Demosyy =
OpenAl

1to7

N

This function
is not available
for B1505A.

HIBIEIBIEE HIBIEIEHIEEIBIEE
HIBIEIEERE HIBIEEIENEREE
ZZ|21|Z2]||2]]|2 HIENERH B HE I E
ZIEINEIIEIIE]|® HIENEIE B EEE
] Bl Gl @ @ @ @
a 2 2 = =
2 € =4 = =
i = i} 2 =
I % £ I &
H ES ES 5 B

1 2 3 4 5 6 7 8 9 10 11 12

4l if 4]

Step 1: Click Switching Matrix button to open the Switching Matrix Operation Panel.
Step 2: Enter the switch setup name.

Step 3: Define the switch setup by using the matrix on the operation panel window. Label can be set to input

ports and output channels.
Step 4: Click the Apply Switch Setup button to send the switch setup to the B2200/E5250 switching matrix.

Note: Before clicking this button, connect the B2200/E5250 to the B1500A via GPIB, and set the
configuration. To set the configuration, see Module 8.

The switch setups you create or modify MUST be saved in a preset group.
To save the setup, click the Save button.

To recall the setup, click the Recall button.

You can organize the setups by using the Preset List button.

To select the available preset group, use the field below the Preset List button. In the above example, the
DemoSW group is selected and listed in the Preset List list.

To rename, duplicate, or delete the setups, and to add, rename, duplicate, or delete the preset group, use the
function of the Preset List button menu or the Organize Preset Group dialog box shown in the next page.

Read Switch Setup: Read switch setup from B2200/E5250 via GP-IB and show it on the operation panel
window.

Note: Standard revision of EasyEXPERT cannot support the E5250. The E5250 control is optional function
of B1540A-002/B1541A-002.

Note: EasyEXPERT supports the ES250A installed with the ES252A matrix card.
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To organize preset group for switch setup

Organize Preset Group n
e Preset List | button
Demosw - \
[ oupicae |
Preset Group: Preset Group:
I = [Bemas 5
Setup Name I Setup Name Add New Preset Group
OpenAl Rename This Preset Group
1to7
W Copy Duplicate This Preset Group
Organize Preset Group ..
»
«
Select All
166
Cr ¢
e
Kl | |

This dialog box is opened by selecting the Organize Preset Group function of the Preset List button
menu, and is used to organize the switch preset group.

*Preset Group List

Lists the preset groups saved in the workspace. The Add, Rename, Duplicate, and Delete buttons are
available to organize the preset groups.

*Copy

Sets the operation of the >> button and the << button. They work as Copy when this check box is
checked, and as Move when this check box is blank.

o>

Copies or moves the preset setup selected in the left Preset Group box to the right Preset Group box.
<<

Copies or moves the preset setup selected in the right Preset Group box to the left Preset Group box.
*Close

Closes the Organize Preset Group dialog box.

*Preset Group

Lists the preset setups saved in the preset group. The Select All, Unselect All, Rename, Duplicate,
and Delete buttons are available to select or organize the setups saved in the preset group.
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To add switch setup to test preset group

e Data Display Help
[My Favorite Setup -

I Preset Group: [Demo |
Setup Name @ Switching Matrix Operation Panel BE=]
I 1d-vd [Switch setup

upi 4 2 3 4 5 6 7 8 8 Moa S,

Read Switch Setup

Clear All

Input: Label:

Al
| —
| —y
.
.

Preset List -]
[Demoswy |
Openal

1to7

Save W

e —
T —
e —
T —

]
Flag | Setup Name SWM IN1D ]
Vth gmMax 4
s ] 1
Tmg idd idvgd 1
Trng idvd idvg2
Trng idvd idvg L]
Trng idvd idvg Er I:l

2 3 4 5 6 7 8 9 10 11 12

| o

Switch setups can be saved in the preset group for test setups.
Click the Export to Current My Favorite Group button. The switch setup will be converted to a
classic test setup and saved in the My Favorite Setup group opened in the main screen.

To select the available preset group, use the Preset Group field. In the above example, the Demo
group is selected and listed in the quick test setup list.

To duplicate, import, or export the preset group, use the function of the My Favorite Setup banner
menu or the Organize Preset Group dialog box shown in the next page.
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Class Exercise

Add switch setup to test preset group.

1. Create a switch setup.

2. Create your switch preset group, and save your setup.
3. Add the switch setup to your test preset group.
4

. Save your test preset group.

Note:
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To Manage Data Display Window
Data Display > Default Data Display Properties...

Data Display Properties x|

Effective Area Graph Trace Color
¥ X-Y Graph
e —— visible  Color Thickness
Logo
Y1 v -
¥ Grid ON = ||
™ Setup Summary ON v2 ~ - l—_,'
¥ List Display v i M —=
¥ parameters
v ¢ EE [—
Graph Color |
v ¢ Bl [—
Background: w = m =
w | v v g —F
v 7 Wl [—3
Line/Cursor: -
Log Scale
Maximum decades to
show minor ticks: 6 Bl decades
Text Size
X/V Axis Title:  [Medum =] E| points
Scale: [Medum =] [~ 8] points
Legend: Medium ~| |7 H| points

The Data Display Properties window is used to set the default setting of the Data Display window.
This window is opened by selecting the Data Display > Default Data Display Properties... menu of the
main screen.

The Effective Area is used to select the area effective when the Data Display window is opened, and
provides the following check box.

*X-Y Graph: Enables the X-Y Graph area.

*Logo ON: Displays the Agilent logo at the upper left on the X-Y Graph.

*Grid ON: Displays the grid in the X-Y Graph.

*Setup Summary ON: Displays the channel setup summary information of the I/'V Sweep or Multi
Channel I/V Sweep Classic Test at the bottom of the area.

+List Display: Enables the List Display area.

*Parameters: Enables the Parameters area.

The Graph Color area is used to set the color map for the Data Display window. You can change the
color of the background, text, graph grid, and line. The color palette is opened by clicking the pattern
of the item.

The Graph Trace Color area is used to set visibility, color, and thickness of the data traces Y1 to Y8
plotted on the graph.

The Log Scale area is used to set the maximum number of decades to show the minor ticks for the log
axis. If the number of graph decades is less than or equal to the entered value, the minor ticks are
displayed. If it is greater than the entered value, the minor ticks are not displayed.

The Text Size area is used to set the font size for the graph. The available settings are Largest, Large,
Medium, Small, Smallest, and Fixed. For settings other than Fixed, the appropriate size is automatically
selected. For Fixed, a font size entry field is provided, and the specified font size is always applied.
*X/Y Axis Title: Font size for the axis title

*Scale: Font size for the X and Y coordinate values

*Legend: Font size for the graph legend
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To Manage Data Display Window
Data Display > Manage Data Display...

€ Data Display Manager
[Data Display window Order Data Display Windows Configuration |

« Keep Setup
Do not change the present Data Display
Windows configuration.

¢ Tiling
Resize and collate the Data Display
windows such that they fill up the entire
screen.

pown
Select Al | _Momze | cose | | ~ stacking

Resize and collate the Data Display
windows so that they overlap slightly with
an offset.

Minimized Data Displays ‘

 Overlaying

Resize, overlap and make transparent the
data display windows so that multiple
graphs can be viewed and superimposed
on one another.

I~ Apply same scale to all graph

Select All Restore Close

oK Cancel Apply

The Data Display Manager is used to control the appearances of the Data Display windows. This
window is opened by selecting the Data Display > Manage Data Display... menu of the main screen.
The Data Display Window Order area lists the Setup Name of the Data Display windows opened.
The list items from top to bottom correspond to the windows from front to back in the screen image.
The Minimized Data Displays area lists the Setup Name of the Data Display windows minimized.
The Data Display Window Configuration area provides the following radio buttons and a check box
to change the appearances of the Data Display windows. All functions are available for the opened
windows. See following slides for the display examples.

*Keep Setup: Keeps the present configuration of the Data Display windows.
*Tiling: Resize and collate the data display windows such that they fill up the entire screen.
*Stacking: Resize and collate the data display windows so that they overlap slightly with an offset.

*Overlaying: Resize, overlap, and make transparent the data display windows so that multiple graphs
can be viewed and superimposed on one another.

The following check box must be checked to apply the same graph scale to all graphs.
*Apply same scale to all graph
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Tiling

File Data Display Help

@ BT Gun

=%

()]
100 m.

Thase

decade]
Jdiv]

0 Vbase (V)

@ BUT GummelPlot [(3

9/3/2005 12:36:28 PN

100 m

Tcollecto;

100m

Tcollecto;

100 m)

Ibase

decade
Jdiv

0 Vbase (v)

Icollecto:

Vbase (V)

Icollecto!

This is a display example of Tiling.
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Stacking

File Data Display Help

Setup Name: [BIT GummelFlot [(1) ; 9/3/2005 12:35:10 F

1| 15 [X-¥ Graph Plot | [Parameters |
1| [ Agilent
1| @ ) hfemax [543 245
1 100m 100m
1
1
Ibase Icollector
di
di
di
decade
Jdiv
s b i i 1f
1 0 Vbase (V) 100 m /div 12
H H 3 F—r—
B [ 7 [UstDisplay ]
; 1 Index | Voase | Thase | Tenlecror | e | [a]
HEB ov -14.531 pA 26.866 pA  -1.84887481... =
«|@32 wmv 14302pA 11183pA 7.81018612...
3 3 L 20500 b8 ~bo0ozmleL 2]
E [m] G-Plot Vbe=0V Pulse[3] 9/3/2005 12:33:52PM 1
ot G-Plot Vbe=0V[3] 9/3/2005 12:33:00PM 6
[m] G-Plot Vbe=0V([3] 9/3/2005 12:29:18 PM 5

This is a display example of Stacking.
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Overlaying

File Data Display Help

mEEhaa®d

|B5]=1 %]

R einE-BA- FE

SetupName: [BJT GummelPlot [(1) ; 9/3/2005 12:35:10 P

100m

Thase

decade
fdiv

00m

Icollector

[X-¥ Graph Plot ‘ [Parameters ‘
i Agilent
a) () hfemax  [47 245

1 | —— 1f
0 Vbase (V) 100 m /div 12
<] m e
[t Dispiay |
Index_| Vbasa | Thasa | Tcolector | [a]
! ov -14.531 pA 26.666 DA 1.84867481.., i
2 10my -14.302 pA 11183 pA  -7.81918612...
3 20my -14.105 pA 26.874 pA  -190528181.. =)
,—\JJ Flag | Setup Name l Date | Count | Device ID | Remark:
BIT GummelPlot 9/3/2005 12:37:25PM 4
BIT GummelPlot 9/3/2005 12:36:2 3
BIT GummelPlot 9/3/2005 12: 2
BIT GummelPlot 9/3/2005 12: 1
=|O0 G-Plot Vbe=0V Pulse[3] 9/3/2005 12: 1
ot G-Plot Vbe=0V[3] 9/3/2005 12: 6
[m] G-Plot Vbe=0V([3] 9/3/2005 12:29:18 PM 5

This is a display example of Overlaying.
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@ iV 101 - 87572005 2:26:53 ] - Ageot ExsyreRT | - £

aaaaaa

To tile/stack/overlay windows

Stacking

Overlaying

<+—— Tiling

When some Data Display windows are opened, the following Windows menu functions are useful.

Tiling

Tiles all Data Display windows on the screen.

Stacking

Stacks all Data Display windows on the screen.

Overlaying

Overlays all Data Display windows on the screen. Then the position, window size, and visibility of

the most front window are applied to all windows on the screen.

The background of the X-Y Graph area is cleared except for the most back window.
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Data Display and Management




Module 2
Data Display and Management

In This Module

* Data Display window

*  Graph Analysis Tools

* Data Status

* To Change Graph/List/Display Setup
* To See Print Preview

* To Print Display Data

* To Copy Graph Plot/List Data

* To Save Analysis Result

 To Use Preview Window

This section describes the above topics. You will understand how to use analysis tools, how to
change display setup, and how to print/export test result data.
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Data Display and Management

Data Display window

@ Vth_gmmax - Agilent EasyEXPERT =
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The Data Display window is opened after measurement automatically, or by clicking the Data
Display button. And the window is used to display measurement data and analyze the data.

The Show X-Y Graph icon displays/hides the X-Y Graph Plot area. This is the same as the View >
X-Y Graph menu.

The Show List Display icon displays/hides the List Display area. This is the same as the View > List
Display menu.

The Show Parameters icon displays/hides the Parameters area. This is the same as the View >
Parameters menu.

Multiple data display windows can be opened while the Multi Display indicator is ON. Then the test
result data of the same test setup name will

be displayed on the exclusive Data Display window and the test result data of the different test setup
name will be displayed on the new Data Display window. To set Multi Display ON, click the Run
Option button located at the top right of the Main window, check the “Allocate Data Display for each
test” box on the Run Option dialog box, and click the Close button.
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Module 2
Data Display and Management

Graph Analysis Tools
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The Data Display window provides marker, cursors, and lines for analyzing test result data. Marker
is used to read measurement data and draw a tangent line. Cursors are used to read the cursor

position and draw a normal line, gradient line, or regression line. The cursor/marker position data is
displayed top of the graph plot area.

Clicking Y axis can select the Y axis effective for the analysis tools. On the graph, left axis is always
Y1 axis. And the right axis is selectable from Y2 to Y8 axes.
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Module 2
Data Display and Management

Graph Analysis Tools

Text Pointer
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Text and pointer are the tools to decorate the X-Y Graph.
The text is used to leave notes on the graph. The notes will be measurement conditions, device
information, operator name, and so on. Up to 20 texts can be added to a graph.

The pointer is used to indicate the remarkable measurement point and show the X and Y coordinates
like the marker. The new pointer can be displayed on the marker point at first and can be moved on
the measurement data curve by using the rotary knob or the mouse wheel. Up to 30 pointers can be

added to a graph.
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Module 2

Data Display and Management

Graph Analysis Tools

Show Graph Legend

Slhow Line Information
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When a line is displayed, the line information can be displayed in the graph plot area.

The Show Line Information icon displays/hides the line information. This is the same as the View >
Line Information ON/OFF menu.

The Show Graph Legend icon displays/hides the graph legend. This is the same as the View > Graph

Legend ON/OFF menu.
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Data Display and Management

Graph Analysis Tools

Close All Displays Hold this layer
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If the append measurement is performed, the data display layer is added to the Data Display window.
In this example, the Data Display window has three layers.

Use the icons shown above

to organize the data display layers.

Switch Display Mode icon switches the mode, overwrite or append.

In the overwrite mode, the data is displayed in a new Data Display window.

In the append mode, the data is displayed on a new display layer in the present Data Display window.

The Data Display window can hold up to 10 display layers. And the earliest layer over 10 will be
automatically deleted. The Hold this layer icon is available when the window holds at least two
layers. If this icon shows the standing pin, the layer will be held. If this icon shows the laid pin, the
layer can be deleted. Double clicking the tab gives the same result as this icon.
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Data Display and Management

Graph Analysis Tools

Graph control
|
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Graph control:

Auto Scale icon will change the graph scale automatically to fit the trace in the graph. The right
arrow button opens the menu for enabling or disabling the run time auto scaling. This function is set
independently for the X and Y axes. If this function is enabled, the graph scale will be changed
automatically to fit the trace in the graph during the measurement.

Zoom In icon zooms the data graph in. This enlarges the trace in the graph. Then the center of
zooming will be the cursor position.

Zoom Out icon zooms the data graph out. This reduces the trace in the graph.
Graph Setup icon opens the Graph Setup dialog box used to change the graph axis setup.

Choose Active Y axis icon selects the Y axis that is effective for the analysis tools (marker control
and auto scaling).

If multiple layers are opened on the Data Display window, the scale change is applied to the layers.
This means that the X-Y graph scale will be shared by all display layers. The auto scaling is
performed as follows.

1. Graph scale is optimized for the data on the selected layer (top layer).

2. The graph scale is applied to the graph in the all layers.

Note that auto scaling is performed independently for the left and right Y axes.

There is also a function for resetting the graph scale. Click View > Cancel Scaling > This Display or
All Displays.

This Display will reset the selected layer only. All Displays will reset all display layers.
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Data Display and Management

Graph Analysis Tools

Marker control
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Marker control:
Marker ON/OFF icon enables or disables the marker.

Interpolation ON/OFF icon enables or disables the interpolation function of measurement data. You
can read the interpolation data between two actual measurement points.

Marker Skip icon moves the marker to the next measurement curve that is added by the VAR2
variable.

Marker Maximum icon moves the marker to the maximum measurement point.
Marker Minimum icon moves the marker to the minimum measurement point.

Marker Search icon opens the Direct Marker/Cursor dialog box used to specify the coordinate values
to move the marker.
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Data Display and Management

Graph Analysis Tools

Line control
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Line control:

Line 1 State icon enables or disables line 1 and its function: normal, gradient, tangent, or regression.

Line 2 State icon enables or disables line 2 and its function: normal, gradient, tangent, or regression.

Cursor to Marker icon moves the cursor to the marker position.

Adjust Gradient icon is available when a gradient line is active. Clicking this icon enables the rotary
knob and the mouse wheel to increase/decrease the gradient of the line. Clicking this icon again,
clicking the rotary knob, or clicking the mouse wheel disables this function.
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Data Display and Management

To Enable Marker and Line
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*Line 1 & Line 2

To enable maker, click the Marker ON/OFF icon, or select the Marker > Marker ON/OFF menu.

To enable the Line 1, click Line 1 icon and select one of the line mode. Or select the Line > Line 1

ON/OFF menu and select one of the line mode.

To enable the Line 2, click Line 2 icon and select one of the line mode. Or select the Line > Line 2

ON/OFF menu and select one of the line mode.

If you enable the Normal line, two cursors are available. The cursors specify the points that the line

passes through.

If you enable the Gradient line, a cursor is available. The cursor specifies the point that the line

passes through.

If you enable the Regression line, two cursors are available. The cursor specify the measured data

used to draw the regression line.
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Data Display and Management

To Draw Normal Line

Line N > Normal
/Cursor To Marker
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2 cursors line

Enable the Normal line by clicking the Line 1 (or Line 2) icon and Normal.

Move cursors to draw the line. The line passes through the cursor points.

To move the cursor, you can use the Cursor To Marker icon. The cursor will move to the marker

point.
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Data Display and Management

To Draw Gradient Line

Line N > Gradient
/Cursor To Marker
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Enable the Gradient line by clicking the Line 1 (or Line 2) icon and Gradient.

Move the cursor to specify the point that the line passes through. And click the Adjust Gradient icon.
Use the rotary knob or the mouse scroll button to adjust the gradient of the line.

To move the cursor, you can use the Cursor To Marker icon. The cursor will move to the marker
point.
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To Set Gradient Value
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This is another way to draw the gradient line.

Set the line 1 or 2 ON and select the gradient line mode. Then click Line > Gradient... to open the
Gradient Value dialog box.

On the dialog box, enter the desired gradient value, and click OK to draw the gradient line.
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Data Display and Management

To Draw Tangent Line

Line N > Tangent
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Enable the Tangent line by clicking the Line 1 (or Line 2) icon and Tangent.

Move marker to draw the line. The tangent line will pass through the marker point.
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To Draw Regression Line

Line N > Regression
Cursor To Marker
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Enable the Regression line by clicking the Line 1 (or Line 2) icon and Regression.
Move cursors to specify the region of the measurement data used for the regression calculation.

To move the cursor, you can use the Cursor To Marker icon. The cursor will move to the marker
point.
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To Fix a Line

Line N > Fix
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To fix a line, click the Line 1 (or Line 2) icon and Fix, or select the Line > Line Mode > Fix menu.
While the Line Mode is set to Fix, the specified line cannot move.
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Data Display and Management

To Add Text

Text > New
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To add a text, click Text > New. A text editor appears. Then enter the text you desire.

The following functions are available for the selected text(s) via the Text menu, the Text icons, or the
right-click menu.

Clicking on a text will select the text. To select the multiple texts, click the text while holding down
the Shift key on the keyboard.

Edit Mode: Edits the selected text.

Size: Sets the font size of the selected text(s). The available setting values are Largest, Large,
Medium, Small, Smallest, and Fixed Point (6, 7, 8, 9, 10, 11, 12, 14, 16, 18, or 20). For settings other
than Fixed Point, an appropriate size will automatically be applied. For Fixed Point, the specified
font size will always be applied.

Font: Sets the font of the selected text(s).
Text Color: Sets the text color of the selected text(s). Click Customize to open the color palette.

Background Color: Sets the background color of the selected text(s). Click Customize to open the
color palette.

Hide Frame/Show Frame: Hides or shows the frame for the selected text(s).
Delete: Deletes the selected text(s).

Dragging a text moves this text.
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To Add Pointers

Pointer > New

X
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To add a pointer, set Marker ON, click Pointer > New. A pointer and description (pointer ID and X-
Y coordinate values) appear. Then move the pointer you desire by using the rotary knob or the
mouse wheel.

The following functions are available for the selected pointer(s) or description(s) via the Pointer
menu, the Pointer icons, or the right-click menu.

Clicking on a pointer will select the pointer. To select the multiple pointers, click the pointer while
holding down the Shift key on the keyboard.

Clicking on a description will select the description of a pointer. To select the multiple descriptions,
click the description while holding down the Shift key on the keyboard.

Shape: Sets the shape of the selected pointer(s).
Hide Description/Show Description: Hides or shows the description of the selected pointer(s).

Delete: Deletes the selected pointer(s).

The rotary knob or the mouse wheel can be used to move the selected pointer in the VAR direction.

The pointer can not be moved in the VAR2 direction.

Dragging a description of pointer moves this description of pointer.
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Data Status

€ Vth gmMax [(2) ; 4/7/2006 12:46:26 PM] - Agilent EasyEXPERT o
File Edit View Marker Cursor Line Window Help
il ‘TH Sl || ol ol €12 | = A~ b2 5 | =
‘HeQXi@- BEEHEMeE-FA-Z5 L2
Setup Name: !vth gmMax [(2) ; 4/7/2006 12:46:26 PM] L x
X-¥ Graph Plot Properties... | |
- Agilent
610 u 12m
Intzroapn: e
600,018 A
- Gradent: -
| 2,000000¢-008
50.0u
fdiv
89p Intarcept;
500 m Vagate (V) 200 m fdiv 2
List Display Properties... | |
Index | Vgate | Vsource Vdrain | Vsubs Idrain gg\_:l
1/50 195V ov 100 mv ov € 600.057 us | 125.650000000...
1/51 2N oV 100 my oV €600.058 uA | 20.0000000024... v
sl w \ J | &)

If measurement unit detects any status while measurement, the status code is recorded with the
measurement data. In this example, a SMU detected the compliance condition in the drain channel,
so the status code C is put just before the Idrain value.

SMU status code:

* C: Compliance

* T: Other channel compliance
*» X: Oscillation

* V: Overflow

MFCMU status code:

* U: Unbalance

* D: I/V amp saturation
* V: Overflow

2-20



Module 2

Data Display and Management

To Change Graph Properties
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The Graph Properties dialog box is used to set the following setting of the selected Data Display
window. This dialog box is opened by clicking the Properties... button in the X-Y Graph Plot area or
by selecting the Edit > Graph Properties... menu of the Data Display window.

The Logo ON check box is used to display the Agilent logo at the upper left on the X-Y Graph.
The Grid ON check box is used to display the grid in the X-Y Graph.

The Setup Summary ON check box is used to display the channel setup summary information of the
I/V Sweep or Multi Channel I/V Sweep Classic Test at the bottom of the area.

The Graph Color area is used to set the color map for the Data Display window. You can change the
color of the background, text, graph grid, and line/cursor. The color palette is opened by clicking the
pattern of the item.

The Graph Trace Color area is used to set visibility, color, and thickness of the data traces Y1 to Y8
plotted on the graph.

The Log Scale area is used to set the maximum number of decades to show the minor ticks for the
log axis. If the number of graph decades is less than or equal to the entered value, the minor ticks are
displayed. If it is greater than the entered value, the minor ticks are not displayed.

The Text Size area is used to set the font size for the graph. The available settings are Largest, Large,
Medium, Small, Smallest, and Fixed. For settings other than Fixed, the appropriate size is
automatically selected. For Fixed, a font size entry field is provided, and the specified font size is
always applied.

*X/Y Axis Title: Font size for the axis title
*Scale: Font size for the X and Y coordinate values

*Legend: Font size for the graph legend
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Setup Summary

Filar Edit  Wiew Marlker Cursor  Line Text Pointer ‘window Help
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—= e =1 o i B E - FA - ==
EEEEEDR Q@ DEHEH® % F E]
‘ Setup Name: |RDSan ID-vDS CT [(1) "1.64 mohm'; 2012/05/31 15:10:04] .
=¥ Graph Plot Properties... | | Parameters |
ﬂ ﬂ]“!llt MARKER( 1.9599600000E+002 &  1.6427711174E-003 oh 3.2200000000E-001
: + ' -003 ohm 3 001
Rds_on [164277 mohm
am :
=
=2 LEm
g 16m §
1d4m =

19 195134 A 16428735346 m...

10 ¢8) 200 fdiv

WDS: [ 500 m, 10 ]V ) 21; ID: 501 A; 3.5 kw

wizg: [ 10, 10] ¥ 0Y; IE: 100 mA < >
List Display Properties... | |
Troles_ | 0| RDS0N WS WGS ~
17 174640 A4 1642808062 m... 286.9 mv 10.00002
18 104076 4 1642161787 m... 303.6 my 10.00000 ¥

320,86 My 9,09992 v 3

If the Setup Summary ON is checked, the channel setup summary information shown below is

displayed at the bottom of the graph area.

The setup for one channel is displayed with one line as follows. Where, the items in {} are the

setting values.
VARI Channel:

For the voltage output channel:

{V Name}: [{Start}, {Stop}] V / {No of Step}; {I Name}: {Compliance} A; {Pwr Comp} W

For the current output channel:

{I Name}: [{Start}, {Stop}] A/ {No of Step}; {V Name}: {Compliance} V; {Pwr Comp} W

Example: VDS: [0, 10] V/101;ID: 1 A; 1 W
VAR?2 Channel:

For the voltage output channel:

{V Name}: [{Start}, {Stop}] V / {Step} V; {I Name}: {Compliance} A; {Pwr Comp} W

For the current output channel:

{I Name}: [{Start}, {Stop}] A/ {Step} A; {V Name}: {Compliance} V; {Pwr Comp} W

Example: VGS: [0,5]V/1V;ID: 1 mA; 1 mW
Constant Channel:

For the voltage output channel:

{V Name}: {Source} V; {I Name}: {Compliance} A
For the current output channel:

{I Name}: {Source} A; {V Name}: {Compliance} V
For the common channel:

{V Name}: COMMON

Example: VSUB: -1 V; ISUB: 1 mA
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To Change List Display Properties
Edit > List Display Properties...

Data Status

Physical Unit
List Display Properties @

- |
’ PIWvDatastam ¥ Physical Unit Example: -1.2345

~Number Format

+ Engineering Format (with Unit Prefix) — =———————) Example: -1.2345 mA
Lt — > Example: -1.23456789012345E-003 A

OK Cancel Apply ]

This dialog box is used to set the data display format in the List Display area. This dialog box is
opened by clicking the Properties... button in the List Display area or by selecting Edit > List Display
Properties... menu of the Data Display window.

Display:

Check the following check box to add the data status or the physical unit to data. Unchecking the box
removes it.

*Data Status: Adds or removes the status code before data.
*Physical Unit: Adds or removes the physical unit after data.

Number Format:
Selects the data display format from the following formats.

* Engineering Format (with Unit Prefix):
Data display with arithmetic point, SI prefix, and unit.
Example: -1.2345 mA

* Scientific Notation:
Data display with arithmetic point, exponential part (E, +/- sign, and three-digit number), and unit.
Example: -1.23456789012345E-003 A
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To Change Display Setup
View > Display Setup...
Display Setup
%-V Graph —’
Jur " - |
Name: sharing:  Scale: Min: Max:
P x: [veate =l | | [tnear =] [S00mv H| [2v B
£ YL Jidan =] Jmeone) =] fonear =] oA & [roma 8|
C vz fom =] Jnone) = [near =] Jos a3 [1s 8|
©¥3: Jidan =] Jmene) =] frog = 1A 8| [loma 8|
List Display [Parameters |
S| T | | S BT N |
c [vaate - L T |
 [Vsource - e Jomiax -
c den 5]
F o=
e [den 5]
oo 5]
oK Cancel Apply

This dialog box is used to change the graph scale and data to be displayed in the Data Display
window.

The X-Y Graph area sets the X and Y1 to Y8 axes of the X-Y Graph Plot area.
Name: Specifies the parameter for the axis

*Sharing: Specifies the group for sharing the Y axis scale. Select from Group 1, Group 2, Group 3,
Group 4, or None (no grouping). The Scale, Min, and Max values are shared by the Y axes in the
same group. The scale set by Run Time Auto Scale, Auto Scale, Zoom in, and/or Zoom out are also
shared. If another layer on the Data Display window contains an X-Y trace which has the same name
for both its grouped Y parameter and its X parameter, the scaling will also be shared by this X-Y
trace.

*Scale: Scale of the axis, Linear or Log
*Min: Minimum value of the axis
*Max: Maximum value of the axis

The List Display area selects the variables to be listed in the List Display area. Up to 20 variables
can be set.

The Parameters area selects the variables to be listed in the Parameters area. Up to 20 parameters
can be set.
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To See Print Preview

File > Print Preview...

=5 Print preview

Print Preview Ed

. Print Range
* Whole DataDisplay
" Graph Only

—Data to print

= Current Data Display
" All opened Data Display

[~ Scaling
@ AdjustTo: [100  B|% MNormal Size
{" Fit To Page

¥ Keep Aspect Ratio

Preview Cancel

50- OONBE S o Fese

L e e M A e S AR

Sedup N |48 amias (015 47772306 122 50 ]

The Data Display window provides the File > Print Preview... function to show the print preview.

This is an example of the print preview.

*Select the File > Print Preview menu to open the Print Preview dialog box.

*Set the Print Range, Data to print, and Scaling.

*Click Preview button. The Print preview window is displayed.
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File > Print

To Print Display Data

Print

Print Range
* Whole DataDisplay
" Graph Only

Data to print
* Current Data Display
" All opened Data Display

Scaling
@ AdjustTo: [100  B|% MNormal Size

" Fit To Page
=

Mext

Cancel

File > Save Image As...

Save Image As...

Savein: [(E) My Documents

My Documerts
.

59

My Computer

<«

- «eEcEr

- g
My Network  File name |
Plzces

Save as type:

bmp, emf, gif, or png format

The Data Display window provides the display image output capability to a printer or a file.
Before printing, connect a printer to the BISO0A/B1505A via the parallel interface or the LAN, and

set up it by using the Add Printer Wizard of Windows. After that, do following.

*Select the File > Print menu to open the Print dialog box.

*Set the Print Range, Data to print, and Scaling.

*Click Next button.
*Select the printer, and set the Properties.
*Click OK button.

You can export the display image to a file as shown below.

*Select the File > Save Image As... menu to open the Save Image As... dialog box.

*Select the format (file type) from Save As Type menu.

*Enter the file name.
Click Save button.

The file can be imported by the graphics software that supports the exported file type. The

EasyEXPERT supports the following types.
*bmp: Bitmap image

semf: Enhanced metafile

+gif: GIF image

*png: PNG image
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To Copy Graph Plot

(. Vth gmMax [(1) ; 4/7/2006 12:45:39 PM] - Agilent EasyEXPERT
File |Edit View Marker Cursor Line Window Help

1_Cop ariec_ V- A B a5 - A~
o | B ot -
St Copy T - Paste to WordPad
ey Copy Parameters Properties... | | |
nr‘gi Graph Properties. A L173100000¢-0n3 § = Document=WardPad BE) ]
54’2)“ List Display Properties... File Edit View Insert Format Help

Tntercents

D SR # sB- B

c -
£ T s T T T 7 0 O N 7
500u
Jdiv
w
MARKER( 1 v 04 A LI7HL0000E-003 S )
Ly
-8.8p 1 640 u
1 Vaate (V) 100 m /div Inercept
-1.53848 mA
Gradient
List Display 1ITHI0E-00
Index [ Vaate | Vsource [ Velain | s E]
1 500 mv ov 100 my = -
2 450 mv av 100 my i d
< m
0.0 u
Jdiv

L3B7Y

Feent

1 vgate (V) 100 m /div 2
n

For Help, pressF1

You can copy graph image to the clipboard, and paste it to a word processing software. In the above
example, the graph image is pasted to the WordPad.

This is an example of the copy and paste operation.
*Select the Edit > Copy Graph menu on the Data Display window.
Select the Edit > Paste menu on the WordPad.

2-27



Module 2

Data Display and Management

To Copy List Data

(. Vth gmMax [(1) ; 4/7/2006 12:45:39 PM] - Agilent EasyEXPERT

Fiier Edit View Marker Cursor Line _V!ingjuw Help

|| o cri+c | - | B e[ - A P N d
= G aste to Notepa
53{ Copy List PM]
IZ\’G Copy Parameters pi 4 Untitled - Notepad g@
=i . T = -
£ Agi Graph Properties. File Edit Format View Help
&) i o Index vgate vsource vdrain Vvsubs  Idrain gm =
40y List Display Properties... 2500 mv oV 100 mv 0V 404 fa -163.88 ps M
- -450 mv 0V 100 mv 0 Vv - 9 pa -81.58 ps
Intercept: -400 mv 0 ov 2.72999999999999 ps
4 -350 mv 0 /0V ~660.000000000007 5
H -300 mv 0 ¢ 0V -3,06999999999998 ps
c 5 -250 mv 0 /0v -810.000000000001 5
s 7 -200 mv 0 ¢ 0V -§50, 000000000006 f5
s 8 -150 mv Q v -1,73999999999998 ps
a -100 mv o ov 2.52 ps
10 -50mv 0V “Fa 32.02 ps
11 0 v ov 4 -6. 3800000000000 pS
500U 12 50 mv ov -8 -34.72 ps
b’d 13 100 mv O V 8
L 14 150 mv 0V 7
15 200mv OV
16 250 mv 0V
— 17 300 mv 0V
88p Ly 18 350w 0 v
k 19 400 mv OV
1 Vaate (V) 100 m /div 20 450 v OV
21 500 my OV
22 550 mv OV
it is 23 600 mv OV
Lt pisplay 21 gs0my 0V
Index | Vaate | Vsource | Vdrain [ 25 700 mv 0V
< p— vy vy 26 50mv_0V
A c [+] E F [ 1 7] K L M
1 findox  Vipte VeourceVdrain Vsubs ldrsin gm Sl
2 1 v ov 10 ov
3 ov ov 1714431 us
3 ov oV 5.31222999399999 us
5 ok i 2197377 us 5
[] ov ov
7 ov ov
8 ov ov
[} ov ov
10 ov av
i ov o Open by a spreadsheet software
13 ov ov
14 ov ov
15 ov ov

You can copy the data list to the clipboard, and paste it to a word processing software. In the above

example, the data list is pasted to the Notep

ad.

This is an example of the copy and paste operation.

*Select the Edit > Copy List menu on the D

ata Display window.

*Select the Edit > Paste menu on the Notepad.

You can save the data as a text file, and read it by using a spreadsheet software. Data elements are

separated by a tab.
Note:

As same as the Copy List function, the Copy Parameter function is used to copy the data in the

Parameter area.
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To Save Analysis Result

Select File > Update Test Result =% Saves graph information to data record.
Select File > Save Image As... 4

—> Saves graph image as a file.

(B
on Hep
Setup Name: [Vih_gmmax
X-¥ Graph Plot [Parameters ‘
7 Agilent
MARKER( Vv 1951 A 1951 A) Vth 2.072283158805
@ @) mMax
970 u 0 s, g F57.2u5
e -

722.239 u 5
Gradient;
4un.512)d u

169.013 uA

Idrain Idrain

Intercept: | 3.02228V

-500 m Vagate (V) 200 m /div 2

List Display

Index [ Vgate [ Vsource Vdrain | vsubs [ Idrain [ am| [a]
10 -50.00 mv oV 100.0 mv oV 139.940 vA 533.34 uS
11 ov oV 100.0 mV oV 167.360 uA 551.9 uS
12 50.00 mV oV 100.0 mV oV 195.130 uA 557.2uS

To leave the graph modification information such as scaling, marker, cursor, and line on the graph,
select the File > Update Test Result menu.

You can see the all information when you open the graph again. Note that the modification
information will be destroyed if you did not do it.

To save the graph image as a file, select the File > Save Image As... menu.

You can save the image as a bmp, emf, gif, or png file.
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Class Exercise

Use the analysis tools.

1.

Use your test setup (for example, GMMAX in the
Demo preset group) and perform measurement .

Enable marker and draw line. Try it for all line
types.

Copy/paste/save data list, and open it by using a
spreadsheet software (optional, if you can).

Save analysis condition. Re-open the test record.

Export your test record. And import it.

Note:
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To Use Preview Windo
[ Preview Settings
[General
Graph Title: [ID-VG Charactaristice =
X7V Axis Title |[Gne style
linel: [Z=———= ] Une2: | =
” v2: [rramndica vi: B 5
€ Vth gmMax [(1) ; 4/7/2006 12:45:39 PM] - Agilent EasyEXPERT = ‘ =l ‘ =
File Edit [View| Marker Cursor Line Window Hely “* Pencorert sl v | L | H ] E
I B2 Y Gravh = sl vs: [ = ve | = v ERRCE - |
S 1istDisplay F3 e v7: | ERCH - vz ERRCE |
SetupNan  pParameters F4 R |
T ' oK Cancel Apply Reset
XY CraphP|  Graph Legend OFF
v R e L L
Line Information OFF ' AT o R =
U Open Preview Window e = fCraph Trace Color =
G e ¥ Logoon Visible  Color  Thickness
~2.92216 v ardon « r I [—H
Zoom In Gradient! R v ¢ @ —3
. Zoom Out ! T v ¢ B —3
B 7 Cancel Scaling e :: : = ——TH
Choose Active Y Axis » Background:
[ ] v v [ [—3
ol Display Setup... e || v v m —3
fdiv | rid: = w v W —3
tne/cursor: [
oy scaie
88p Tiiercept: 132817V Mo decadesto 53] gecades
1 Vgate (V) 100 m /div s
Idrain gm Idrain X/Y Axis Title:  [Fedum =] 5] points
saale: fedom =] [ points
Legend: fedom =] [ points
=

The Data Display window provides the File > Print... function to print the graph image. However,
you may want to set the graph title and change the line style. Then use the Preview window. The
Preview window is used to see and print the graph image you modified.

Select the View > Open Preview Window to open the Preview window and the Preview Settings
dialog box. And use the Preview Settings dialog box to set the title of graph, X axis, and Y axis, and
change the line style. To change the color and thickness, use the Color and Thickness dialog box
opened by clicking the Color and Thickness... button.

Clicking OK button in the Preview Settings dialog box applies the modification to the Preview
window and closes the dialog box.

Note:
The graph image in the Preview window cannot be saved.
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To Use Preview Window

€ Vth gmMax [(1) : 4/7/2006 12:45:39 PM] (Preview) - Agilent EasyEXPERT =
File Edit View Help
Setup Name: J\.’tb gmMax [(1) ; 4/7/2006 12:45:39 PM]\
X-Y Graph Plot
ni- Agilent
) MARKER( 1.5000000000E+000 V 2.0162800000E-004 A 1.1734100000E-003 5 ) )
640 u = 3 N 12m
ntercept: e ———
-1.55849 mA i = i
o Gradient: e - M o
@ 1.173410E: T ~22 =]
5 == 8
d L= sl =
E Ex= =
£ 1 s
[a] 3
50.0u
Jdiv
8.8p ntefcept: 132817 V 170p
1 Gate Voltage (V) 100 m /div
Drain Curr... =---" Transcon... ——— - Drain Curr...
1D-VG Characteristics

This example is result of the changes shown in the previous page.
Line style was changed as shown above. The titles are set as follows.
Graph title: ID-VG Characteristics

X axis title: Gate Voltage

Y1 axis title: Drain Current

Y2 axis title: Transconductance

Y3 axis title: Drain Current

Also color of linel was changed to red, and thickness of trace was changed.

To change the setup again, open the Preview Settings dialog box by selecting the View > Preview

Settings... menu.
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Class Exercise

Use the Preview window.
1. Use your test record used in the previous exercise.

2. Change the graph image as you want.
- Add graph title and change axis title.
- Change line style
- Change color and thickness

3. Print the graph image if a printer is available.

Note:
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Note:
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Module 3
Classic Test Environment

In This Module

* Classic Test Execution Mode

* I/V Sweep Measurement

*  Multi Channel I/V Sweep Measurement
* I/V List Sweep Measurement

* I/V-t Sampling Measurement

* C-V Sweep Measurement

*  Switching Matrix Control

* Direct Control

Note:
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ile Data Display Help

Classic Test Execution Mode

i

IV Sweep

| Quick Test [ Tracer Test [[classic Test Jappiication Test
m
e
0

SPGU Control

b
Fiis

Control

T

e + 1/V Sweep

e I/V List Sweep
(2] * I/V-t Sampling
o | * C-V Sweep

* SPGU Control
» Switching Matrix Control

butching Matr| * Direct Control

e * Multi Channel I/V Sweep

Trmg 1d-vd

&)

Tmg Sampling )

HEEEN

= Flag | Setup Name

| Date | Count | Device ID

| Remarks

1)V Trace
Vth gmMax and Id

= ALWG monitor
ALWG monitor
— PG monitor

2009/09/18 16:59:38
2008/10/02 16:20:46

£ Charge Pumping 4T 0.1V step  2008/02/05 11:24:50

2008/02/01 20:36:02
2008/02/01 20:36:02
2008/02/01 20:35:43

1

[N

1

Id-vd

finital Workspace

[T thermometer OFF [/ Multi Display OFF |[] Standby OFF [0 SMUZero OFF || Auto Export OFF _|EZ] Auto Record OFF

ij

To use the classic test mode, click the Classic Test tab. And select the execution mode. The

following modes are available.

*I/V Sweep: For X-Y characteristics measurement of I or V.

*Multi Channel I/V Sweep: For simultaneous multi channel (up to 10) sweep measurement of [ or V.

I/V List Sweep: For multi channel (up to 10) I/V sweep measurement using list data.

*I/V-t Sampling: For time-Y characteristics measurement of [ or V.

*C-V Sweep: For DC bias-impedance characteristics measurement.
*SPGU Control: For voltage pulse output. Not available for BIS05A.
*Switching Matrix Control: For B2200/E5250 switching matrix control. Not available for B1505A.

*Direct Control: For various measurements (e.g. C-f measurement, Quasi-Static C-V measurement)

using Agilent FLEX commands.
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I’V Sweep Measurement ]

_ |
EEEER|
* To Define Source/Measurement Channels " )
I_II " S.'.l'-.' EE I:l
* To Read Time Stamp Data and Data Index
* To Set Source Outputs (VARI1, VAR2, VART’, Pulse, CONST)

* To Set Timing Parameters RIS

i Agilent

* To Set Sweep Abort Function [»~
« Range, ADC, Advanced, SPGU | *

* To Set User Functions

* To Set Analysis Functions

0 vd (V) 200 m fdiv 3

* To Set Auto Analysis Function
* To Set Display Parameters (X-Y Graph, Data List, Parameter)

This section explains how to perform I/V sweep measurement. You will perform the above tasks to
execute the I/V sweep measurement.
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To Define Source/Measurement Channels

TV Sweep

Channel Setup Setup Name

@|1/V Sweep Setup Name: [Tmg Id-vd )

- Channel Setup. | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
Channel Definition

addsmu | addsecu|  peeie | Uz |
Unit: ¥ Name: I Name: Mode: Function:
[l [ ] = [vPuLsE xfvar1 =l
[l O =fve efig EG =fvarz =l SMU4
el |SMU2:HP j|\.fs ElH §|\f jl[ONST =l
e |SMU1:HP j|\.rsuh e §|\f j|\fAR1‘ = SMU3
o— | —o
SMU Channel Definition SMU1
-V name/l name
-I/V/IPULSE/VPULSE/COMMON SMU2

-VAR1/VAR2/VART’/CONST
SPGU Channel Definition

-V name
-VPULSE/ALWG
Miscellaneous Yariables
Time Stamp Name: lm Index Name: lm

Click the I/V Sweep icon and open the setup editor. Then click the Channel Setup tab to display the
channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number. The GNDU (ground unit) can be set instead of a SMU.
*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current
pulse), or COMMON (ground)

*Function: Source output function, VARI (primary sweep), VAR2 (secondary sweep), VAR’
(synchronous sweep), CONST (constant)

V Name and I Name are used to specify the parameters displayed on the Data Display window. The
display parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is returned to
the V variable and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will appear.
Then set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform voltage)
for all SPGU.
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To Read Time Stamp Data and Index i

TV Sweep

Channel Setup

@|1/V Sweep Setup Name: [Tmg Id-vd

- Channel Setup. | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
Channel Definition

addsmu | addseau|  peeie | Uz |
Unit: ¥ Name: I Name: Mode: Function:
[l [ ] = [vPuLsE xfvar1 =l
[l O =fve =l EG =fvarz =l
el |SMU2:HP j|\.fs ElH §|\f jl[ONST =l
e |SMU1:HP j|\.rsuh §|Isuh §|\f j|\fAR1‘ =

Variable name for time stamp data

Variable name for data index

Miscellaneous Yariables \ \

Time Stamp Name: Bl Index Name: ‘ E

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V Name,
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the
display parameters.

Note:
The time stamp is the time the measurement is started for each measurement point.

The index is the index number for each measurement data.
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To Set Primary Sweep Source

Measurement Setup

g'l V Sweep Setup Name: [Trng Ichvd
| Measurement Setup IFum:tiDn Setup | Auta Analysiz Setup | Display Setup |

Char
VAl [var2 |[var1® |
/ Unit: [SMUHR ‘SMUE:HR | unit: AOTHE E] et
Name: [iid E & E| Name: lm ADC /.
Direction: lm Offset: lh‘ i
Linear/Log: lm Ratio: m v;s:;d
Start: [0V Hjfiv Bl| compliance: [looma 6]
stop: 5V &2V E||  Pwr comp: [oFF ] Eﬁf;ﬁ
step: [i0mv 8500 mv ] [5MU Pulse el |
No of Step: 5T 1 B El| unit: [FMOTFR H]
Compliance: [10 m& Bffrma | Period: [10ms  H]
\Pwr comp: [OFF o | width: [Tms 8|
Timing | Base: lm
Hold: [ B Delay: 7% Bl =gweep [ConTHEAT ANy =] status
Constants
Unit: Y Name: I Name: Mode: Source: Compliance:
SMUZHP Elvs =E G Elov B[Foma E

VARI1

Stop

s
Start

The Measurement Setup tab screen is used to set the source output value and timing parameters.

At the VARI area, you set the primary sweep source output.
*Unit: SMU name or number

*Name: Variable name of source output

*Direction: Single (start to stop) or Double (start to stop to start)
*Linear/Log: Linear sweep or Log sweep

«Start: Source output start value

*Stop: Source output stop value

Step: Source output incremental step value

*No of Step: Number of sweep steps

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value
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To Set Secondary Sweep Source

Measurement Setup

g'l V Sweep Setup Name: [Trng Ichvd
Cha | Measurement Setup IFum:tiDn Setup | Auto Analysiz Setup | Display Setup |
VAl [var2 |[var1® |
Rarige
unit; [SMU%HR 0B Ef Unit: [ERUTHR H 2
Name: [iid #lva = Name: [Vsub E ADC /.
- x Iritey
Direction: [Single = Offset: [0 v ]
Linear/Log: |LINEAR - Ratio: [0 El Ad-
= vanced
start: [0V &1y Bl| compliance: [100ma ]
SPGEL
Stop: [2v @[z v = Pwr Comp: [OFF B | Pule
Step: [60 mv 8500 mv 8| [SMU Pulse | it
No of Step: [51 B|[= & Unit: [SMU4HR ]
Compliance: [10 & 3"1 ma 8] Period: [10ms ]
Pwr Comp: [CFF i“OFF &l width: [1 ms [
Timing | Base: [0V ]

Hold: [0s H pelay: 75 H - Sweep [CONTINUE AT ANY | status
Constants |
Unit: Y Name: I Name: Mode: Source: Compliance:

SMUZHP Elvs =E G Elov B[Foma E

TV Sweep
VARI1
VAR2

— L

At the VAR2 area, you set the secondary sweep source output.
*Unit: SMU name or number

*Name: Variable name of source output

«Start: Source output start value

*Stop: Source output stop value

*Step: Source output incremental step value

*No of Step: Number of sweep steps

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value
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Classic Test Environment

To Set Synchronous Sweep Source

TV Sweep

Measurement Setup

g'l V Sweep Setup Name: [Trng Ichvd
Cha | Measurement Setup IFum:tiDn Setup | Auta Analysiz Setup | Display Setup |
VAl VAR2 |[var1®

Rarige
unit; [SMU%HR | Bl Unit: EMULHP ﬁ d VARI1
Name: [73 = E ame: [T |,
Direction: |Single - Offset: [0 Y F] s ﬂ

Linear/Log: |LINEAR ~ Ratio: m v;‘iea
Start: [0V H][rv Bl| compliance: [looma 6]
stop: 5V &2V E|\_ pwr comp: [oFF i, Eﬁf;ﬁ
step: [i0mv 8] [5o0mv ] [5MU Pulse el |
No of Step: |51 EI 3 ﬂ Unit: ,m VARI’
Compliance: [10 m& Bffrma | Period: [10ms  H]
Pwr Comp: [OFF 6] e El width: [[me B] ﬂ
Timing | Base: lm

Hold: [0s 8] Delay: i3 Bl ecweep [CONTHUEAT ANY =] status

Constants |

Unit: Y Name: I Name: Mode: Source: Compliance:
SMUZHP Elvs =E G Elov B[Foma E

At the VAR’ area, you set the synchronous sweep source output.
*Unit: SMU name or number

*Name: Variable name of source output

*Offset: B value of the above formula.

*Ratio: A value of the above formula.

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value

The VAR1’ output is expressed by the following formula.
VAR1’ output=A X (VARI output) + B
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To Set Pulse Output

TV Sweep
Measurement Setup
g'l V Sweep Setup Name: [Trng Ichvd
Chal [mlmmtinn Setup | Auto Analysis Setup | Display Setup |
VAl VAR2 |[var1® |
Unit: [SMUHR ] [sMUzHR | unit: AOTHE E] et
Name: [iid E| | Name: fisb = oo/
Direction: lm Dffset: lh‘ G .
Linear/Log: [TNEAR =] Ratios f ® || A Trigger
start: [0V Hiv 8]| compliance: lm e . .
stop: 5V &2V E]|  Pwr comp: [oFF ol Width Width
step: [i0mv 8] [5o0 mv ] [5MU Pulse | B2 | pind -
No of Step: 5T 1l B El| Unit: [SMOTHR 5
Compliance: [10 m& Bffrma | Period: [10ms  H] Base
Pwr Comp: [OFF B[jore | width: [Tms 8| e
Timing | A\ Base: lm \ .
Hold: [0s B Delay: [iz B -sweep e AT =]status \ Period
Constants | Hold time
Unit: Y Name: I Name: Mode: Source: Compliance:
ZRELE s =k EllR Bl [0 5 Delay time cannot be set.

At the SMU Pulse area, you set the SMU pulse timing parameter and the pulse base value.
*Unit: SMU name or number

*Period: Pulse period

*Width: Pulse width

*Base: Pulse base value

Only a SMU can be set to the pulse source.
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Measurement Setup

To Set Constant Output

g'l V Sweep Setup Name: [Trng Ichvd
Char [mlmmtinn Setup | Auto Analysis Setup | Display Setup |
VAl VARZ |[var1® |
Unit: [SMUHR ] [sMUzHR | unit: AOTHE E] et
Name: [iid E| E| Name: lm ADC /.
Direction: lm Offset: lh‘ i
Linear/Log: lm Ratio: m Ad-
vanced
Start: [0V H][rv Bl| compliance: [looma 6]
stop: 5V &2V E||  Pwr comp: [oFF ] Eﬁf;ﬁ
step: [i0mv 8] [5o0 mv ] [5MU Pulse |
No of Step: 5T 1l B El| unit: [FMOTFR H]
Compliance: [10 m& Bffrma | Period: [10ms  H]
Pwr Comp: [OFF B[jore | width: [Tms 8|
Timing | Base: lm
Hold: [ B Delay: 7% Bl =gweep [ConTHEAT ANy =] status
Constants |
Git: Y Name: I Name: Mode: Source: Compliance:
SMUZHP Elvs =E G Elov B[Foma E
\

TV Sweep

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current

pulse), or COMMON (ground)
*Source: SMU output value

*Compliance: SMU compliance value

3-1
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To Set Timing Parameters

Measurement Setup

g'l V Sweep Setup Name: [Trng Ichvd
Chat | MeasLrement Setup IFum:tiDn Setup | Auta Analysis Setup | Display Setup |
VAl VAR2 |[var1® |
Rarige
Unit: [SMUHR ] [sMUzHR | unit: [EMUTHP Fl J
Name: [iid E| E| Name: [Wsub H | oo/
- x Iritey
Direction: [Single - Dffset: |0V []
Linear/Log: |LINEAR - Ratio: [0 El Ad-
vanced
Start: [0V H][rv E|| Ccompliance: [100 ma [l
SPGEL
Stop: |3 W E 2 ¥ E Pwr Comp: [OFF ] Fulse
step: [i0mv 8] [5o0 mv ] [5MU Pulse |
No of Step: 5T H[: | Unit: [EM0EHR ]
Compliance: [10 & ﬂll ma 8] Period: [10ms ]
Pwr Comp: [CFF ﬂlOFF | width: [1 ms ]
Timing Basge: [0V ]

Hold: |05 8] Dpelay: [15 Bl | *cweep [CONTHUEAT ANY =] status
Constants |
Unit: Y Name: I Name: Mode: Source: Compliance:
E Elvs =E G Elov B[Foma E

Trigger

Measurement time

—>
+——>
_,—d,__,—1_
> \/
\ Delay time
Hold time

At the Timing area, you set the source output and measurement timing.

*Hold: Source output hold time. Time after the measurement trigger until starting delay time.

*Delay: Measurement start delay time. Time after the hold time until starting measurement.

When a SMU forces pulse, the delay time is ignored. Source output and measurement timing will be

controlled by the pulse width and pulse period.
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To Set Sweep Abort Function

Measurement Setup
g'l V Sweep Setup Name: [Trng Ichvd

Chat | MeasLrement Setup IFum:tiDn Setup | Auta Analysis Setup | Display Setup |
VAl VARZ | VARL' ‘
Rarige
Unit; [SMU4HR | B JEl| Unit: [FMULHR i 5
Name: [iid E| E| Name: [Wsub H | oo/
- x Iritey
Direction: [Single & Offset: 0V ]
Linear /Log: [LINEAR B Ratio: [0 W Ad
vanced
ji

Start: [0V H][rv E|| Ccompliance: [100 ma
stop: [V &2V = Pwr Comp: [OFF W Eﬁf;ﬁ
BT 6] [pm mv JeTf o "~ CONTINUE AT ANY
No of Step: |51 EI 3 IEl| Unit: ,m STOP AT ANY
Compliance: [10 m& Bffrma El| Period: [10ms  H] ABNORMAL
Pwr Comp: [OFF 01| B3 &l width: [Tms 8] -Range overflow
Timing | Base: [Iv | -SMU compliance
Hold: [0s B Delay: 7% B [ »sweep [FoNTmuE AT Ar =] status ] -SMU oscillation
Constants |
Unit: Y Name: I Name: Mode: Source: Compliance:
SMUZHP Elvs =E G Elov B[Foma E

This field sets the sweep abort function.
When this field is CONTINUE AT ANY, the sweep measurement is not aborted.

When this field is STOP AT ANY ABNORMAL, the sweep measurement will be aborted when one
of the following conditions is detected.

*Measurement range overflow
*SMU compliance
*SMU oscillation
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To Set Ranging Mode

Measurement Setup

. l Range Not available when a SMU pulse is used.

ADC /

Intog
e Measurement Range |
vanced U I o
SEEE Unit: Name: Mode: Range: Range Change Rule: Rate:
Setup o [sMuLHP B|fi2 | LMITED  w|fina  ~[|BY FULL RANGE i | G|
o JemuzHRias  Efi2 Emmer w|ine <[y FULL RanGE (=] =
o [emuzHrias B[ HlmTen  wfina <[y FULL RaNGE i | &
o [EMU4HR |4 E|LMITED  wffina || FULL RANGE |z ][t 8|

The Range button opens the SMU Range Setup dialog box. The dialog box is used to set the
measurement ranging mode. This button is not available when a pulse source is used.

*Unit: SMU name or number

*Name: Variable name for the measurement data

*Mode: Ranging mode, AUTO, LIMITED, or FIXED

*Range: Range value

*Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
*Rate: Value used for range changing. See the following formula.

For the AUTO or LIMITED, SMU automatically selects the minimum range that covers the
measurement value, and performs the measurement by using the range. For the limited auto ranging,
the instrument does not use the range lower than the specified range value. For example, if you
select the 100 nA limited auto ranging, the instrument never uses the 10 nA range and below.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules, specify the Rate value, 11 to 100,
which fixes the boundary of the ranging. The ranging occurs when the measurement data goes across
the boundary values shown below.

go up boundary = present measurement range X Rate / 100

go down boundary = present measurement range X Rate / 1000
The go down boundary is available only for the UP AND DOWN AHEAD rule.
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To Set ADC/Integration Time
Measurement Setup

Range
ADC | A/D Converter
Iriteg
Ad

o Unit: Name: ADC: Measurement:
vanced [Euzhe Bl = =] Jromgiance sice =
SPGU ISMUz:HR ﬂllz HIHR ADC jl(nmphamce Side d
SPSEE [EUzR S e [FR ADC =] [eomglance Side =
[erusirr 8] s =] |compliance Sice =

Integration Time

Mode: Factor: Auto Zero:
High Resolution ADC: IAUTO jlﬁ EIOFF :I
High Speed ADC: [8UTO =]t B
Close

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box. The dialog
box is used to select the ADC for each SMU and set the integration time for each ADC (high
resolution or high speed).

A/D Converter:

*Unit: SMU name or number

*Name: Variable name of the measurement data

*ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)

*Measurement: Compliance side measurement or Force and Compliance sides measurement.
HR ADC is not available for HCSMU, HVSMU, and the measurement which uses SMU pulse.
Force and Compliance sides measurement is not available for HRSMU, MPSMU, and HPSMU.
Integration Time:

*Mode: ADC operation mode

AUTO, MANUAL, or PLC for HR ADC

AUTO, MANUAL, PLC, or TIME for HS ADC
TIME or PLC for the measurements using SMU pulse.

*Factor: Coefficient for the reference value of the integration time.
*Auto Zero: Auto Zero function ON or OFF. For HR ADC.
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Advanced Setup
Measurement Setup

Range

ADC /
Integ

Ad-
wanced

SPGU
Fulse
Setup

Advanced Setup i

Channel Settings

Unit: YName: IName: Series R:

SMU Filter:

[Eotee It EB [ NOME =lfon |
[zrRas &]ve EB [ NoHE EES =l
[EaozrRias &z EE EEE o =l
[EMOaR Elfva =z = [NONE D =l

'Wait Time Control

Factor:

Output Wait: |1 )
Measurement Wait: |1 8

After Measurement Settings

Bias Hold after Measurement: | OFF B

Output Value after Measurement: | START -

[semiconductor Relays ( 16440A SMU/PG Selector)

tHL [oErauT 7] cH3: [Pouoren 7]

Close

The Advanced button opens the Advanced Setup dialog box. The dialog box is used to set the SMU
filter and SMU series resistor settings, the wait time, the after measurement settings, and the 16440A
selector semiconductor relay setting.

Channel Settings:

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Series R: SMU series resistor NONE or IMOHM (1000000 ohm)
*SMU Filter: SMU filter ON or OFF
Wait Time Control:

*Factor: Coefficient for the reference value of the wait time. For details, see online help or User’s

Guide.

After Measurement Settings:
*Bias Hold after Measurement: Bias hold function ON or OFF.

*Output Value after Measurement: Source output value after measurement. START (sweep start
value), STOP (sweep stop value), SOURCE (sampling output source value), or BASE (sampling
output base value)

Note: Pulse channel output after measurement is always Base value.

Semiconductor Relays (16440A SMU/PG Selector):
*CH1: Default or PGU OPEN
*CH3: Default or PGU OPEN

The fields define the selector channel’s switch condition during the measurement. Default is the

setting defined on the SMU/PG Selector screen of the Configuration window.
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SPGU Pulse Setup

Measurement Setup

Jopcupdsesetur
(Global Settings [Operation voutz | pule
Range Period: [1us 8] | & FREERUN € PULSE COUNT f 5 -
€ DURATION TE 5
400 £ [Pulse Settings
Iriteg SPGU setup view order: _ Un | oo |
ad Unit: [Primary Pulse Jddllinnal Pule |
] [EPGUTHY | Base: [0V EY H
UName: Peak: |S00my ]| ElleRy ]
SPGU c T — Delay: [0s B|[0s [
Fulse width: [100ns &[0 &
Setup s Leading: [P0 ECR
povipuke Trailing: [20ns | &
Unit: [Primary Pulse dedllmnal Pulke |
- . [EPaUziH Bl Base: [0V AoV H
This button is - e ol
: O powe g e P [
available when e |—_|mm —3
Type: 5
a SPGU channel | peeme— R
is defined in
Channel Setup.

If a SPGU channel is defined and set to the VPULSE mode on the Channel Setup screen, the SPGU
Pulse Setup button is effective. This button opens the SPGU Pulse Setup window which is used to
define the voltage pulse output by the specified SPGU channels. Maximum 10 SPGU channels can
be used. Not available for B1S05A.
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SPGU ALWG Setup

Measurement Setup

Range

ADC

Integ sPeuawesets

[operaton ] Pulse

Ad- Loae 21 i
vanced = FREE RUN " SEQUENCE COUNT |1 EI

SPGU " DURATION |1 us HI
ALWG

Setp ALWG Setting |

ALWG Source: Ia iI
This button is

available when Closa

a SPGU channel /

is defined in

Channel Setup. This button opens the Define ALWG

Waveform window used to define the
arbitrary linear waveform.

If a SPGU channel is defined and set to the ALWG mode on the Channel Setup screen, the SPGU
ALWG Setup button is effective. This button opens the SPGU ALWG Setup window which is used
to define the arbitrary linear waveform voltage output by the specified SPGU channels. Maximum
10 SPGU channels can be used. Not available for B1505A.
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Classic Test Environment

To Set User Functions

Function Setup @|1/v Sweep Setup Name: [Tng 1dvd
Channel Setupl Measurement Setup Auto Analysis Setup | Display Setup |

User Function

/ Add I Delete |

Name: Unit: Definition:

o [psi0 =2 s |

Data calculation
-Measurement data/source data
-Built-in function, etc.

N\ _

Analysis Function

Add Delete 18] | D |

Name: Unit: Definition:

© [pope =l rljpLic JEl|

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The user
functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data
Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.

Note:

The Apply button performs calculation of the definition in this screen. If this button is clicked when
the Data Display window associated with this test has been opened, the display is also updated. The
associated Data Display window will be the Data Display window that displays the last measurement
data or that is recalled at last.
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Classic Test Environment

To Set Analysis Functions

Function Setup @|1/v Sweep Setup Name: [Tng 1dvd
Channel Setupl Measurement Setup Auto Analysis Setup | Display Setup |

User Function

Add I Deletel (]} | D |

Name: Unit: Definition:

o [psi0 =2 s |

Analysis Function

[ Add Delete Uz | Dowm

Name: Unit: Definition:
© [pope =l rljpLic JEl|

Data calculation
-Measurement data/source data
-Read out function

\ -Built-in function, etc. /

The analysis functions can be displayed on the Parameters area of the Data Display window. Up to
20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

-Read out functions

For details, see online help or User’s Guide.

Note:

The Apply button performs calculation of the definition in this screen. If this button is clicked when
the Data Display window associated with this test has been opened, the display is also updated. The
associated Data Display window will be the Data Display window that displays the last measurement
data or that is recalled at last.
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To Set Auto Analysis Function

TV Sweep

. ;
Auto AnalySlS @|1/v Sweep Setup Na'\ng 1d-vd 1
Chanmel Sstup | Measurement Sstup | Function Setupl Dispilay Siatup | Apply

!
Interpolation (T irerpoistion Moce
Line 1

ﬁJ Enable Type Axis m\

Ol © Normal ¢ Gradient @ Tangent ' Regression b
First Foint -

. € %y Coordinate @ Data Condition
Line 1 setup

Candition: |Vﬂ H = !1 5 L] AﬂErl 5 5 | 5
Second Paint
@ x-y Coordinate € Data Condition
\ X | 5 e | 5 )
Line 2
— ‘
ﬂ_ Enable Type S \
= Fix @ Normal € Gradient € Tangent ¢ Regression 7L T
First Foint
& %Y Coordinate € Data Condition
Line 2 setup X = v =
Second Paint
& %-¥ Coordinate € Data Condition
< | 3
Marker
¥ Enable
Marker Setup Condition: [wd ENE = [ oafer | ER El

Click the Auto Analysis Setup tab to display the auto analysis setup screen. The auto analysis
capability allows you to display/move the marker/line on the data graph automatically after
measurement. The above example displays marker at Vd=1 V point and draw a tangent line for this
point.

Interpolation Mode: Check this box to enable the interpolation mode. You can position marker
between measurement points.

Line 1, Line 2: This area sets the line 1 or line 2 automatically displayed and moved to the specified
position after the measurement. Check Enable box to enable the line.

For Type, select a line type, Normal, Gradient, Tangent, or Regression.
For Axis, select the axis effective for the line.

In First Point and Second Point, specify the cursor points used to draw line.
In Gradient, specify the slope of the Gradient line.

Marker: This area sets the marker automatically displayed and moved to the specified position after
the measurement. Check Enable box to enable the marker.

For Condition, enter a variable name and a condition expression to specify where you want the
marker to display.

For After, check this box to enable the additional condition. And enter a second variable and
condition expression. This sets up a search start condition for finding specified point.

For example, you can specify the following expressions to search for a measurement point that
satisfies the first condition after the second condition is satisfied.

Condition: [DGM] = [MAX(DGM)*0.01] [x] After [DGM] = [MAX(DGM)]

Note:

The Apply button performs calculation of the definition in this screen. If this button is clicked when
the Data Display window associated with this test has been opened, the display is also updated. The
associated Data Display window will be the Data Display window that displays the last measurement
data or that is recalled at last.
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. e |
To Set X-Y Graph Display ol
TV Sweep
Display Setllp gh/\f Sweep Setup Name: Ing Id-vd '
Channel Setup | Measurement. Setup | Function Setup | AuUto Analysis Setupl Display Setup I
X-¥ Graph
K Add I Delete | {/a) | D | \
Name: Sharing:  Scale: Min: Max:
F % |vd =] [Merel =] furnear =] [ov E v il
Lol |Id j |(Nnne) j |Lmear j |UA EI |1El s E
o v2: [aesiD =] [roney =] [near =] foa 8] [oma IE]|

Specify X axis and Y axis

N _/

List Display Parameters
Add | De\etel g | DEwn | Add | Delete | {1} | Do |
 |index - = ©  |Sope -
L g -
© fvd -
o jid -
|

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set
the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the X axis
*Scale: Linear or Log
*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis
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L L .‘l“=-|
To Set Data List Display i
TV Sweep
Display Setllp gh/\f Sweep Setup Name: Ing Id-vd ' |
Channel Setup | Measurement. Setup | Function Setup | AuUto Analysis Setupl Display Setup I
X-¥ Graph
Add I Delete | {/a) | D |
Name: Sharing:  Scale: Min: Max:
F % |vd =] [Merel =] furnear =] [ov E v il
Lol |Id j |(Nnne) j |Lmear j |UA EI |1El s E
o v2: [aesiD =] [roney =] [near =] foa 8] [oma IE]|

Select variables to list

va

List Display / Parameters

( Add | Eelete | g | DEwn I\ Add | Delete | {1} | Do |
e | B P |
L g -
O T —

\ o jid - 5 j

The List Display area selects the variables to be listed in the List Display area of the Data Display
window. Up to 20 variables can be set.
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. e |
To Set Parameters Display i
/V Sweep
Display Setllp gh/\f Sweep Setup Name: Ing Id-vd ' |
Channel Setup | Measurement. Setup | Function Setup | AuUto Analysis Setupl Display Setup I
X-¥ Graph
Add I Delete | {/a) | D |
Name: Sharing:  Scale: Min: Max:
F % |vd =] [Merel =] furnear =] [ov E v il
Lol |Id j |(Nnne) j |Lmear j |UA EI |1El s E
o v2: [aesiD =] [roney =] [near =] foa 8] [oma IE]|

Select parameters to display

List Display Parameters \
Add | De\etel g | DEwn | [ Add | Delete | {1} | Do |
€ |index - = © |Slope -
L g -
© fvd -
=
o jid Bl \

The Parameters area selects the variables to be listed in the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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To Save Test Setup

Run Option
Count: [0 g

Device 1D:
My Favorite Setu L

N My Favorite Setup button

N Preset Group name.
Use this field to
select preset group.

The test setups you create MUST be saved to the internal hard disk drive as “My Favorite Setup”.
To save the setup, click the Save button.

To recall the setup, click the Recall button.

You can organize the setups by using Preset Group. In the above example, the Demo group is
selected and listed in the “My Favorite Setup”.

To create a new preset group, click the My Favorite Setup button to display the function menu, and
select Add New Preset Group.

To select the available preset group, use the field below the My Favorite Setup button.
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To Export/Import Your Preset Group

E ==
— (=P
Run Option
Count: m

Device ID:

My Favorite Setup button

i
T

Cancel

Preset Group Export

Add Mew Preset Group

= Rename This Preset Group Preset Group Export EE
Rename
Sl Duplicate This Preset Group Saven: Qe oo ¥] + EckEy
uplicate
i Delete This Preset Group Demo
Delete
Delete All il
Deskton
My Documerts
b
(I} .3
wok  Fle game: - Save
« g o
] Save as ype: [EasyEXPERT Preset Group Files - Cancel l

Recall

You can export/import your preset group.

To export the present preset group, click the My Favorite Setup button, select Export, and specify the
folder and the name of the preset group to export.

To import the preset group, click the My Favorite Setup button, select Import, and specify the preset
group to import.
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Class Exercise

Define test setup and perform test.

1.

. Export preset group, and import it.

Click I’V Sweep icon and open setup editor.

. Define test setup as shown in the previous pages.

2
3.
4
5

Save it as Trng 1d-Vd.

. Connect device, and perform test.

SMU4
SMU3

SMU1

SMU2

Note:
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Measurement Result Example

il

TV Sweep
'€ Trng 1d-Vd - Agilent EasyEXPERT L__JEITE'
File Edit View Marker Cursor Line Window Help
ol —l g T ol © B C [ ] u F i
T e X@- DEHEMNaE-FA-EF[] >
Trng Id-Vd |ng 1V (7] 4112006 5265 | Trmg 16-Vd [(6] : 41112006 5:26:1 . | Trng ld-Vid [(5] ; 41112006 5:24:1 . |
Setup Name: |ng 1d-vd = ¥
X-Y Graph Plot Properties... | | |Parameters j
X% Agilent ; ” e
(8 ki i o a2 A} Slope  [3.77778 ua
10m m
o respt
78w TR
Gradiant: Gradient:
2, 777783E-006 L77TTE3E006
=
= a
5
1.00m
fdiv
o 0
200 m fdiv 3
List Display Properties... | ]
Index | Indexl Vgl le Idl T\mel M
4/15 15 v 840 mv 40.5 uA 142.54 ms
4/16 16 1v 900 mv 39.5 A 152.54 ms =
4/17 17 1v 960 mv 40.5 uA 162.54 ms v

This is a test result example displayed on the Data Display window.
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Multi Channel I/V Sweep

* To Define Channel Setup Screen

To Set VAR1 S S MU
* To Se weep Sources ’

P Channel I/
* To Set Constant Qutput Syres D

Other Measurement Setup Parameters

To Set User Functions

To Set Data Display

This section explains how to perform the Multi Channel I/V sweep measurement. You will perform
the above tasks to execute the Multi Channel I/V sweep measurement.
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Multi Channel I/V Sweep

Voltage or current

Stop value 7 Start measurement
0 — L»‘
Start value Delay time

Hold time
Voltage or current

Stop value Delay time

Start value |

o
Voltage or current

Stop value

1

Start value |

=: Measurement

Primary sweep source

Second sweep source

Tenth sweep source

Multi
Channel IV
Swieep

Time

Multi Channel I/V Sweep measurement is similar to I/'V Sweep measurement.

Changes from I/V Sweep are listed below.
*All SMU can be set to the VAR1 sweep source (up to 10 channels)
*All SMU can be set to the pulse output mode

*Both voltage mode and current mode are available for the VARI sweep output

*VARI1’ sweep output is not available

The output channels start to output in the order in which they are listed on the Channel Setup screen.

If multiple pulse output channels are used, the DC output channels start to output in the order in
which they are listed on the Channel Setup screen, and then the pulse output channels start to output
simultaneously. And the all measurement channels perform measurements simultaneously.
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8|
To Define Channel Setup Screen i
Multi
Channel IV
Swesp
Channel Setup Setup Name
@] Multi Channel T/V Sweep Setup Name: |[Trng Muiti ]
Channel Setun JMeasurernent Setup | Function Setup | Auto Analysis Setup | Display Setup |
annel Definition
addsmu | addspal| [pee=| [ Ua | [mown |
Unit: ¥ Name: 1Name: Mode: Function:
e |SMU1:HP j|vh =[h §|\f jI\IARl =l
e |SMU2:HR jl\/e e §|\f j|VAR1 =l
~ |SMU3:HR j|vh = 5|v leONST |
[l I =i Ei ~lfcamsT =l

SMU Channel Definition
-V name/I name
-I/V/IPULSE/VPULSE/COMMON

-VAR1/VAR2/CONST
SPGU Channel Definition
AV TR Variable name for reading time stamp data
-VPULSE/ALWG / Variable name l;or reading data index
Miscellaneous Yariables /

Click the Multi Channel I/V Sweep icon and open the setup editor. Then click the Channel Setup tab
to display the channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number. The GNDU (ground unit) can be set instead of a SMU.
*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current
pulse), or COMMON (ground)

*Function: Source output function, VARI (primary sweep), VAR2 (secondary sweep), CONST
(constant). Up to 10 sources can be set to VARI.

V Name and I Name are used to specify the parameters displayed on the Data Display window. The
display parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is returned to
the V variable and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will appear.
Then set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform voltage)
for all SPGU.

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V Name,
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the
display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index
is the index number for each measurement data.
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To Set VAR1 Sweep Sources a8

Multi
Channel IV
Swesp
Measurement Setup
@|Multi Channel I,V Sweep Setup Name: [Trng MU
Chann Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
VARL
Direction: [Single =l Lnear/Log:[mEsR x| o of Step: 101 B B SMU1

Unit: Name: Start: Stop: Compliance: Pwr Comp: ADC / Stop
EwoTHe  @|[vh =0 H|[z5v E|ioma  @][oFF G| -
IEMU2:HR ] [ve Hpv &|[ssomy  E[ame  &|forF | A Start

vanced

e

Pllse
\_ Jeasi SMU2

Stop
Timing | Start
Hold: |05 8| Delay: 0+ & * sweep [CONTINUE AT ANY ~| status

Constants |
Unit: ¥ Name: 1 Name: Mode: Source: Compliance:
[EMUzZHR E[fve =ib ElD Eljpv (E][1o00 ma |
[Erausr E]fc | ED Al B[00 ma |

The Measurement Setup tab screen is used to set the source output value and timing parameters.
At the VARI area, you set VAR sweep sources.

Follows are common parameters for all VAR1 sweep sources.
*Direction: Single (start to stop) or Double (start to stop to start)
*Linear/Log: Linear sweep or Log sweep

*No of Step: Number of sweep steps

Following parameters can be set for each VAR sweep sources.
*Unit: SMU name or number

*Name: Variable name of source output

«Start: Source output start value

*Stop: Source output stop value

*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value

3-32



Module 3
Classic Test Environment

Measurement Setup
@|Multi Channel I,V Sweep Setup Name: [Trng MU
Chann I|"’|EEiSLleH‘ﬂE”1t Setup IFUFIEUDH Setup | Auto Analysis Setup | Display Setup |
VARL
Direction: [Sindle =l Lnear/Log:mEsR x| o of Step: 101 B B
Unit: Name: Start: Stop: Compliance: Pwr Comp: ADC /
EwoTHe  @|[vh =0 H|[z5v E|ioma  @][oFF G| -
[Eruzir B [ve Hpv &|[ssomy  E[ame  &|forF | A
vanced
e
Pllse
Setlp
Timing |
Hold: |05 8| Delay: 0+ & * sweep [CONTINUE AT ANY ~| status
Constants |
(Unit: ¥ Name: 1 Name: Mode: Source: Compliance:
[EMUzZHR E[vb =ib ElD Eljpv (E][1o00 ma |
[Erausr E]fc | ED Al B[00 ma |
N

Multi
Channel IV
Swieep

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)

*Source: SMU output value

*Compliance: SMU compliance value

3-33



Module 3
Classic Test Environment

Other Measurement Setup Parameters

Multi

Timing

Hold: |0 5 8| Delay: 0: & [* Sweep [CONTIMUE AT ANY - status]
Constants |
Unit: ¥ Name: 1 Name: Mode: Source: Compliance:
[EMUzZHR E[vb =ib ElD Eljpv (E][1o00 ma |
[Erausr E]fc | ED Al B[00 ma |

Channel IV
Swieep
Measurement Setup
@|Multi Channel I,V Sweep Setup Name: [Trng MU
Chann I|"’|EEiSLleH‘ﬂE”1t Setup IFUFIEUDH Setup | Auto Bnalysis Setup | Display Setup |
VARL = - ~
Direction: [Sindle =| Linear/Log: LINEAR =l moof step: [101 =] e Range
Unit: Name: Start: Stop: Compliance: Pwr Comp: ADC / ADC /
[EMOTHE B [vh =pv H|[z5v E[iooma B8] [oFF E| ey e,
[Eruzir B [ve Hpv &|[ssomy  E[ame  &|forF | A
vanced e
SFEEU
Pules
< ad-
i vanced
SFEEL
Pulse
=)

For the functions of Timing, Sweep status, Range, ADC/Integ, Advanced, SPGU Pulse Setup, and
SPGU ALWG Setup, see the following pages respectively in the I/'V Sweep section of this module.

*To Set Timing Parameters
*To Set Sweep Abort Function
*To Set Ranging Mode

*To Set ADC/Integration Time
*Advanced Setup

*SPGU Pulse Setup

*SPGU ALWG Setup

If a SMU is set to the pulse output:

The Range button is not available.

The dialog box opened by the ADC/Integ button is different from the I/V Sweep. See “A/D

Converter & Integration Time Setting” page.

The Pulse button is available which opens the Pulse Setup dialog box. See “Pulse Setup” page.
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A/D Converter & Integration Time Setup -

Multi
Channel IV
Swieep

Measurement Setup

Rarige A/D Converter
- ADC / Unit: Name: ADC: Measurement:

it | SR Bl [Hs and] x| [compliance Side =l
Bika JSMUZIHR, E= m=[HS ADC x| [Fompliance Sids I

| SENELE EH|E = |Hs ADC | [compliance Side |
Va‘:cc‘; : [EruaHR Bl ‘s Hs ADC = [compliance Side =l
SFGU
Pulse

ﬂ Integration Time
Mode: Factor: Auto Zero:
High Resolution ADC: | leaN El k|
High Speed ADC: |TIME j|2 s E
Pulse Averaging Count
Count: |1 izl
Close

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box. The dialog
box is used to set the operation of the high speed ADC.

A/D Converter:

*Unit: SMU name or number

*Name: Variable name of the measurement data

*ADC: ADC type, HS ADC (high speed)

*Measurement: Compliance side measurement or Force and Compliance sides measurement.
HR ADC is not available for HCSMU, HVSMU, and the measurement which uses SMU pulse.
Force and Compliance sides measurement is not available for HRSMU, MPSMU, and HPSMU.
Integration Time:

*Mode: ADC operation mode TIME or PLC.

*Factor: Coefficient for the reference value of the integration time.

Pulse Averaging Count:

*Count: Number of pulsed measurements for averaging to get one measurement data. Not effective
for HRSMU, MPSMU, and HPSMU. The setting is automatically set to the same setting on the Pulse
Setup dialog box for using multiple SMU pulse output channels.
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p Multi
Channel IV
M t Set e
easurement Setup For multiple pulse sources
[fommon ]
Range
Period: |AUTO B
A0C /
Integ veasurement Delay Time IAUTO B
Integration Time
- Pulse
Mode: Factor: Auto Zero:
va‘:wcc‘;ad High Resolution ADC: I jINaN ﬂl ;‘
SPGU High Speed ADC: [TIME =l E
gs‘lzz Pulse Averaging Count |
. Count: |1 B
For single pulse source
Pulse Channels |
SMU Pulse Unit: Name: Pulse Delay Time: width: Base:
jsMuLHR vl s E|f1 ms E|fov IEl|
Unit: |SMULHP B
SMUZHR |2 E{j0 B[l B0 B
Period: Im I JI —” = JI e JI —l
Width: |1 ms E]
Base: [0V 7

Common:
*Period: Pulse period. Entering AUTO sets the optimum value automatically.

*Measurement Delay Time: Delay time from the beginning of the pulse period to the beginning of the
measurement. Entering AUTO sets the optimum value automatically so that the measurement is
completed when the transition from peak to base is started by the pulse output channel which starts
the transition at first.

Integration Time:

*Mode: ADC operation mode TIME or PLC.

*Factor: Coefficient for the reference value of the integration time.
Pulse Averaging Count:

*Count: Number of pulsed measurements for averaging to get one measurement data. Not effective
for HRSMU, MPSMU, and HPSMU.

The Integration Time and Count settings are automatically set to the same settings on the A/D
Converter & Integration Time Setup dialog box.

Pulse Channels:

*Pulse Delay Time: Delay time from the beginning of the pulse period to the beginning of the
transition from base to peak. This value must be 0 for HRSMU, MPSMU, and HPSMU.

*Width Pulse width. The value must be the same for HRSMU, MPSMU, and HPSMU.

*Base: Pulse base value
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To Set User Functions #
Channel IV
Function Setup ‘ e
@|Multi Channel 1,V Sweep Setup Name: [Trng Mt i

Chanrel Setup | Measurernent Setup | Function Setup § auto Analysis Setup | Display Setup

Aply

User Function

( Add I De\etel (5]} | Duwn\h

Name: Unit: Definition:

c [vba EG =] fwb-va B

Data calculation
-Measurement data/source data
-Built-in function, etc.

N /

Analysis Function

Add Delete {E]c} | Do |

Name: Unit: Definition:

To add a function parameter, press the [Add] button in this area,

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The user
functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data
Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.
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Display Setup

To Set Data Display

@ ‘Multi Channel I/\V Sweep
Channel Setup | Measurernent Setup | Function Setup | Auto Anabysis Setupl Display Setup I

Setup Name: |ng MUt '

\

=%-¥ Graph
/ Add | Delete | Up | DEvwr | \
Name: Sharing: Scale: Min: Max:
o ox: [vbe = [mered = [unear  F] ov 8| 1v 8|
O e =] [ioney =] Jiog =l [ ] [1nma 8]
el 8 T =] [inone) =] Jrog = Jofe 8] [100ms |

Specify X axis and Y axes
Select variables to list j

List Display

Parameters

[ e

/
| De\etel (if]c] | /D\:lwm |\

Add | Delete | Upy BEwer) |

i e i e e

he

Ic

b

vh

=/

To add a parameter, press the [Add]
button in this area.

Multi
Channel IV
Swieep

Click the Display Setup tab to display the display setup screen.
The X-Y Graph area is used to set the X axis and Y axes of the X-Y Graph Plot area in the Data

Display window.

*Name: Name of variable to plot on the X axis

*Scale: Linear or Log

*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data Display
window. Up to 20 variables can be set.

For example, following variables are set for the Class Exercise.

Vbe, Ic, Ib, Vh, Ih
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Class Exercise ““i
nnel IV

Cha
Swieep

Define test setup and perform test.

1. Click Multi Channel I/V Sweep icon and open setup
editor.

2. Define test setup as shown in the previous pages.
3. Save it as Trng Multi.

4. Connect devices (NPN Bipolar Transistor and Red
Miniature LED) as shown in next several pages, and
perform test.

5. Export preset group, and import it.

Note:
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SMU Triax Connection

Force Lines to Fixture 1,2,3,4 Ports

CMU (CNCRCONC)

SMU4 -2 ° ®.®
SMU3 .t -«
SMU2 -t

SMU1 °

GNDU @®

iy
.#&'
Multi
Channel I/V
Sweep

Force side Sense side
AW V4

|

s

16442A/B Fixture

184

-, ® ° @ e
:-@@ ®®

g

B1500A Rear View

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers. On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 - 3.

Your B1500 may not match the SMU configuration shown in this figure. Note that SMU1 is the
module top of the GNDU (ground unit). The SMU number become large from bottom to top as

shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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Multi

Jumper Leads - MOS transistor Channel v

Sweep

C
% 00000000000 B
O ] EBC 17: Emitter
2 28 16: B
’ 1|:| 000a00000ad I’i“ Shorter Lead 15, C?:leector

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force
and sense, or six SMUs with force only. For this class example we will use the six (6) SMU scheme.

Connect jumper leads as follows.

Terminal 13 :
: GNDU F terminal

Terminal 14

Terminal 15 :
Terminal 16 :
Terminal 17 :

SMUI F terminal

SMU4 F terminal
SMU3 F terminal
SMU?2 F terminal

Locate the bipolar transistor in the corner of the 28-pin dual in line socket as shown, with the flat side
of the device facing toward you. Unlike the MOS device, the bipolar transistor is not static sensitive.
You may touch the leads without using a ground strap.

Locate the LED between terminals 13 and 14 of the 28-pin dual in line socket.

3-41



Module 3
Classic Test Environment

Measurement Result Example 4

Multi
Channel IV
Sweap
€ Multi Channel IV Sweep - Agilent EasyEXPERT M= <)
File Edit View Marker Cursor Line Window Help

B R S@-BeERE e @-FA-50

SetupName:  |Multi Channel IV Sweep

sl

x
X-Y Graph Plot Properties... ‘
5 Agilent
® (a
100m 100 m

decade

fdiv
if
0 Vbe (W) 100 m fdiv 1

List Display Properties... | ‘
Index | vbe | ic| b vh | Ih| [»]
o9 833 mv 21.813 mA 170.76 uA 245V 77.742 mA

100 841.5 mV 23.446 mA 188.8 uA 2475V 80.717 mA

101 850 mv 25.087 mA 207.68 uA 25V 83.8 mA @

This is a test result example displayed on the Data Display window.

At the start of measurement, LED lights off. Beyond the threshold voltage, the LED lights on.
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I/V List Sweep e e

* To Define Channel Setup Screen I List

To Set VAR1 Sweep Sources Swieep
* To Set Constant Qutput

Other Measurement Setup Parameters

To Set User/Analysis Functions

Auto Analysis Setup
* To Set Data Display

This section explains how to perform I/V List sweep measurement. You will perform the above
tasks to execute the I/V List sweep measurement.

I/V List Sweep measurement is similar to I/V Sweep measurement.
Changes from the I/V Sweep are listed below.

*VAR1/VAR2 step output values are set by using a vector data. Vector data from a spreadsheet
software, either tab separated or comma separated can be copied to the Define vector data dialog
box via the Windows clipboard.

*All SMU installed in the B1500 can be set to VARI.
*VARI’ is not supported.

For more information, see online help or User’s Guide.
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To Define Channel Setup Screen -

Channel Setup Setup Name

(D] 1/V List Sweep Setup Name: [[Trmg List ]

- Channel Setup | Measurement Setup | Function Setup | Auta Analysis Setup | Display Setup |
Channel Definition

addsuy | [Addspal| [pee| [0 | [Boun |

Unit: ¥ Name: I Name: Mode: Function: \
el |SMU1:HP j|\.rsuhs = [lsubs §|\f jl[ONST =l
e |5MU2:HR j|\.rsnuma §|Isuurca §|\f j|c0N5T =
o [uzHe =lfvaate = [loate = = ]fver1 |
 [sMuaHR =] [werain Eficrain = =lronsT |

SMU Channel Definition
-V name/I name
-V/I/VPULSE/IPULSE/COMMON

-VAR1/VAR2/CONST
SPGU Ch 1 Definiti
annet betmition Variable name for reading time sfamp data
-V name
-VPULSE/ALWG / Variable name for reading data index
Miscellaneous Variables / /

Click the I/V List Sweep icon and open the setup editor. Then click the Channel Setup tab to display
the channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number. The GNDU (ground unit) can be set instead of a SMU.
*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current
pulse), or COMMON (ground)

*Function: Source output function, VARI (primary sweep), VAR2 (secondary sweep), or CONST
(constant). Note: Up to 10 sources can be set to VARI.

V Name and I Name are used to specify the parameters displayed on the Data Display window. The
display parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is returned to
the V variable and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will appear.
Then set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform voltage)
for all SPGU.

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V Name,
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the
display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index
is the index number for each measurement data.
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Measurement Setup

To Set VAR1 Sweep Sources

{9]| jst Sweep Setup Name: [Trmg List
Cha IMeasurement Setup IFunctinn Setun | Auto Analysis Setup | Display Setup
VARL |
Unit: Sources: Compliance:  Pwr Comp: RERES
[EXEE I I B[ome E|[orF H e
Integ
-
File  Edit v
1
= el
1l-500 my
0 Pl
Grid button zov e
3/500 My |
41y
5105 v
611V
7115y
Timing I > v
Hold: |05 B 1 by ~|stats
Ok Cancel LS
Constants
Unit: ¥ Name: 1 Name: Mode: Source: Compliance:
[Emue B|fvas ‘ol suibs [ Elov B|[100 ma Ell
[emz:HR 8fvsaurce = flsource =y Efpv 8|[1moma El|
[Emua:R “E|fvdran ‘el idrain v B[00 mv B][100 ma |

/W List
Svieep

The Measurement Setup tab screen is used to set the source output value and timing parameters.

At the VARI area, you set VAR sweep sources.

*Unit: SMU name or number

*Source: Click the grid button to open the Define vector data dialog box. Enter the vector data of
VARI. For example, -500 m, 0, 500 m, 1, 1,05,1.1, 1.15, 1.2, 1.25, 1.3, 1.35, 1.4, 1.45, 1.5, 1.55, 1.6,
1.65,1.7,1.75,1.8,1.85,1.9,1.95,2, 2.5, and 3 V are set for the Vth-gmMax. Step voltages near the

gmMax are set to 50 mV and others are set to 500 mV.
*Compliance: SMU compliance value

*Pwr Comp: SMU power compliance value
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To Set Constant Output =

/W List
Svieep

Measurement Setup

@ ‘ ist Swee] Setup Name: [Trng List
Char Measurement Setup § Function Setup | Auta Analysis Setup | Display Setup

VARL |
Unit: Sources: Compliance:  Pwr Comp: RERES
{EVEE I | B[ome E|[orF H e
Integ
Ad-
vanced
el
Pujse
Sefup
Timing ‘
Hold: |05 B Delay: [m].. B s gyeep [ONTNEATANY 7] status
Constants ‘
Init: ¥ Name: 1 Name: Mode: Source: Compliance:
|EEE B [vaubs = [lsubs e[ Elov B|[100 ma Ell
[erz:HR 8fvsaurce = flsource =y Efpv 8|[1moma El|
[Emua:R “E|fvdran ‘el idrain v B[00 mv B][100 ma |
AL

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data
[ Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current
pulse), or COMMON (ground)

*Source: SMU output value. For example, Vdrain is set to 100 mV for the Vth-gmMax.

*Compliance: SMU compliance value
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Measurement Setup

Other Measurement Setup Parameters

Setup Name: |ng List

@| ist Sweey
Char Measurement Setup i Function Setun | Auto Analysis Setup | Display Setup

VARL | ( )
Unit: Sources: Compliance:  Pwr Comp: RERES
{EVEE I | B[ome E|[orF H e
Integ
Ad-
vanced
el
Pujse
Sefup
Timing
Hold: |05 ] Delay: [M].. W] [' Sweep [CONTINUE AT &MY = status]
Constants ‘
Unit: ¥ Name: 1 Name: Mode: Source: Compliance:
[Emue B|fvas ‘ol suibs [ Elov B|[100 ma Ell
[emz:HR 8fvsaurce = flsource =y Efpv 8|[1moma El|
[Emua:R “E|fvdran ‘el idrain v B[00 mv B][100 ma |

/W List
Svieep

For the functions of Timing, Sweep status, Range, ADC/Integ, Advanced, SPGU Pulse Setup, and
SPGU ALWG Setup, see the following pages respectively in the I/'V Sweep section of this module.

*To Set Timing Parameters
*To Set Sweep Abort Function
*To Set Ranging Mode

*To Set ADC/Integration Time
*Advanced Setup

*SPGU Pulse Setup

*SPGU ALWG Setup
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To Set User/Analysis Functions

/W List
Svieep

.
Function Setup

@|1/v List Sweep Setup Name: [Trna List

Channel Eetupl Measurernent Setup Auto Analysis Setup | Display Setup

Apply.

User Function

add |

Delete |

Up

| Dawr |

Name: Unit: Definition:
ol |gm §|5 jld\ff(ldra\n,\/gate)

3

Data calculation

-Built-in function, etc.

-Measurement data/source data

Analysis Function

Add

Belete

Ua

| B |

Name: Unit: Definition:
o foma E=ls lfnaigms [El
c o = el Ell
o futh £ = ]fon-tidraing2) ]|

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The
user/analysis functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of
the Data Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.

-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component

-Built-in functions and global variables

For details, see online help or User’s Guide.

For example, following user/analysis functions are set for the Vth-gmMax.

<Name> <Unit> <Definition>
Gm S diff(Idrain,Vgate)
gmMax S max(gm)

Von v @L1X

Vth v Von-(Vdrain/2)

For built-in functions, see online help or User’s Guide.
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Auto Analysis Setup

.
Auto Analysis Setup
g|1/\f List Sweep Setup Nalge” | Trmg List i
Channel Setup | Measurement Setup | Function SatupDisp\ay Setup |
Epply.
™ Interpolation Mode
Line 1
¥ Enable Type Axis
(l' Fix " Mormal  Gradient & Tangent ¢ Regression vl '\
First Point -
€ ¥-¥ Coordinate & Data Condition
Condition: [am | = [omMax | [ after | R =
~Second Paint 3
@& 3-¥ Coordinate € Data Condition
K X | H =i | g)
Line 2
[ Erable [ TVPe A
I Eix @ Mormal € Gradient € Tangent € Regression vl =
First Point
@ %-¥ Coordinate € Data Condition
x| = vio | =
Second Point
& 3-¥ Coordinate # Data Condition
| E i E
Marker
I~ Enable
Condition: ER e | == =

Click the Auto Analysis Setup tab to display the Auto Analysis setup screen. This screen is used to
set the automatic analysis function. When a measurement finishes, the function automatically draws

lines, a marker, or both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function.

In the Line 1 and Line 2 areas, you can set up the lines to be drawn.
In the Marker area, you can set up the marker.

For details, see online help or User’s Guide.

For example, the Line 1 is set for the Vth-gmMax.
Type: Tangent

Axis: Y1

First Point: Data Condition

Condition: gm = gmMax
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° =
To Set Data Display =
IV List
Sweep
.
Display Setup
@|[1/v List Sweep Setup Name: [T List i
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setupl Display Setup I
X-¥ Graph
Add | Deletel U | D |
Name: Sharing:  Scale: Min: Max:
% [veate =] [foer 7] [frer =] [soomv W] BV H
Oy lIdrain j |(None) j |Lmear j |—1 mé, £| |10 mA ﬂ
O Yo Igm j I(Nune) j ILmear j IUS EI IlU ms E
AN

Specify X axis and Y axes

Select variables to list

72
List Display / Parameters

Add | Delete | y{ | Down | Add | Delete | U | Do |

Z

© |voate - = o jgmMax -

o |vsource - © th -

© |vdrain =

Select parameters to list
i |vsubs -

Click the Display Setup tab to display the display setup screen.

The X-Y Graph area is used to set the X axis and Y axes of the X-Y Graph Plot area in the Data Display
window.

*Name: Name of variable to plot on the X axis

*Scale: Linear or Log

*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

For example, following axes are set for the Vth-gmMax.
<Name> <Sharing> <Scale> <Min> <Max>

X Vgate Linear -500mV 3V

Y1 Idrain (None) Linear -1mA 10 mA

Y2 gm (None)  Linear O0S 10 mS

The List Display area selects the variables to be listed in the List Display area of the Data Display window. Up
to 20 variables can be set.

For example, following variables are set for the Vth-gmMax.
Vgate, Vsource, Vdrain, Vsubs, Idrain, gm

The Parameters area selects the variables to be listed in the Parameters area of the Data Display window. Up to
20 parameters can be set.

For example, following parameters are set for the Vth-gmMax.
gmMax, Vth
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Class Exercise |

IV List
Svieep

Define test setup and perform test.

1.

Click I/V List Sweep icon and open setup editor.

. Define test setup as shown in the previous pages.

2
3.
4

Save it as Trng List.

. Connect an N-ch MOSFET as shown in next several

pages, and perform test.

Export preset group, and import it.

Note:
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SMU Triax Connection

Force Lines to Fixture 1,2,3,4 Ports

CMU ©
SMU4 .= °- ®.®
SMU3 .t -«
SMU2 -t
SMU1 °

GNDU @®

Force side Sense side
AW V4

|

s

16442A/B Fixture

184

-, ® ° @ e
:-@@ ®®

g

B1500A Rear View

For the non-Kelvin connections, connect only the Force lines, leaving the Sense lines open.

Connect corresponding numbers. On the 16442A/B fixture use the numbers labeled 1 - 6, not 1 - 3.

Your B1500 may not match the SMU configuration shown in this figure. Note that SMU1 is the
module top of the GNDU (ground unit). The SMU number become large from bottom to top as

shown.

This is the SMU cable setup that will be used in the remainder of the class exercises.
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Jumper Leads - MOS transistor

@ 00000000000000 1608860002
> >8 Dual in line package
00000000000000) (28 pin)

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force
and sense, or six SMUs with force only. For this class example we will use the six (6) SMU scheme.

On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is
shown in white reverse background lettering.
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Device Orientation and Insertion

15

Sub

Jgpuooopuooood

Insert the transistor last, 1: Substrate 1
AFTER connecting the 2: Source

cables and leads. Remove 3: Gate

the shorting wire after 4: Drain

insertion in the socket.

The MOS FET leads must be re-arranged into a straight line as shown.

IMPORTANT:

The MOS FET is highly sensitive to electrostatic damage. Touching the bare leads can definitely
destroy the device. The device comes with a special shorting wire attached. Bend the leads the way
you want, insert the device in the socket, and then remove the shorting wire. The wire has a tab. Just
grab the tab and pull straight out. The wire will spiral out as you pull.

Once the shorting wire is removed, you must use a wrist strap when handling the device.
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Measurement Result Example

IV List
Swieep
'€ Trog List [(1) ; 4/23/2007 9:12:45 AM] - Agilent EasyEXPERT M= x|
File Edit View Marker Cursor Line Text Pointer Window Help
r e ; : O == B =
B- @ Q 5/ - |12 G o8- -
Setup Name:  [Trng List [(1) ; 4/23/2007 9:12:45 AM] b
[X-¥ Graph Piot Properties... Parameters |
% Agilent
MARKER{ 1 v i 5) gmMax 'W
12m A Lim
2 um Vth 1.00451 V
2 1im -
= ooy =
800U N
T00u
00u
s00u
= 400u
g 30u
= W
100u
-150p
-S0m [ s0m 1 15 2 25 E
Vgate (V) 500m fdiv <] [T 1(2)
List Display Properties...
Index | Vgitel Vsuur(el Vdmml Vsuhsl ]dmml gm[
8 1.zo00 v oV 100.00 mV oV 155.620 uA 1.048740000 ms =
2 1.2500 v ov 100.00 mV oV 209.960 uA 1.074000000 mS M
<] M B

This is a test result example displayed on the Data Display window.

3-55



Module 3
Classic Test Environment

I/V-t Sampling Measurement

* To Define Channels and Variables

* To Set Sampling Parameters

* To Set Stop Condition

* To Set SMU Outputs (CONST)
* Range/ADC/Advanced/SPGU

* To Set User Functions/
Analysis Functions

* To Set Data Display

E
K7
L

L-"'u_."-t
Sampling

X-Y Graph Plot

[ Agilent
Q)]
12n

it

1.00n
Jdiv

200 m Jdiv 3
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To Define Channels and Variables LJ;

Channel Setup Setup Name

@ |I/\."-t Sampling Setup Name: leg Sarmpling I

- Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
Channel Definition

Addsmu | [AddspaU| [pelete| | Up | [ ooen |
Unit: ¥ Name: 1 Name: Mode:
[r- |SMU1:HD j|v1 = §|\/ =l ]
SMU Channel Definition
-V name/l name SMU1
-I/V/COMMON i
-CONST
SPGU Channel Definition
-V name l

-VPULSE/ALWG GNDU

Variable name for time stamp data

Variable name for data index
\
Miscellaneous Yariables \ \
! N

Time Stamp Name: \ E Index Name: E

Click the I/V-t Sampling icon and open the setup editor. Then click the Channel Setup tab to display
the channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List SMUs used for source output or measurement, and set the following parameters.
*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)

*Time Stamp Name: Variable name for the time stamp data

*Index Name: Variable name for the data index

V Name and I Name are used to specify the parameters displayed on the Data Display window. The
display parameters are selected on the Display Setup tab screen. For the GNDU, 0 V is returned to
the V variable and no data is returned to the I variable.

To use the SPGU channels, click the Add SPGU button. The SPGU channel setup row will appear.
Then set the following parameters.

*Unit: SPGU name or number
*V Name: Variable name for the voltage data. No data is returned to the variable.

*Mode: SPGU output mode. VPULSE (voltage pulse) or ALWG (arbitrary linear waveform voltage)
for all SPGU.

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V Name,
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the
display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index
is the index number for each measurement data.
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To Set Sampling Parameters Lg,

Measurement Setup !

Q"I,/V-t Sampl Setup Name: [Trng Samping

Channel Setunl Measurement Setup IFur‘vctinn Setun | Auto Analysis Satup | Display Setup |

Sampling Parameter Stop Condition
S Range
Linear/Log: |LINEAR A Enable/Disable: [EMABLE i
ADC
Interval: [30 ms z] ) Enable Delay: |0s B Integ
No of Samples: {101 ] Name: |I1 - Ad-
vanced
Total Sampling Time: |3 5 B Threshold: |0 A B
SpGl
Output Sequence: [SEQUENTIAL o Event: [val < Th - Filse
Senin
Hold Time: |100 ms 8 No. of Events: |1 B
Base Hold Time: |0 = ]
Constants |
Unit: ¥ Name: 1 Name: Mode: Base: Source: Compliance:
SMULHP B[ =i = Efov H5v B[[ome 8

Trigger
Measurement time

4‘—>

>

/
Hold time NSampling interval

Click the Measurement Setup tab to display the setup screen for the sampling timing parameters and
the SMU source output parameters. At the Sampling Parameter area, you set the following sampling
timing parameters.

Linear/Log:

Sampling mode. LINEAR for linear sampling. LOG10, LOG25, LOG50, LOG100, LOG250, or
LOG500 for logarithmic sampling. For the logarithmic sampling, the number after LOG indicates
the number of measurement data in a decade. For example, LOG10 mode is used to get 10
data/decade.

For the log sampling, the B1500 holds only the data that can be plotted on the log scale in the same
distance as close as possible. Only the held data is counted in the number of measurement result data.

For the linear sampling with Interval < 2 ms, if the total measurement time runs over the specified
time Interval X No of Samples, the sampling measurement will be stopped even if the number of
measurement result data is less than the specified No of Samples.

Interval:
Interval of the sampling, in seconds. 0.002 to 65.535 s, 0.001 s resolution.

Interval < 0.002 s in 0.00001 s resolution is also available for the linear sampling. It must satisfy the
following formula. For details, see online help or User’s Guide.

Interval > 0.0001 + 0.00002 X (number of measurement channels-1)
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To Set Sampling Parameters Lif

Measurement Setup !

@|1/V-t Sampl Setup Name: [Trng Samping

Channel Setunl Measurement Setup IFur‘vctinn Setun | Auto Analysis Satup | Display Setup |

Sampling Parameter Stop Condition
Range
Linear/Log: |LINEAR A Enable/Disable: [EMAELE =
ADC
Interval: [30 ms z] Enable Delay: |0s B Integ
( No of Samples: |101 ] \ Name: |11 = Ad-
vanced
Total Sampling Time: |3 5 B Threshold: |0 A B
SPRGU
Output Sequence: [SEQUENTIAL o Event: [val < Th - Plilse
Senin
Hold Time: |100 ms 8 No. of Events: |1 B
k Base Hold Time: |0 s ] )
Constants |
Unit: ¥ Name: 1 Name: Mode: Base: Source: Compliance:
SMULHP B[ =i = Efov H5v B[[ome 8

Trigger
Measurement time

4‘—>

>

Hold time NSampling interval

No of Samples:
Number of samples. Integer. 1 to the following value.

For linear: 100001 / (number of measurement channels)
For logarithmic: 1 + (number of data for 11 decades)

Total Sampling Time:
This field just displays the total sampling time that is the time from the measurement start time for
the first point to the end of sampling measurement. It does not include the hold time.

Total Sampling Time = Interval X No of Samples

Output Sequence:
Source output sequence. SIMULTANEOUS or SEQUENTIAL.

Hold Time:

Time since the Source value output until the first sampling point, in seconds. 0 to 655.35 s, resolution
0.01 s.

The following values are also available for Interval < 0.002 s. [Hold Time| will be the time since the
sampling start until the Source value output.

-0.09 to -0.0001 s, resolution 0.0001 s.

Base Hold Time:
Hold time of the Base value output until the Source value output, in seconds. 0 to 655.35 s, resolution
0.01 s.
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To Set Stop Condition

Measurement Setup
@1/v-t Sampli!

L‘.‘-f't
Sampling

Setup Name: |ng Sampling

Channel Setunl Measurement Setup IFur‘vctinn Setun | Auto Analysis Satup | Display Setup |

Sampling Parameter Stop Condition
Range
Linear/Log: |LINEAR b cnahIE/Disahle: EMAELE i
ADC
Interval: [30 ms z] Enable Delay: |0s B Integ
No of Samples: |101 ] Name: |11 = Ad-
vanced
Total Sampling Time: |3 5 B Threshold: |0 A B
SPRGU
Output Sequence: [SEQUENTIAL o Event: [val < Th - Filse
Setup
Hold Time: |100 ms 8 \ No. of Events: |1 B
Base Hold Time: |0 = ]
Constants |
Unit: ¥ Name: 1 Name: Mode: Base: Source: Compliance:
SMULHP B[ =i = Efov H5v B[[ome 8
Trigger
Measurement time
> +—>
Hold time Sampling interval

The stop condition is defined by using the Stop Condition fields on the Measurement Setup screen.

This function stops the measurement as shown below.

1. Compares the value of parameter set to the Name field and the value defined in the Threshold

field.

2. Counts how many times the selected Event occurs.

3. When the count reaches the value defined in the No. of Events field, sampling is stopped

immediately.
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Measurement Setup

@1/v-t Sampli!

To Set SMU Outputs (CONST)

a2
4354
L‘.V't
Sampling

Setup Name: |ng Sampling

Channel Setunl Measurement Setup IFur‘vctinn Setun | Auto Analysis Satup | Display Setup |

Sampling Parameter Stop Condition
Range
Linear/Log: |LINEAR A Enable/Disable: [EMABLE i
ADC
Interval: [30 ms z] Enable Delay: |0s B Integ
No of Samples: {101 ] Name: |I1 - Ad-
vanced
Total Sampling Time: |3 5 B Threshold: |0 A B
SPRGU
Output Sequence: [SEQUENTIAL o Event: [val < Th - Filse
Senin
Hold Time: |100 ms 8 No. of Events: |1 B
Base Hold Time: |0 = ]
Constants |
Unit: ¥ Name: 1 Name: Mode: Base: Source: Compliance:
SMULHP B[ =i = Efov H5v B[[ome 8

SMU constant output setup

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data
*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)

*Base and Source: SMU output value

*Compliance: SMU compliance value

Base value is available for all output channels for the SIMULTANEOUS mode and the last source

channel for the SEQUENTIAL mode.
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Measurement Setup

@1/v-t Sampli!

Range/ADC/Advanced/SPGU Setup

Setup Name: |ng Sampling

Channel Setunl Measurement Setup IFur‘vctinn Setun | Auto Analysis Satup | Display Setup |

Sampling Parameter Stop Condition
Range
Linear/Log: |LINEAR A Enable/Disable: [EMABLE =
ADC
Interval: [30 ms z] Enable Delay: |0s B Integ
No of Samples: |101 ] Name: |11 = Ad-
vanced
Total Sampling Time: |3 5 B Threshold: |0 A B
SPRGU
Output Sequence: [SEQUENTIAL o Event: [val < Th - Filse
Setup
Hold Time: |100 ms 8 No. of Events: |1 B
Base Hold Time: |0 = ]
Constants
Unit: ¥ Name: 1 Name: Mode: Base: Source: Compliance:
SMULHP B[ =i = Efov H5v B[[ome 8

a2

N

L‘.V't
Sampling

For the Range, ADC/Integ, Advanced, SPGU Pulse Setup, and SPGU ALWG Setup buttons, see the
following pages respectively in the I/V Sweep section of this module.

*To Set Ranging Mode

*To Set ADC/Integration Time
*Advanced Setup

*SPGU Pulse Setup

*SPGU ALWG Setup

Note:

If the range changing occurs during measurement, the SMU may not complete measurement within
the sampling interval. So use FIXED range if the sampling interval is top priority and the

resolution/sensitivity is second priority.
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Function Setup

To Set User Functions/Analysis Functions

g|1f\f—t Sampling

Channel Setup | Measurement Setup

Setup Name: |ng Sampling

Function Setup | auto Analysis Setup | Display Sstup

2pply.

User Function

| Delete |

U | DT |

Unit: Definition:

ﬂlsec jlde\ta(ﬂme)

Name:
c [pelta

Data calculation
-Measurement data/source data
-Built-in function, etc.

Analysis Function

Add

Belate

U | Do |

Definition:

Name: Unit:
O IAverage HIA jlavg(ll)

Data calculation

-Measurement data/source data
-Read out function

-Built-in function, etc.

a1

W2
4354
L‘.‘-f't

Sampling

Click the Function Setup tab to display the User Function/Analysis Function setup screen.

The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data
Display window. Up to 20 functions can be set.

*Name: Function name

*Unit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.

*Variables for the measurement/output data used in this test

*Functions defined in the above lines

*Local variables passed from the application test that calls this test as a component

*Built-in functions and global variables

For details, see online help or User’s Guide.

The analysis functions can be displayed on the Parameters area of the Data Display window. Up to 20 functions

can be set.

*Name: Function name

eUnit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.

*Variables for the measurement/output data used in this test

*Functions defined in the above lines

*Local variables passed from the application test that calls this test as a component

*Built-in functions and global variables

*Read out functions

For details, see online help or User’s Guide.
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To Set Data Display Lt”

.
Display Setup
g|UV't Sampling Setup Name: [Trng Sampli
Channel Setup | Measuremnent Setup | Function Setup | Auto Analysis Setupl Display Setup I
X-¥ Graph
Add | Deete | Up | Dowr |
Name: Sharing:  Scale: Min: Max:
Fox:  [Time =] [werey = urex 5] os 8] [3s |
(el 's 0 IIl j I(Nuﬂe) j IL\near j IEIA E |12 na E
Specify X axis and Y axis
List Display [Parameters
Add | Beete | Up | D | Add | Delate | (i} | Down |
Lo Time - [ e \bwerage - ]
La] 11 ut .
Select parameters to display
© |Delta - *
Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set
the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the X axis
*Scale: Linear or Log
*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data Display
window. Up to 20 variables can be set.

The Parameters area selects the variables to be listed in the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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Class Exercise

Define test setup and perform test.

1.

. Export preset group, and import it.

Click I/V-t Sampling icon and open setup editor.
. Define test setup as shown in the previous pages.

2
3.
4
5

Save it as Trng Sampling.

. Connect device (capacitance), and perform test.

Si/IT;Ul
T

GNDU

5

N

L“-f't
Sampling

Note:
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Measurement Result Example

€ Trig Sampling [(23) ; 8/17/2005 4:08:53 PM] - Agilent EasyEXPERT mEx|
Fie Edit View Marker Cursor Line Window Help
1 T SEI T e = — e
| EEEEEESRL e R R
Setup Name: ITrng Sampling [(23) ; 8/17/2003 4:08:53 P
[X-¥ Graph Plot } |Parameters ]
% Agilent
o) Average [3114051041666
12n
8
1.00n
Jdiv
0
0 Time (s) 200 m Jdiv
List Display |
Index | Time | 1 Daita | [~
1 Hall 5 VAN A Nall sac =)
2 Hall s v Nal A Nall sec
3 Hall s v Nall A lall sec
4 Hall s v Nal A Hall sec
5 Mzl s V Nal A N3N sec
5 1000 ms 1145270 nA Nall sec
7 1277ms 623160 nA 28.8 msec
8 157.6ms 521890 nA 30 msec
9 1877 ms  6.09990 nA 30 msec
10 317.6 M5 5.57960 nA 30 msec (]

vt
Sampling

This is a test result example displayed on the Data Display window.
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C-V Sweep Measurement J_,—"r

i

C-V Sweep

* To Define Channels and Variables

* To Set Sweep Source

* To Set Signal Source

* To Set Measurement Timing and Abort Function
* To Set SMU Outputs (CONST) [cerpmeor

[ Agilent
A

* Range/Advanced 2

MARKER[ 0V 1,1723200000e-0i2 F  1,8315100000=-006 5 )

* To Set User Functions/ :
Analysis Functions

* To Set Data Display i

* To Perform Compensation ,
and Correction s ) w50 jaw e

This section explains how to perform C-V sweep measurement. You will perform the above tasks to
execute the C-V sweep measurement.
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To Define Channels and Variables .

C-V Sweep
Channel Setup Setup Name
@ |C-V Sweep Setup Name: Ing [ ]
Channel Setup [Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
Channel Definition
Add SMU | Delete | Up | Down |
Unit: ¥ Name: I Name: Mode: Function:

el |SMU1:HP jl\ls [ §|\f leONST =l

& |EMU2‘HR j|\ld §|12 §|\/ leONST =

 [muLeE =llva Ell =l fvart =

SMU1
Channel Definition
. CMH

-CMU/SMU

-V name/I name o o

-I/V/ICOMMON CML

SMU2
Variable name for time stamp data
Variable name for data index
Miscellaneaus Variables \
<
Time Stamp Name: E Index Name: E

Click the C-V Sweep icon and open the setup editor. Then click the Channel Setup tab to display the
channel definition screen.

*Enter the Setup Name for the test setup to be defined on the setup editor.

«List units used for source output or measurement, and set the following parameters.

*Unit: MFCMU/SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
*Function: CONST or VAR1

*Time Stamp Name: Variable name for the time stamp data

eIndex Name: Variable name for the data index

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V Name,
I Name, Time Stamp Name, and/or Index Name entry fields, you can choose the variables as the
display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index
is the index number for each measurement data.
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To Set Sweep Source

Measurement Setup

@ Sweep Setup Name: [Tmg v
Charr Measurement Setup JFunction Setup | Auto Analysis Setup | Display Setup |
C-v (VAR1)

Signal Source |

[VNamE: |\/g 3 F"ECI}'"E"‘C\I' add | Deietel Un | Dy |
ist:
Model: [Cp-G -
@ |1 MHz B
C Name: |C g
G Name: m F Name: |Freq g

Direction: [Single -
Linear/Log: |LINEAR -
Start: |5V B

Stop: |5V

—
ji

AC Level: ,m

Step:

Integration Time |

Range

ADC /
Integ

Ad-
vanced

Compliance:
w of step: [101 Mode: [PLC x| Factor: ]2 [l
Timing ‘

Hold: IU 5 ﬂ Delay: ID S ﬂ * Gweep |CONTINUE AT ANY ~|status
Constants |
Unit: ¥ Name: I Name: Mode: Source: Compliance:
[emorP s alfin [ Elfov B[00 ma 15|
[pMuzbR et EE EIG Bl v 8] [100 me 8|

CV sweep

ol

e
C-V Sweep

Stop
Step
Start

The Measurement Setup tab screen is used to set the source output and timing parameters.
At the C-V(VAR]) area, you set the DC bias output of the MFCMU.

*V Name: Variable name of the MFCMU output

*Model: MFCMU measurement mode. Primary and secondary measurement parameters.

*(C) Name: Variable name of the primary measurement parameter

*(G) Name: Variable name of the secondary measurement parameter

*Direction: Sweep direction, single (start to stop) or double (start to stop to start)
*Linear/Log: Sweep output, LINEAR, LOG10, LOG25, or LOG50. where the number following

LOG means the number of sweep points in one decade.
«Start: Source output start value
*Stop: Source output stop value

Step: Source output incremental step value

*Compliance: Only for SMU. Compliance value. Enter the current limit value for the voltage source,

or the voltage limit value for the current source.

*No of Step: Number of sweep steps
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To Set Signal Source

Measurement Setup

@ Sweep Setup Name: [Tmg v
Charr Measurement Setup JFunction Setup | Auto Analysis Setup | Display Setup |
C-v (VAR1)

Signal Source |
Ll m G’Efli:‘:_"w Add | Delete | Up | Dowm e
Model: m . ADC
camE & @ [imme 8 Imgf
G Name: m F Name: |Freq g Va‘?—‘d[;gd
Direction: m AC Level: lm
Linear/Log: lm
start:[5v @] N J
Stop: lh,
Step: lm
Compliance: lﬁ [Integration Time |
No of Step: [i01 5| mode: [PLC | Factor: |2 I
Timing ‘

Hold: [0 5 B Delay: 05 H]  “Sweep feonTIE AT e <] status
Constants |
Unit: ¥ Name: I Name: Mode: Source: Compliance:
[emorP s alfin [ Elfov B[00 ma 15|
[pMuzbR et EE EIG Bl v 8] [100 me 8|

o

C-V Sweep

*Frequency List: MFCMU output frequency
*F Name: Variable name of MFCMU output frequency
*AC Level: MFCMU oscillator level, 10 mV to 250 mV, 1 mV resolution
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Measurement Setup

To Set Meas. Timing and Abort Function

o

C-V Sweep

Sweep abort function

@ Sweep Setup Name: [Tmg v
Charr Measurement Setup JFunction Setup | Auto Analysis Setup | Display Setup |
C-v (VAR1)

CONTINUE AT ANY
STOP AT ANY

Signal Source

o - range | ABNORMAL

5
M:::: ICE_G—_I ;E Freqi::ta:l'lcv Add | Delete | Upr | D | — -Range overflow

i @ [ime 8| il | -MFCMU error
Lo NomezlC = -SMU compliance
G Name: 5 = L™ = s | _SMU oscillation
Direction: m AC Level: lm
Linear/Log: lm
sarcfsv H| Trigger

stop: fV M|
step: fuomy ]| Integration time (AUTO or PLC) Measurement time
Ccompliance: lﬁ [Integration Time |
No of Step: [iD1 ]| Mode: pic =] Factor: |2 0| ]
Timing _,_:__1_
hold: 05 B| pelay:[s  E| | "Sweep JCONTIMUE AT abry | status ] Dad
ol elay: R
Constants f
Unit: VNayé: I Name: Made: Source: compliance: .
S E"\;s/ = = G— afome 3§ Delay time

Timing parameters

[pMuzbR | EE Bl v 8] [100 me 8|

Hold time

At the Integration Time area, you set the integration time of the impedance measurement by the MFCMU.

*Mode: AUTO or PLC. Rule to decide the integration time. For details,

*Factor: Coefficient for the reference value of the integration time.

At the Timing area, you set the source output and measurement timing.

see online help or User’s Guide.

*Hold: Source output hold time. Time after the measurement trigger until starting delay time.

*Delay: Measurement start delay time. Time after the hold time until starting measurement.

The Sweep [ ] status field sets the sweep abort function.

When this field is CONTINUE AT ANY, the sweep measurement is not aborted.
When this field is STOP AT ANY ABNORMAL, the sweep measurement will be aborted when one of the

following conditions is detected.
*Measurement range overflow
*MFCMU error

*SMU compliance

*SMU oscillation
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To Set CONST Outputs o

C-V Sweep

Measurement Setup

@ Sweep Setup Name: [Tmg cv
Char Measurement Setun JFunction Setup | Auto Analysis Setup | Display Setup |
C-v (VARL) Signal Source |
A Range
¥ Name: g E FI'EEI_I-ItEI'IC\I' add | Deietel Un | Dy |
ist:
Model: [Cp-G -
& [t ] R
C Name: |C g a
G Name: m F Name: |Freq E Ad-
vanced
Direction: [Single - AC Level: [30mv 7]
Linear/Log: |LINEAR -
Start: |5V B
Stop: |5V B
Step: |100 my B
Ccompliance: lﬁi |Integration Time |
NoofStep: [0 &|| Mode: [pLc | Factor: |2 I

Timing ] ‘

Hold: [0 5 B Delay: 05 H]  “Sweep feonTIE AT e <] status
Constants |
Unit: ¥ Name: I Name: Mode: Source: Compliance:
[Emo:rP s alfin [ Elfov B[00 ma 15|

[sMuz:HR et EE EIG Bl v 8] [100 me 8|
A\

SMU output setup

At the Constants area, you set the SMU constant output.

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data

*Mode: Source output mode, V (voltage), I (current), or COMMON (ground)
*Source: SMU output value

*Compliance: SMU compliance value
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Range Setup for C-V Sweep o

C-V Sweep

Measurement Setup

Range Setup
- Range CMU Measurement Range

400 ¢ Unit: vode: Range:
e [euimE Hfputo =[50 ahm B
Ad-
vanced :
SMU Measurement Range |
Wa Down
Unit: Name: Mode: Range: Range Change Rule: Rate:
o [sMuLHe Bl Himmen  wffine =By FULL RANGE B2 | ER ]
o [EMUziHP Ell= wLMTED  wfina =B FULL RaNGE | 8]
Close

The Range button opens the Range Setup dialog box. The dialog box is used to set the measurement ranging
operation.

CMU Measurement Range:
*Unit: CMU name or number
*Mode: Ranging mode, AUTO or FIXED

*Range: Measurement range. This field is effective when Mode=FIXED.
Available values are 50 ohm, 100 ohm to 300 kohm (=<200 kHz), 100 ohm to 30 kohm (=<2 MHz), and 100
ohm to 3 kohm (=<5 MHz) in 1, 3 step

SMU Measurement Range:

*Unit: SMU name or number

*Name: Variable name for the measurement data

*Mode: Ranging mode, AUTO, LIMITED, or FIXED

*Range: Range value

*Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
*Rate: Value used for range changing. See the following formula.

For the AUTO or LIMITED, SMU automatically selects the minimum range that covers the measurement value,
and performs the measurement by using the range. For the limited auto ranging, the instrument does not use the
range lower than the specified range value. For example, if you select the 100 nA limited auto ranging, the
instrument never uses the 10 nA range and below.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules, specify the Rate value, 11 to 100, which fixes the
boundary of the ranging. The ranging occurs when the measurement data goes across the boundary values shown
below.

go up boundary = present measurement range X Rate / 100
go down boundary = present measurement range X Rate / 1000
The go down boundary is available only for the UP AND DOWN AHEAD rule.
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ADC & Integration Time for C-V Sweep &

C-V Sweep

Measurement Setup

A/D Converter & Integration Time Setup

Range A/D Converter

. ?r?tggf I Unit: Name: ADC: Measurement:
| SRR Bl &R and =] [compliance Sice
Ad-

El
oy [EuziHp B2 R ADC x| [compliance Side =l

Integration Time

Mode: Factor: Auto Zero:

High Resolution ADC: IAUTO jlﬁ EIOFF LI
High Speed ADC: [sUTO =]t Il
Close |

The ADC/Integ button opens the A/D Converter & Integration Time Setup dialog box. The dialog
box is used to select the ADC for each SMU and set the integration time for each ADC (high
resolution or high speed).

A/D Converter:

*Unit: SMU name or number

*Name: Variable name of the measurement data

*ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)

*Measurement: Compliance side measurement or Force and Compliance sides measurement.
HR ADC is not available for HCSMU, HVSMU, and the measurement which uses SMU pulse.
Force and Compliance sides measurement is not available for HRSMU, MPSMU, and HPSMU.
Integration Time:

*Mode: ADC operation mode
AUTO, MANUAL, or PLC for HR ADC
AUTO, MANUAL, PLC, or TIME for HS ADC

*Factor: Coefficient for the reference value of the integration time.
*Auto Zero: Auto Zero function ON or OFF. For HR ADC.
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Advanced Setup for C-V Sweep o

C-V Sweep
Measurement Setup [AC Level/DC Bias Monitor Settings

Unit: AC Level Monitor Name: DC Bias Monitor Name:

[eruLr C E] |
Range
ADC (Channel Settings
Integ

Unit: VName:  IName:  SeriesR: SMU Filter:
. Ad- [EmotHe s =i e lfom |
e [EmizP v =z ‘el [none fen =l

Wait Time Control

Factor:

Output wait: |1 B
Measurement wait: [1 B

[After Measurement Settings

Bias Hold after Measurement: |OFF i
Output Yalue after Measurement: [START et

[Semiconductor Relays (16440A SMU/PG Selector)

cH1: e ] cH3: e 5]

Closz.

The Advanced button opens the Advanced Setup dialog box used to set the following functions.

AC Level/DC Bias Monitor Settings:
Defines the variables for the AC level data and the DC bias data monitored by the MFCMU while
the capacitance measurement is performed.

Channel Settings:

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data
] Name: Variable name for the current measurement or source data
*Series R: SMU series resistor NONE or IMOHM (1000000 ohm)
*SMU Filter: SMU filter ON or OFF

Wait Time Control:

*Factor: Coefficient for the reference value of the wait time. For details, see online help or User’s
Guide.

After Measurement Settings:
*Bias Hold after Measurement: Bias hold function ON or OFF.

*Output Value after Measurement: Source output value after measurement. START (sweep start
value) or STOP (sweep stop value)

Semiconductor Relays (16440A SMU/PG Selector):
*CH1: Default or PGU OPEN
*CH3: Default or PGU OPEN

The fields define the selector channel’s switch condition during the measurement. Default is the
setting defined on the SMU/PG Selector screen of the Configuration window.
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To Set User Functions/Analysis Functions ﬂ

.
Function Setup '
@[c-v Sweep Setup Name: [Tmg CV i
Channel Setup | Measurement Setup Auto Analysis Setup | Display Setup

User Function

Al

Add | De\etel e} | B |

‘] IDE\la glse[ jlde\ta('rime) H

[ Name: Unit: Definition:

Data calculation
-Measurement data/source data
-Built-in function, etc.

Analysis Function

Add | Delete Uy | Downl

o [pverage wlfF =lfavaic) E

[ Name: Unit: Definition:

Data calculation

-Measurement data/source data
-Read out function

-Built-in function, etc.

Click the Function Setup tab to display the User Function/Analysis Function setup screen.

The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the
Data Display window. Up to 20 functions can be set.

*Name: Function name

*Unit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.
*Variables for the measurement/output data used in this test
*Functions defined in the above lines
*Local variables passed from the application test that calls this test as a component
*Built-in functions and global variables
For details, see online help or User’s Guide.

The analysis functions can be displayed on the Parameters area of the Data Display window. Up to
20 functions can be set.

*Name: Function name

*Unit: Unit of the function

*Definition: Definition of the function. The following identifiers can be used.
*Variables for the measurement/output data used in this test
*Functions defined in the above lines
*Local variables passed from the application test that calls this test as a component
*Built-in functions and global variables
*Read out functions

For details, see online help or User’s Guide.
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To Set Data Display
.
Display Setup '
@|C-v Sweep Setup Name: [Tmg CV
Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setuul Display Setup I
X-¥ Graph
Add | Deletel (e | Dy |
Name: Sharing:  Scale: Min: Max:
F % | =] [Mane) =] Jinear =] f5v B v H
(ol i | =] [meney =] [near <] [poa e B [2or |
Lef D |G j |(Nnne) j |Linear j |DS E| |5 us ﬂ
Specify X axis and Y axis
List Display Parameters
Add | Dgletgl U | Dowr | Add | Deletel Up, | BaEwn |
o - = [ & |dverage - ]
o |c E .
Select parameters to display
[SI cf -
C fIndex -
&l
Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set

the X axis and Y axis of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the X axis

*Scale: Linear or Log
*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed in the List Display area of the Data Display

window. Up to 20 variables can be set.

The Parameters area selects the variables to be listed in the Parameters area of the Data Display

window. Up to 20 parameters can be set.
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m Calibration button

To Perform Compensation and Correctionc_fﬂp

‘Advanced Options for CMU Calibration

[Frequency “Relerenue Standard Value ‘

@ Use factory specified frequencies (Default)

 Specify list of calibration frequencies

Calibration

SMU Calbration  CMU Calbration

[cmu calibration

hj
E=E|

¥ Open Correction

¥ short Correction

™ Load Correction

" Specify frequencies by range
start: [ B stop: 8|

steps: [ 8| scale: [ |

Open Reference
Model:[G25 =
Capacitance: [0F  H|
Conductance: [15 [

Short Reference

Model: [ LsRs B
Inductance: [0 H B
Resistance: [0 onm B

Load Reference

Model: [ LsRs
0H B

[integration Time |

50 ohm B

‘r Auto Mode & PLC Mode Factor: [16 (]

» =
Advanced Options...

¥ Phase Compensation Measure...

Calibration

The MFCMU is equipped with the error correction function used to realize accurate impedance
measurements. The correction function minimizes the effects of the error elements in the extension
cables and the DUT interface such as manipulator and probe card.

*Phase compensation: Corrects phase error caused by extending measurement cables.
*Open correction: Corrects for stray admittance. Effective for high impedance measurements.
*Short correction: Corrects for residual impedance. Effective for low impedance measurements.

*Load correction: Corrects any error by using the working standard (load standard).

Click the Calibration button to open the Calibration window. And click the CMU calibration tab on
the window to perform the compensation and correction data measurement.

*To measure the phase compensation data, open the measurement terminals at the end of the device
side and click the Measure... button.

*To measure the open correction data, open the measurement terminals at the end of the device side
and click the Measure... button.

*To measure the short correction data, connect the measurement terminals together at the end of the
device side and click the Measure... button.

*To measure the load correction data, connect the load standard that has the reference value or
calibration value. Then, click the Measure... button.

For details of the error correction (CMU calibration) and the Advanced Options, see online help or
User’s Guide. The Advanced Options window is used for the compensation/correction data
measurement setup.
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Class Exercise A

C-V Sweep

Define test setup and perform test.

1.
2.

Click C-V Sweep icon and open setup editor.

Define test setup as shown in previous pages. And
save it as Trng CV.

Open measurement terminals, and perform phase
compensation and open correction.

Connect device, and perform test. . SMUI
MH
Export preset group, and import it. o oML
SMU2

Note:
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Measurement Result Example

€ Trng CV [(20) ; 8/17/2005 12:43:32 PM] - Agilent EasyEXPERT
File Edit View Marker Cursor Line Window Help
= SETE = ] e
- o (s - - I3 -7
EEaaQiid EuHEMee - F -2
Setup Name: ITrng v [{20) ; 8/17/2005 12:43:32 PM]
X-Y Graph Plot ] |Parameters
% Agilent
® MARKER{ OV 1.1723200000-012 F  1.8915100000=-006 S ) = Average [{ 314020881080
2p Su
C G
100f
Jdiv
8oof 0
5 vg (V) 1.00 Jdiv
List Display
Index | v cf 3 Index [ Time | Defta | ]
43 -800 mV 1.50343 pF 2.74072 us A3 4.9622 5 118.2 msec
44 700 mV 1.42850 pF 2.54577 usS 44 5.0804 s 118.15 msec
A5 -600 mv 1.36454 pF 2.38035 us 45 5.1985 5 118.1 msec
46 -500 mv 1.31499 pF 2.24966 us 46 5.3166 ¢ 118.15 msec =
47 400 mv 1.27579 pF 2.15420 us 7 543485 118.15 msec
48 -300 mvV 1.24529 pF 2.07649 us 48 5.5529 s 118.1 msec
48 -200 mv 1.21895 pF 2.01644 us 49 5.6710 s 118.15 msec
50 -100 mv 1.19657 pF 1.94813 us 50 57892 s 118.35 msec
51 av 1.17232 pF 1.89151 usS 51 5.0077 s 118.3 msec
52 100 mv 1.13482 pF 1.80326 us 52 6.0258 ¢ 118.1 msec |:‘

o

C-V Sweep

This is a test result example displayed on the Data Display window.
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Switching Matrix Control ps, s

Switching

* To Define Switch Setup Matris

This section explains how to define the switch setup for B2200/E5250 Switching Matrix. Not
available for BI5S05A.

Note: Standard revision of EasyEXPERT cannot support the E5250. The E5250 control is optional
function of B1540A-002/B1541A-002.

Note: EasyEXPERT supports the E5S250A installed with the E5252A matrix card.
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To Define Switch Setup

Switching
Matris ...

Setup Name
g|8witching Matrix Control Setup Name: [Trng Switch ]
Connection
Add | Delete I Lp | o
Operation: Input: Outputs: Rule:
9] |OpEnA\I il ﬂl EI ﬂl QI L] j
€ |[switch setup =lfEwm e 1 || ] Ell] 8 |[esm =l
€ |[switchsetup  rflswmmz -z E| | | QIBBM |
C |[switch setup =lfwm s ~][s | IEl|| | ﬂIBEM =l
€ |[switchsetup  =flswmmr 7 E| | | Affeam -]
N~ g
-Open All -BBM
-Switch Setup -MBBR
-Close Range To specify Output Channel
-Open Output
-Open Range To specify Input Port
-Open Input

This setup screen is used to create the relay control setup (switch setup) for Agilent
B2200A/B2201A/E5250A Switching Matrix.

To send the switch setup to B2200/E5250, click the Single button. Before doing this, you have to
establish the GPIB connection to B2200/E5250 by using the Switching Matrix tab screen of the
Configuration window and B1500A is set to system controller. See Module 8.

This screen provides the following GUI.
Add: Adds a setup row for relay connection.
Delete: Deletes the setup row. To select the setup row, use the left radio button.

Up: Moves the selected setup row upward.

Down: Moves the selected setup row downward. The setup row provides the following entry fields.

Operation: Relay control operation. Open All, Switch Setup, Close Range, Open Output, Open
Range, or Open Input. See the next page.

Input: B2200/E5250 input port number or label. Available for the Switch Setup, Close Range, and
Open Input operations.

Outputs: B2200/E5250 output channel number or label. Four entry fields are available for the
Switch Setup and Open Output operations to specify the output channels. Two entry fields are
available for the Close Range and Open Range operations to specify the range of output channels.

Rule: Relay connection rule. BBM or MBBR.

*BBM: Breaks the previous connection and then makes the new connection for the specified outputs.

*MBBR: Makes the new connection and then breaks the previous connection for the specified
outputs.
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Operation and number of Outputs

Matrix ...

Operation Description Number of
Outputs
Open All |Opens all relays. 0
Switch Setup| Makes the connection from the specified input port to 4
the specified output channels. Up to four output
channels can be specified at once.
Close Range | Makes the connection from the specified input port to 2
the specified output channels. They are between two
channels given by the Outputs fields.
Open Output|Opens the relays connected to the specified output 4
channels. Up to four output channels can be specified
at once.
Open Range | Opens the relays connected to the specified output 2
channels. They are between two channels given by
the Outputs fields.
Open Input |Opens the relays connected to the specified input port. 0

Note:

3-83



Module 3
Classic Test Environment

Class Exercise b

Define switch setup and send it to B2200/E5250.

1. Click Switching Matrix Control icon and open setup
editor.

2. Define switch setup as you want. And save it as Trng
Switch.

3. If B2200/E5250 is available, establish the GPIB
connection between B1500A (must be set to system
controller) and B2200/E5250, and apply your switch
setup.

Note:
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Direct Control m

* To Define Channels and Variables Direct
* To Set Measurement Conditions Control
* Advanced Setup

To Set User Functions

To Set Data Display

This section explains how to use Direct Control to perform various measurements (e.g. C-f
measurement, Quasi-Static C-V measurement) using Agilent FLEX commands.
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. 7
To Define Channels and Variables
Control
Chanllel setup Setup Name
i)| Direct Control Setup Name: [Tmg C-f |

- Channel Setup | Measurement Setup | Function Setup | Auto Analysis Setup | Display Setup |
Channel Definition

sadsmo| | add oo addseou| e | U |
Unit: ¥ Name: I Name:
folll TN = [veias = =
o fausee = =i =

CMU Channel Definition: V Name
SMU Channel Definition: V Name and I Name
SPGU Channel Definition: No variable

Additional Data Yariables

Additional Data Variables Add e |
Unit: Type: Name:
ol TR =][@uRet) =l | j
[al T [ ey 3 =
[ol =][@0 OC Bias Manitar Data ] Detan = ) .
Miscellaneous Yariables
Time Stamp Name: : Index Name: :E
Variable name for time stamp data Variable name for index data

Click the Direct Control icon and open the setup editor. Then click the Channel Setup tab to display
the channel definition screen.

1. Enter the Setup Name for the test setup to be defined on the setup editor.

2. List channels used for source output or measurement, and set the following parameters.
*Unit: Name or number of the channel

*V Name: Variable name for the voltage measurement or source data. For SMU and CMU.
] Name: Variable name for the current measurement or source data. For SMU only.

V Name and [ Name are used to specify the parameters displayed on the Data Display window. The
display parameters are selected on the Display Setup tab screen.

You can read measurement data by using the Data Display window. Parameters displayed on the
window are selected on the Display Setup tab screen. If you enter the variable name in the V Name,
I Name, Additional Variable Name, Time Stamp Name, and/or Index Name entry fields, you can
choose the variables as the display parameters.

Note: The time stamp is the time the measurement is started for each measurement point. The index
is the index number for each measurement data.

For example, the Trng C-f test setup has defined the following additional variables to monitor.

<Unit> <Type> <Name>
CMUIL:MF CMU Re(Y) G
CMUL:MF CMU Im(Y) B

CMUI1:MF CMU DC Bias Monitor Data  DcMon
CMUI1:MF CMU AC Level Monitor Data AcMon
CMUIL:MF CMU Frequency Freq
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To Set Measurement Conditions

Measurement Setup

Setup Name: |Trng f

@|Dicect Control
Chanl I Measurement Setup IFunct\Dn Setup | Auto Analysis Setup | Display Setup

Ad-
vanced

Command Setup

I

Add

Delete |

Upl

B |

Command:

Arguments:

c 1 [T 3| FERY R
o a2 lIE3 = =
3w | ERs
4 [wTC .o ENls
5 [wmrc = ElE
c e [wrC femuLi, 4, 103 505,50 ERE
e 7 facT =z =
g |y =lfomutiir, a0s-3 ERs
c g o =] femuE 1 ENls
c w [ =]t ElE
c 1 R =l =

12 | =

lgnnre:\

7

Command Setup

Direct
Contral

The Measurement Setup tab screen is used to set Agilent FLEX commands for measurement.

For example, following FLEX commands are set for the C-f Sweep Measurement.

O 0 9 N N B~ W N =

_ = = =
W o = O

See B1500 Series Programming Guide for more details about FLEX commands.

<Command> <Arguments>

FMT 13,1

TSC 1

MM 22,CMU1:MF
WTEC 0,0

WMEFC 1

WFC CMUI1:MF,4,1¢e3,5¢6,50
ACT 0,2

ACV CMUI1:MF,30e-3
DCV CMUI1:MF,1

RC CMU1:MF,0
TSR

XE

ReadDataBuffer
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Measurement Setup

Advanced Setup ‘

Advanced Setup

Advanced Setup i

Options

Primary Setup: |CFF T

Channel Settings

Unit: YName: IName: Series R:

SMU Filter:

| 0| i ol [NONE

o

H

After Measurement Setting

Bias Hold after Measurement: | OFF L2

Semiconductor Relays ( 16440A SWU/PG Selector)

cH1: [DEFALLT =] cH3: [Peucren |

Close

Direct
Contral

The Advanced button opens the Advanced Setup dialog box. The dialog box is used to set the option
setting, the SMU filter and SMU series resistor settings, the after measurement settings, and the
16440A selector semiconductor relay setting.

Options:
*Primary Setup: ON or OFF.

If Primary Setup=ON, the primary setup is applied to the instrument when the Direct Control test is
started. For the primary setup condition, see the online help or User’s Guide.

Channel Settings:

*Unit: SMU name or number

*V Name: Variable name for the voltage measurement or source data

] Name: Variable name for the current measurement or source data
*Series R: SMU series resistor NONE or IMOHM (1000000 ohm)
*SMU Filter: SMU filter ON or OFF

After Measurement Settings:

*Bias Hold after Measurement: Bias hold function ON or OFF.
Semiconductor Relays (16440A SMU/PG Selector):

*CHI1: Default or PGU OPEN
*CH3: Default or PGU OPEN

The fields define the selector channel’s switch condition during the measurement. Default is the
setting defined on the SMU/PG Selector screen of the Configuration window.
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. H
To Set User Functions
Control
Function Setup
@|Direct Control . Setup Name: [Tmg C-f i

Channel Setup | Measurement Setup | Function Setup | auto Analysis Setup | Display Setup
Apply.

User Function

Add | De\etel U | B |
Name: Unit: Definition:
o | =115 |
o |Im‘r’ = j|compenImY(Freq,GJE) EI
O |RE!Y §|5 jl[nmpenReV(Freq,GJE) il
e |c 5]; j|1mw(2*p1*;req) IO
Analysis Function
Add Delete Upy Do

Name: Unit: Definition:

To add & function parameter, press the [Add] button in this area.

Click the Function Setup tab to display the User Function/Analysis Function setup screen. The user
functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data
Display window. Up to 20 functions can be set.

Name: Function name
Unit: Unit of the function

Definition: Definition of the function. The following identifiers can be used.
-Variables for the measurement/output data used in this test

-Functions defined in the above lines

-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.
For example, following user functions are set for C-f Sweep Measurement.
<Name> <Unit> <Definition>

PI 3.1415

ImY S compenlmY (Freq,G,B)

ReY S compenReY(Freq,G,B)

C F ImY/(2*PI*Freq)
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To Set Data Display

Contral

.
Display Setup '
g|Direct Control Setup Name: [Tng C-f i
Channel Setup | Measurerent Setup | Function Setup | Auto Analysis Setupl Display Setup I
X-¥Y Graph
Add | Delete | {]a] | (B]E] i) |
Name: Sharing:  Scale: Min: Max:
F % [Frea =] [mere) =] [Loa =l [ ] [ ]|
o v =] [rone) 7] [rear 7] [250rF W] [Eoonr H

Specify X axis and Y axes.

List Display Parameters
Add | Delste | U | Do | Add Delete Uy Dyt
« [Time - =
L& Freq -
L& C - To add a parameter, press the [Add]
button in this area.
(ol (c} - _J

Select variables to list

Click the Display Setup tab to display the display setup screen. The X-Y Graph area is used to set
the X axis and Y axes of the X-Y Graph Plot area in the Data Display window.

*Name: Name of variable to plot on the axis

*Scale: Linear or Log

*Min: Minimum value of the specified axis

*Max: Maximum value of the specified axis

For example, following axes are set for the C-f Sweep Measurement.
<Name> <Scale> <Min> <Max>

X  Freq Linear 1kHz 5 MHz

Yl C Linear -250nF 500 nF

The List Display area selects the variables to be listed in the List Display area of the Data Display
window. Up to 20 variables can be set.

For example, following variables are set for the C-f Sweep Measurement.
Time, Freq, C, G, B
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Module 3
Classic Test Environment

Class Exercise .

Define test setup and perform test.

1. Click Direct Control icon and open setup editor.

2. Define test setup as shown in the previous pages.

3. Save it as Trng C-f.
4

. Connect a device (capacitance) as shown in next
several pages, and perform test.

5. Export preset group, and import it.

Note:
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Classic Test Environment

Cable Connections

Control

'

cMU D —

SMU4 = *@®.@ - 16442A/B Fixture
SMU3 -2 - ©.@ -
SMU2 = - @.@- NOROR

0 0.0
SMUI1 MCONCE CHCK
GNDU

B1500A Rear View

The following cables are required to perform this class exercise.
CMU cable (Agilent N1300A-001/002), 1 ea.

One side of the CMU cable forms the attachment used to join and fix it to the CMU. And the other
side provides four BNC connectors used to connect the fixture as shown.

Connect the cables between the B1500 and the test fixture as follows.
Hcur : PGUI1 (red)

Hpot : PGU2 (orange)

Lcur : VSUI (black)

Lpot : VSU2 (gray)
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Classic Test Environment

Jumper Leads — Capacitance

([
Direct
Control
GNDUE
"o fn®)
s©

0.1uF

goyooooooooon

@
3 7 3
o O O
9 10 1
QO O
B % U
@)
(TR S
gooooooooooo

14

20:x0=0:0-0

™
o«

This class exercise requires four jumper leads to connect the DUT. Connect the jumper leads

between the following terminals.

PGU1
PGU2
VSU1
VSuU2

: terminal 4
: terminal 4
: terminal 1
: terminal 1
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Classic Test Environment

Measurement Result Example

€ Trng C-£[(1) 5 5/10/2007 6:42:51 PM] - Agilent EasyEXPERT BmEX|
File Edit View Marker Cursor Line Text Pointer Window Help
. - ~Tecole=IE . 5 . T =om o W F"_ o T =
HEB-aaf@-BeEREs E-PA- S5l
SetupName: [Trng C-f [(1) ; 5/10/2007 6:42:51 PM] x
[X-¥ Graph Plot Properties... | |
% Agilent
= 500n
=]
<
R
2
250n
100n
]
™
© -00n
-250n
1k 2k 3k 5k 0k 20k 50k 10k 20k 500k 1M n M oM
Freq {Hz) decade [div
List Display Properties...
Index Time | Preg | cf 6 B I
1 336.08 ms 1.000000 kHz 103.7412656 nF 7.66515 uS 651.807 uS =
2 617.26 ms 1.189842 kHz 103.5854829 nF 9.22423 uS 774.382 us [‘Ll

L&

Direct
Contral

This is a test result example displayed on the Data Display window.
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Module 4
Measurement Functions

In This Module

SMU Pulsed Sweep Measurement

* I/V-t Sampling Measurement

* Negative Hold Time for High Speed Sampling
* Auto Analysis

* SMU Filter

* Standby Function

* Bias Hold Function

There are too many measurement functions to conveniently cover in one module. Ultra low current
measurement and capacitance measurement are covered in separate modules.

This module covers the key features listed above.
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Module 4
Measurement Functions

SMU Pulsed Sweep Measurement

* Use PULSE mode for precise force/measure timing

* Use PULSE mode for repeatable high current
measurements

» To eliminate heating during IV sweeps
» To avoid device damage

* Set the expected maximum measurement value to
Compliance

*  Multiple pulsed source/measurement channels are
available for Tracer Test and Multi Channel I/V Sweep
Classic Test

SMUs can be pulsed for precise force/measure timing, or to reduce heating of the device when
forcing high currents.

The measurement unit performs measurement by using the compliance range. It is the minimum
range which covers the Compliance value. The Compliance value should be the expected maximum
measurement value or greater.
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Module 4
Measurement Functions

SMU Pulse Mode

VARI1 —
Primary H

VAR2
Secondary |

VAR2 |
Secondary

Multiple pulsed channels are available for Tracer Test and
Multi Channel I/V Sweep Classic Test

Tracer Test and Multi Channel I/V Sweep Classic Test support multiple pulsed channels. VARI,
VAR2, and CONST can be pulsed.

For the other Classic Test such as I/V Sweep and I/V List Sweep, only one SMU can pulse while
another follows. VAR, VAR1’, VAR2, or CONST may be pulsed.



Module 4
Measurement Functions

Pulse Setup Parameters

1. Using one pulse output channel
Pulse period

Voltage or current ,
Measurement time
>

Peak value )
: Hold time
Previous value —'\ '
Base value —,i
Pulse width

2. Using multiple pulse output channels
Pulse period

Voltage or current
g Measurement delay time Measurement time

Peak value Hold time
I —
Previous value 4 ——— .
Base value E T

Delay time ' Pulse width

Time

When you select VPULSE or IPULSE on the Channel Setup screen, the Pulse button is available for
the Measurement Setup screen. Click the Pulse button to open the Pulse Setup dialog box, and set
the pulse setup parameters on the dialog box.

For the test which supports one SMU pulse, use the SMU Pulse area on the Measurement Setup
screen to set the pulse setup parameters.

Pulse period may be adjusted from 5 ms to 5 s in 100 us steps. Pulse period is measured from the
base value to peak value transition, between two consecutive pulses.

Pulse width may be adjusted from 0.05 ms to 2 s in 2 us steps for HCSMU or 0.5 ms to 2 s in 2 us
steps for the other modules. Pulse width is measured between the transition from base value to peak
value and the transition from peak value to base value.
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Measurement Functions

Hints on Pulsing the HPSMU - B1500A

¢ Use the HPSMU or GNDU as the current return
path

* Use Kelvin connections (must use on GNDU)

* Use 16493L. GNDU cable for the GNDU connection

Example for B1500A:

Sense IPSMU 1.0 A

Force
HRSMU
or

MPSMU
Foree CNDU 4.2 A

Sense

The 1 A SMU (HPSMU) cannot use another MPSMU or HRSMU as the current return. It must be
used with the other HPSMU or the GNDU that can sink enough current. The GNDU is the unit that
you can use without defining in the Channel Setup.

The GNDU can sink up to 4.2 A, and it is designed for the Kelvin connection. The force and sense
lines must be shorted near the DUT.

For the connection of the GNDU, do not use the normal triaxial cable. The GNDU is rated for up to
4.2 A, while the maximum current rating of the triaxial cable is 1 A.
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Measurement Functions

Class Exercise
SMU Pulse Mode

« You will observe a MOS FET family of curves
« You will edit VARI from V mode to VPULSE mode
« You will learn how to properly define a "pulsed" algorithm

To Get Started:

« Use the next several pages as you guide
« Get the IDVD setup
« Follow the instructions on the following pages

You will setup a basic MOS family of curves without VPULSE. Then change VAR to VPULSE.
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Module 4
Measurement Functions

SMU Triax Connection
Force Lines to Fixture 1,2,3,4 Ports

CMU

SMU4 3 16442A/B Fixture

SMU3 -T2

SMU2 T —0.® -
o0,

SMUI @@ |[e®

GNDU

B1500A Rear View

This is the SMU cable setup that will be used in the remainder of the class exercises.

Connect the cables between the B1500 and test fixture as follows.

SMU1 : SMU1
SMU2 : SMU2
SMU3 : SMU3
SMU4 : SMU4
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Module 4
Measurement Functions

Jumper Leads — MOS transistor

Sub

1: Substrate
2: Source

7 [oooooooooon| 3+ Gate
1 1

4 4: Drain

With the 16442A/B fixture, note that there are two SMU numbering schemes....3 SMUs with force
and sense, or six SMUs with force only. For this class example we will use the six (6) SMU scheme.
On older fixtures, this scheme is shown in light blue lettering. In newer fixtures, this scheme is
shown in white reverse background lettering.
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Measurement Functions

VPULSE
Data Display Window
£ Agilent
$ (a) MARKER{ 2.00D00DODDDE+D0D V' 5.469800DDD0E-D03 A —~----
40m
5.00 m
fdiv
0
0 vd (V) 500 m /div 5

Make a measurement to verify the setup is correct. You should see the above family of curves. The
algorithm is defaulted to standard staircase sweep on VAR1 (no pulsed SMU).

4-10



Module 4
Measurement Functions

VPULSE
Channel Setup

Enter new name before save

e R
@|1/v Sweep Setup Name: [IDVD-Pulse
Channel Setup IMeasurement Setupi Function Setup i Auto Anabysis Setupi Display Setupi
Channel Definition

Unit: V Name: I Name: Mode: Function:

o~ [smuz:mp w|fvsub B |Isub |y rllconsT |
 |smuz:He RIE = m=|coMMoN v|consT v
¢ |SMU3:HR ~llva =g =V wlfvarz Ba|

e —
 [sMU4:HR =||vd = |1d | VPULSE <) VAR |

Drain pulse

Switch VAR1 from V mode to VPULSE mode. A new panel will pop up on the Measurement Setup.

Before saving this new setup, enter new name into the Setup Name field, then click the Save button.
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Measurement Functions

VPULSE
Measurement Setup ii‘,"cg,‘},?t"e;

are disabled

VARL —vAR2 ‘ ' N\
Unit: [SHU4:HR fEl| e El . :
This box pops up T
— L = only if VPULSE
Direction: |Single - CIUYRL U_
Linear/ Log: [LINEAR = or IPULSE is set At
start: [o v Fv 5 on Channel Setup. e
Stop: |5V H|fsv H]
Step: ]SIJ my E] 1V EJ |SHH Pulse |
Elfs E]l Unit: [SMU4:HR, E|
EDIL0mA & Period: |10 ms E
OFF ] Width: |1 ms B
| Base: |0V E]
’ A
Hold: [0 5 / | Dpelay: | B+ sweep [cONTIUE AT ANY =] status
Unit: V Name: I Name: Mode: Source: Compliance:
|SMUL:HP / B][vsub e [Tsub |V v B][100 ma 8|

Maximum measurement value

Default pulse conditions for the Measurement Setup are shown here. The base is 0, and the pulse
duty cycle is 10 %. These settings are OK for this class exercise. Click the Single button to start a

pulsed sweep measurement.

Range and ADC/Integ buttons are disabled for pulsed measurement. The measurement range is
always the compliance range. And the integration time cannot be changed.

For example, if you change the Compliance value to 30 mA, the data beyond 30 mA cannot be
measured.
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Measurement Functions

I/V-t Sampling Measurement

Voltage or current

Starts sampling Time=Hold time + a  Time=Hold time + Interval + b
g g

Source - : .
} Channel 1 output J‘ \_

Interval

-~

Time=0 (origin)
= : Measurement

Voltage or current 1 Hold Time

Measurement time

Bias hold time . ,|
)

Source - r_. : __\_
Base - 4,—/ Channel 2 output

Time

a, b : time from measurement start to integration start

B1500 supports the sampling measurement which performs the operation shown above.

With the SEQUENTIAL output sequence, the source channels start to force the Source value
sequentially. Then the last source channel forces the Base value, and forces the Source value after
the Bias hold time. After the Hold time, the measurement channels start measurement sequentially,
and repeat this in the specified interval if the measurement channel is ready to measure. After the
last sampling measurement, the source channels stop output sequentially.

The order of source output is defined in the Channel Setup. Top of the channels on the setup screen
starts output first. And the following channels start output sequentially. After the measurement, the
source channels stop output sequentially in the opposite order.

With the SIMULTANEOUS output sequence, the source channels start to force the Base value
simultaneously. And the channels force the Source value after the Base hold time. After the Hold
time, the measurement channels start measurement sequentially, and repeat this in the specified
interval if the measurement channel is ready to measure. After the last sampling measurement, the
source channels stop output simultaneously.

For the measurement channels which use the high resolution A/D converter, the order of
measurement is defined in the SMU Range Setup. Top of the channels on the setup screen starts
measurement first. And the following channels start measurement sequentially. For the
measurement channels which use the high speed ADC, the channels start measurement
simultaneously.
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Measurement Functions

I/V-t Sampling Measurement

« LINEAR
« Sampling interval: >=2 ms
0.1 ms to 1.99 ms (limited)
« Number of samples: 1 to 100001

« LOG
o Sampling interval: >=2 ms
« Number of samples: 1 + number of data for 11 decades
« Remaining data:
10/25/50/100/250/500 data are plotted into one decade
of the log scale in the same distance

There are two sampling mode. The linear sampling repeats the sampling in the specified interval
until the number of measurement data reaches the specified number of samples. High speed
sampling is available if the following conditions are satisfied. The high speed sampling allows
you to set the sampling interval 0.1 ms to 1.99 ms in 0.01 ms step.

1. Sampling mode is LINEAR
2. High speed ADC is used for all measurement channels

3. Interval >= 0.08 ms + 0.02 x (number of measurement channels) ms

The log sampling repeats the sampling in the specified interval and gathers the measurement data
which can be plotted on the log scale in the same distance. The sampling will be stopped when
the number of measurement data reaches the specified number of samples.
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Measurement Functions

Class Exercise
Sampling Measurement

You will:

« Monitor the charging voltage of an RC circuit

o Learn LOG10 data interval

« Learn how to properly define a sampling algorithm

To Get Started:

« Use the instrument setup as same as the SMU pulse exercise
« Connect the RC components as shown in the next page

« Get and run the RC-sampling-log setup

« Change the range or ADC and perform append measurement
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Measurement Functions

Jumper Leads — Sampling Exercise

28: SMU1

9
O O (1) 0.5M
15 6 18
0.1ufF O 25: SMU2
-
nofooooooo T"'l uF

22: SMU4

0.5M 0000000000 *
@ 1 14

The 0.5 M ohm and 0.1 uF values were chosen because these values are readily available, and they
give a RC time constant suitable for observing 2 ms time steps.
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Sampling Exercise — LOG10, 2 ms interval
RC Measurement
i Apgilent
(V) MARKER( 1.0130000000E-002 5 3.4150000000E-001V -—— ;)
2 X data
—————eAe—————
——— 10 data
———— 10 data
> 10 data -
Y data
200m
[div
X+Y=20
D |
1m T Time (s) decade /div I 1k
2 Ims S decades 260 s

The RC-sampling-log setup is for the LOG10 sampling with 2 ms interval and 51 samples.

LOGI10 sampling obtains 10 data in one decade. And the data will be plotted on the log scale in the
same distance. However this rule cannot be kept at the beginning of sampling because of long
interval.

In this example, there are 10 data in each decade from 100 ms to 10 s, and 20 data in the remaining
decades. The first data will be near zero second. See the List Display.
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Measurement Functions

Sampling Exercise — LOG10, 2 ms interval

List Display Properties... | ‘
Index I Time! V2I \“I
19 10013 ms 16674V ] )
20 126.13 ms 17674 V
21 158.14 ms 1.8764 V
2 200.13 ms 1.9385V
23 25213 ms 18727 V
2 316.13 ms Tossy [ 10 data/decade
25 400.13 ms 1.9959 V
26 502.13 ms 1.9083 v
27 £32.13 ms 1.9989 V
28 796.13 ms 19992y
25 1.00213 5 19906 V] )
0 T26213 5 ZV
31 1.58813 5 1.9999 v
32 2.00013 5 2V
33 251813 5 2.0004 v
34 3170135 soniv [ 10 data/decade
35 3.99013 5 2.0004 V
36 5.02413 5 2.0001 v
7 632413 5 2.0003 v 4
962135 goga v/ 1
30 10.02413 5 20002 V]
0 12.62013 5 20003 V
41 15.88613 5 2.0002 v
42 20.00013 5 2.0002 v
43 25.17813 5 2.0003 v
44 31.60813 5 seoiv [ 10 data/decade
45 39.90613 5 2.0003 v
46 50.23813 5 2.0002 v A
47 £3.24613 5 2V
48 79.62213 5 20003V )
49 100.23813 5 2.0002 V] v
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Measurement Functions

Sampling Exercise
Channel Setup

[ = i = B X
@ |I/V-t Sampling Setup Name: !RC szmpling-log
i Channel Setup i Measurement Setup | Function Setup! Auto Analysis Setupi Display Setupl

Channel Definition

Add | [ Delete | g |
Unit: V Name: I Name: Mode:
o~ [sMuLHP vt =l =V |
¢ [smuz:Hp =|[va =R ElR |
o [smuaHR Ei[E =3 m[conmon =]

Time Stamp Name:@ Index Name: a

Variable for time data
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Measurement Functions

Sampling Exercise

SMU Range Setup .
Measurement Setup === w_
T
Unit: MName: Mode: Range: Range Change Rule: Rate:
« [shuLHe i ﬁ[umna |[1na BV FULLRANGE =l ]|
o [sMuz:Hp V2 R B |
~ [sMUsHR |E =T =[[1ns ] FIXED range —g
T = WD Converter & Integration Time Setup

_@3 I/v-t Sitxumplmg Setup) T |

Channel Setup : | ; Function Setup | A

Sai P. R Unit: Name: ADC:

[EzEnsa | | ECOTET Eﬂn =[wR ADC =

Linear/Log: [LOG10 | [sHUzAP HfE s woc E|
[stauHR BB [ —
Interval: |2 ms 8] ngh Speed ADC
No of Samples: |51 B
Total Sampling Time: |158.866 s E! on Time
Output Sequence: |STMULTANEOUS 'i Misie o Al Zara:
Hold Time: 73 F High Resolution ADC: [2UT0 #[6 8|[ofF =
High Speed ADC: [AUT0 =]f1 ]
Base Hold Time: |03 B

S

Unit: V Name: I Name: Mode: IBase: Source: Compliance:

|EXE EllE = ET EI|D v Bzv Bloms B

|smuz:He B|[v2 |7 ER §l|u A Eloa ajpv ]

Use the FIXED range and the high speed A/D converter to get 2 ms interval.

Change the range to AUTO. Or change the ADC to the high resolution ADC. And perform append
measurement. You may not get 2 ms interval at the beginning of sampling.
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Measurement Functions

Negative Hold Time
Available for Interval <2 ms

-90 ms =< Hold Time =< -0.1 ms, 0.1 ms step

¥4 Agilent
3 ) MARKER{ 0s G.0000000000E-003V ------ )

10

V1

Bias starts at0s

i.00
fdiv

-5m Time {s) 2.00 m /div 15 m

For the sampling measurement, the available hold time value is 0 to 655.35 s, in 10 ms step.

However, the negative hold time -90 ms to -0.1 ms, in 0.1 ms step is also available for the high speed
sampling which the Interval is less than 2 ms.

This measurement result example is obtained by the setup shown in the following pages.
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Jumper Leads — Negative Hold Time

8 9
o
4 16
O O O
20 21
goQooooooooonn

et 2\ § § e o.5M 0000000000 28
@ @ - 4

28: SMU1

% 0w

25: SMU2
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Negative Hold

Time

Channel and Measurement Setup

@|1/v-t Sampling

Setup Name: [R-sampl-neg-hold

Channel Setup | Mgasurement Setup | Function Setup | Auto Analysis Setus | Display Setup |

|l:llal|lld Definition

Unit: V Name: 1 Name:

c—

o [smurme w1

=i E (] =] Current source

o [smuzHe =2

@|1/v-t Sampling

=2 m[comon -+

Setup Name: [R-sampl-neg-hold

Channel setup Measurement Setup ‘ Function 5etup | Auto Analysis Setup | Display setup |

Sampling Parameter |

No of Samples: |10

vanced
Total Sampling Time: [20ms 8]
Output Sequence: SIMULTANEOQUS =

Range

Linear/Log: |LINEAR =
Interval<2ms &
]

-

Negative Hold Time

Base Hold Time: |0 2 [}
Constants |
Unit: ¥ Name: 1 Name: Mode: Base: Source: Compliance:
[sMuHe Hfvr E|m =i Hjos B0 ua H20v LIl
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Measurement Functions

Auto Analysis

GM max
Hands-off marker

and line fitting

Early Voltage

Isub max

Vth

Auto analysis automates the task of doing scalar calculation on swept data. Computed parameters
such as Vth or GMmax can be displayed in the Parameters area on the Data Display window. The
built-in user functions allow data to be plotted and analyzed according to any arbitrary formula. The
B1500 has built-in functions such as axis intercepts, logs, regression lines, area integration, max/min,
and many more. The ability to automatically extract important parameters such as threshold voltage
without the need to manually manipulate screen cursors or markers is important in process
development.
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Measurement Functions

Auto Analysis
Vth Example

X-Y Graph Plot Properties... | Parameters
3 Agilent
i , \ 007573E- 1 002 )
[) MARKER{ 1.3500000000E-+000 V  2.8087007673E-002  8.0311895965E-002 ) VTH 1.00028 v
200m
Intercapt: Intercept: BETA  |5.45000E-003
-0.0803341 -0.0321336
Gradient: Gradient:
8.031190E-002 3.212476E- 00
=
i
=
o
3
20.0m
Jdiv ——
0 Intercept: 1.00028 V.
0 Vg (V) 500 m /div 5
List Display Properties... | |
Index_| va | SQRT_Id | PEAK [~
26 1,25V 20.1330573932...  77.3300163467... =
27 1.3V  24.0848500099.. 78.5395027933...
28 1.35V  28.0870076725... 80.3118959648... [l

Here we see a full-featured example of auto analysis. GMmax and Vth are automatically calculated
each time a measurement is made. Even if you alter the analysis, say by moving the line, you can

restore the original analysis by clicking the Apply button on the Auto Analysis Setup screen.

IMPORTANT!

Please note that formulas for auto analysis are not hard coded into the B1500. You define the
formulas, and so you can customize the method of performing the analysis.
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Vth Measurement
A Tedious Process Now Automated

« Plot square root of the drain current (SQRT Id)

« Plot rate of change of SQRT Id (PEAK)
« Find Peak Value of the PEAK plot

« Drop down to the SQRT Id plot

« Draw a tangent line on the SQRT Id plot

« Read the X-intercept of the tangent line as Vth22

In the previous example of graphically determining Vth, the above steps were automated. There are
other definitions of Vth which are less complex, but now you don't have to worry about complexity.
The B1500 can perform the process without you having to interact with the screen.

Not only automation removes human error, but also it allows computer controlled analysis to proceed
without interruption.
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Class Exercise
Auto Analysis

You will:

« Make a MOS threshold voltage (Vth) measurement

« Observe how parameters for the analysis are defined

« Observe how the user functions and analysis functions are
used in the analysis

To Get Started:

« Use the standard MOS device and pin connections
« Get the GMMAX setup

« Make a measurement and turn the knob

« Click the Apply button to restore the analysis

In this exercise you will observe how auto analysis works. You will understand each setup screen
required to implement an auto analysis process.
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Vth Measurement
Damaged MOS FET Device?

Good BAD
Continuous Curve Broken-Lumpy Curve
No Static Damage Severe Static Damage

The class exercise uses a packaged MOS FET device which is very susceptible to static damage. If
the device has been handled or moved in and out of the socket a few times, you may see a BAD
response as indicated above. Replace the device with a new one.

At the wafer level, you can have the same problems. Putting a charged probe with cables attached
down on a gate junction can weaken or destroy the device. Also, the B1500 offset cancel (zero
cancel) sends signals down to the probes. These voltages can damage a sensitive gate junction.

4-28



Module 4
Measurement Functions

Vth Measurement
Channel and Measurement Setup

No of Step: [101 I
Compliance: |100 mA I

Pwr Comp: |OFF il
Timing 1
Hold: [1 ¢ E| Dpelay: [os Bl = Sweep [CONTHUE AT ANY =] status
Unit: V Name: I Name: Mode: Source: Compliance:
[sMuLHe B [vsub EED =V Hlfov B[00 ma Il
EXETS E[vd = =V Bl2v B|[100 ma ]l

__[er Definition
VARL | e |
Unit: |SHU3:HR ji Unit: V Name: I Name: Mode: Function:
Name: [Vg = | ¢ [ssHe =|[vsub = [lsub R xlfeonsT  +]
Citecnorcl|sholt —_—Iv r [smuz:HP =llvs =l m[conmon w|fconsT =l
Linear/Log: Im
e m ¢ [sMuz:HR ~lva = R vara -]
Stop: [5 v & | -~ [smoenr e EIE = ~Jconst <]
O

Nothing new here. This slide is included for completeness. You will notice that these variables are

heavily used on the Function Setup screen.
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Vth Measurement
Function Setup

User Function
Add e | [Up | [Gown |
Name: Unit: Definition:
¢ [sorT_d | =|[sarc(1d) 8|
r feak =l |[ef(sQRT _Id,va) 8|
Analysis Function
Add e | | oo |
Name: Unit: Definition:
o o =y ~||aLx &
~ [pETa = ~l[euic-2 |

Here are definitions for the Y 1-axis plot (SQRT _ID) and the Y2-axis plot (PEAK).

@L1X means the X-axis intercept of LINE 1.

@L1G"2 means the squared gradient value of LINE 1. In this case, it is just calculating line 1 slope.
It is squared to account for the fact that the Y 1-axis is a square root.

Click Help > Agilent EasyEXPERT Help to open the online help. And visit the Read Out Functions
page for all of these functions.
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Vth Measurement
Display Setup Page

X-Y Graph

| [ous] L] Lo
Name: Scale: Min: Max:
P W ) | S —
v [SQRT_H =] [tnear =l o ] oz i
vz [PEAK =] [tnear ERE EIREE H
List Display Parameters
ads | | ! | add_| | | !
c v = e vt ~
r [sorRTd - (o 5 |
o e S

VTH and BETA are values which will be displayed at the Parameters area on the Data Display
window.

These variables are defined in the Function Setup screen.
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Auto Analysis
Analysis Setup Page

Line 1

 Enable F—Ype

" Normal  Gradient & Tangent

" Regression

r~First Point

£ X-Y Coordinate

& Data Condition

Condition: iF‘EN( ﬁ = |max(PE»\K]

& [ after |

=

—Second Point

& X-Y Coordinate

¢ Data Condition

X: | 5 ¥ |
Line 2
[~ Enable Type Axis
 Normal  Gradient (" Tangent { Regression |

" Data Condition

First Point
{ & %-Y Coordinate

X: | 5 iy |
Second Point
& %-Y Coordinate " Data Condition
( X: | g X: |
Marker
¥ Enable
Condition: |PEAK S = |max(PEAKJ 5 I Aﬂ:erl 5

(End of This Class Exercise)
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SMU Filter

...........................................................................................
o .

: Filter OFF

0 ;Force
¢ [vipac)— 1 ALVV‘O
: —O0
H Filter ON Series Resistor : S
SMU (1Mohm)  :>¢NS€
’ (V or I mode) :
S
Time
: Filter setting

......

The filter is mounted on each SMU. It assures clean source output with no spikes or overshooting.
However, using a filter may increase the SMU settling time. If measurement speed is top priority, set
the SMU Filter OFF.
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SMU Filter

QJEIIN Sweep Setup Name: |IV-res
Channel Satupl Measurement Setup IFunctlun Setup | Auto Analysis Setup ] Display Setup]
[var1 |
Advanced Setup
Channel Settings
Unit: VName:  IName:  SeriesR: SMU Filter:
|EE Bt [ [ HonE jlon _v'

[smuziap B2 =HE 5| HoHE =fon E |

SMU Filter: ON (add filter)
or OFF (no filter)

S

'Wait Time Control

Factor:

Output Wait: |1 jJ
Measurement Wait: |1 B

[TINUE AT ANY ~ | status

Range

ADC [
Integ

Ad-

vanced

| After Measurement Settings

Bias Hold after Measurement: | OFF =

|
Output Value after Measurement: | START =)

1]

Compliance:

To change the SMU filter setup, open the Advanced Setup window by clicking the Advanced button
on the Measurement Setup screen. And specify ON or OFF by using the SMU Filter pull down

menu.

In the power on state, the Classic Test sets the SMU Filter to ON.
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Standby Function
i.a
SMU1 Idle state force V Idle state
' '
i i
i i
Vz-- 1 1
1 1
SMU2 Standbyon | foreeVo I
| : ! :
: ; ; :
V3o i i :
SMU3 1 a force V a Standby OFF 1
| : P
Idle state | Standby state i | Standby state { ldle state
:. Measurement state :

Standby function sets any SMUs (except HRSMU with ASU) to specific output values and
compliances before starting or after stopping measurement. Standby function is useful for power
supplies of complicated device (eg. Smart TEG), defect analysis, and so on.

This slide shows the standby and measurement operation in the following setup. This example
assumes that the channel setup is defined in the Standby Channel Definition as follows in the order,
and the output value in the standby state is the same as the output value in the measurement state.

*SMU1: Voltage source, non-standby channel
*SMU?2: Voltage Source, standby channel
*SMU3: Voltage Source, standby channel
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To Use Standby Function

Category -|Q| Id-Vg Setup Name: (100
BIY ~ [Device Parameters
v [cH0s
Direct Contr Polarity: [lich | g [looem 8] wy: [10.0 um
2;::.: Temp: 5.0cey M| TdMax: 100 74 &
Hemery ‘ Standby Channel Definition
MixedSignal [» =]
Library < |[TestPa
. L Set standby channel output to: (D Standby ON
Vg
|Standby Channel Definition
& f— |
1-vgl3) Sandby:  URIE Mode: Source:  Compliance:
§ P I F [sawe v (A Wooma @]
' od |7 T [ =l =V ] [T
a
1d-vg pulse I r [savsee v v Wwous 6
i vesorl |~ [swem v v fow 5
. vgstol| |~ r [sasar v v ] [T
Vg
pulse{3] Voste
Vth gax
Laa 3.
Flag [ Setup Name Closs
Trng Idvd Vth
Trng Idvd Vth 4/16/2007 2:51:05PM 4
Trng Idvd Vth 4/16/2007 2:50:08 PM 3
Tmg Idvd Vth 4/16/2007 2:49:18PM 2
Trng Idvd Vth 4/16/2007 2:44:11PM 1
Ting Vth 4/16/2007 2:43:10PM 1

)] stancey OFF | [i[smizeroorr  [Elamboortor ] s recardon

Click the Standby Channel Definition button to open the Standby Channel Definition window.
Define Standby channels (Unit, Mode, Source, and Compliance).

Click the Standby ON button to set standby channel outputs. The Standby indicator will change from

OFF to ON.
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Bias Hold After Measurement

End of Single measurement
or
Start of next measurement

Bias Hold ON 4

I Source or Base value for Sampling

CONST | e L

VAR2 ‘_I_, Stop value

Bias Hold OFF
CONST ov

VAR1/VARYT’/CMU ’_I lFI |FI |_rrr ov

VAR2 I ov

Bias hold function keeps bias output after a measurement is made. For instance, the user may need
to keep one or more SMUs on between measurements to bias up a Vcc pin of an IC. Without this
function, a user is forced to connect an external power supply. Now there is no need for extra
supplies.

When this function is ON, the source channels apply the following value.

Constant source: Base value or Source value (I/V-t sampling)

Constant source: Source value (I/V Sweep or C-V Sweep)

VARI1/VARI’ source: Start value or Stop value (I/'V Sweep)

VAR2 source: Stop value (I/'V Sweep)

CMU: Start value or Stop value (C-
V Sweep)
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Class Exercise
Bias Hold Function

You will:

« Perform Repeat Measurement

« Measure the LED I-V characteristics

« Monitor LED during Repeat Measurement

To Get Started:

« Use the connection as same as the SMU pulse exercise
o Add an LED and jumper leads per following pages
« Get the LED setup
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Jumper Leads — Bias Hold Exercise

ENDE
ro n®)
s©
1P

< [00000000000000] %

Oq 1

¥ (000000000000 ™ [

1 T4 Shorter Lead

Connect test leads as shown. And add the LED between terminals 13 and 14 of the 28-pin dual in
line socket.
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Bias Hold Exercise

Channel and Measurement Setup

Setup Name: [LED

ol

V Sweep
4515 | Measurament Satua | Function Setus | Auto Analvsis Setup | Disoiy Setua |

‘Advanced Setup

[Channel Settings

SMU1 Function to VAR1" =

Unit:

Funclion:

Unit: VName: IName: Series R SMU Fillter:

= = ER

o [swiwe

[Euiaee EIT E = NONE =|jon =

o [swzme = = ElD feousT

Channa| Satup {Hiza: 5] Function Setwp | Auro Aaiyss Setup | Dispiey Sasup |

B "W = Hfoe =l =

[vART

Unit: |SMULHP ]
Name: |Vh =

Linear/ Log i~
start: [0V B
Stop: [2.5 v [
o E—

No of Step: |10 []
compliance: [100ms |
N
[Timing |

Hold: [05 3 Delay: [0 |

Vh=0to2.5V

Direction: [5rgk ~ |4

+ Sweep [CONTRIUE AT ALY =|stal

|Walt Time: Contral

il
Output Wait: [T H
Measurament Wait: |1 B

=

Rias Hold after Meastir

T =

Qutput Value after MeasuremaNg [510° -

Bias Hold to ON

Constants

Output Value to STOP

unit: v Name: TName: compliance:
@

: mode: Source:
[suzzp | =l =V Ev H][100 A

]

Set the SMU1 Function to VAR1. The VARI output 0 to 2.5 V is enough to light the LED.

measurements.
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Set the Bias Hold after Measurement field to ON to enable the bias hold function. And set the
Output Value after Measurement field to STOP. This setup keeps 2.5 V output between sweep
measurements. So the LED can light between the
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Bias Hold Exercise Repeat button
Repeat Measurement Setup 1

Repeat Procedures
Start Procedure:

I 5 Browse...
Arguments: 5
Iteration Procedure:
g Browse...
Arguments: 5
Final Procedure:
[ B Browse. Repeats three times
Arguments: 5 /
v Automatically fill in Device ID /
Thermo-trigger /
[~ Enable Thermo-trigger N1265A Thermo-triggg/fist... |

fepeat Stop Condition | / Click Run to start

Stop repeating by:
 Counter reachingfo: [z 8| measurement
¥ Reset counter beldsg repeating o
ancel

¥ Procedure return condition

Click Repeat button to open this window which is used to set and run the repeat measurement.

This example performs the LED I-V sweep measurement three times and then finishes the repeat
measurement.
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Bias Hold Exercise

7% Agilent

&)
100 m

Ih

10.0 m
Jdiv

LED lights on

——

0
~

vho (V)

~—

LED lights off

500 m /div

During the measurement, leave the fixture lid open. And monitor the LED. This measurement does
not force dangerous voltage.

At the start of measurement, LED lights off. Beyond the threshold voltage, the LED lights on. After
the measurement, the LED keeps lighting until start of the next sweep measurement. And this cycle
is repeated until the end of the repeat measurement. After the repeat measurement, the LED lights

off.
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Module 5
Modifying Application Test Definitions

In This Module

To Open Application Test Definition

* To Modify Test Definition

* To Use Debug Tools

* To Use Built-in Functions

* To Add Data Display

* To Use Auto Analysis

* To Use Test Setup Internal Variables

* To Use Auto Analysis twice (as Class Exercise)

* To Use Vector Data (as Class Exercise)
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Modification Overview

Open an application test definition to be modified
Open test definition editor

Save the definition as your test definition

Modify the definition as you like

Resave and close the definition

AN N A a

Export your test definition as your backup

This module explains the modification example using the Vth Const Id test definition. After the
modification, the new definition can perform the Vth Const Id measurement, display the Id-Vg curve,
and additionally display the gm-Vg curve.
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Modifying Application Test Definitions

Example: Select Vth Const Id as template

To Open an Application Test Definition

/th Const Id I '

vgstep: [S0.0m §

v

] Source: [SMUSHR =

Category -rI g Vih Const Id Setup Mame: Vo Const I = |
BT [Device Parameters ] |
os =

21 Daecr Cont Polarity: [lich O] Lg: [1o0nm W] wg: [100om  H]
2::;::: Temp: !25.0 deg ] TdMax: |10.0 mA I]

Memary
MixedSignal [»

Library -|Innw Extended Setup -
o
E-vgl3] ”»

Drain: [SMU4:HR =
. IntegTime: [MEDIUM = vd: 200V @ i
Vg pulse %
G
E; Gate: |SHUZHR - Subs: SMULHR - |
putse[3] VgStart: 500y B Vsubs: |0V ]
. vgStep: [200V W %
Vth gemiMax

Recall 2

Click a test definition in Library list area, and click Select button to open the test definition.

For example, open Vth Const Id.
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To Open Test Definition Editor

Click Library>Open Definition of This Test...

Category -I g Vih Const Id Setup Mame: Vo Const I = |
« [0H08 -
Direet Contil Polarity: [lic [] Lg: [100 nm | wg: [l00uwm W]
Discrete
Exrcise Temp: [25.0 deg ] TdMax: |10.0 mA ']
Memary
MixedSignal v
‘[ Ubrary ~llcancel Extended Setup -

Open Definition of This Test... I -
E-vgl3] Delete Definition of This Test
Import Test Definition...

. Export Test Definition...

==

:| Drain: [SMU4HR =

”»
vd: 200V & i

Vg Gate: |SMUTHR - Subs: [SMULHP -  —
putse(3] vgStart: [S00 v & = *% Vsubs: [V 8]

. vgstop: 200V & «
Veh gmbdacc vgstep: [s0.0 v W i

& ] Source: [SHUSHE + o
Vth Cl:‘nSl]li

Click Library and select Open Definition of This Test... to open the test definition editor.

The following pages show the modification example to display the gm-Vg curve given by the Vth
Const Id test result.

5-5



Module 5

Modifying Application Test Definitions

To Save Definition As Your Definition

Save the definition as your definition (ex: Trng vth)

-)

® Trog Vth B=] ]
File] Help e
Save Ctri+s| rec: oueput | e
Close
2o Unselected: Selected:
Category: [Exercse J——pocesguichy,
BIT -~
Test Name: [Trng Ve =) €MoS -
[ Direct Contrl UC
new test name CEEPERTG sovse. | der | | "
= e Memary : new category
Add nanoTech =
Name: Default: Description: NBTI
_ Pulsed IV
¢ [potriy i “8][f= the speched value) or Peh (SHUs ford it
Qs-Cv
ol 7 =100 m “Bl[Gate Length Relabiity R
c [wg E[in0um "B][Gate width Structure
TFT [x]
¢ [Temp wl[25.0 deg “Bl[Temperature
N T s f
| Test Parameters Definition ‘ [Exercise
Background: [C:\Program Fies|Agient\B1500\E2s/EXPERT| G Browse... | Clear
Name: Type: Default: Description:
¢ [itegTme  wd|stng  ][MEDII “=[incegration tme 0K Cancel
¢ [HodTme  m[numerc <[ s H][Hold tme =T ET E] ETT
¢ [peleyTime  m[lumerc <[5 “&][Deley tme El ] ] i
o [eevih  m[numenc ~][t0E06"(Waita) "8][orain current to decie the veh = moo B0 8iz0 8
¢ [prantinrag m[strng  =][ina _=]finmum range for the drain current measureme & 7 ] ] 8 v H
& [peompd  m[lumenc  <][10 mw “&[[Power complance of dran terminal = wlE g Ee w5 g

Test Definition editor

Create a new Category (ex. Exercise), and change the Test Name (ex. Trng Vth).

After changing the test name, save the test definition. Saving the definition will change the window
title to the new test name. Window title will be changed from Vth Const Id to Trng Vth in this
example.

In this example, the Trng Vth definition belongs to the Exercise category only.
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Modifying Application Test Definitions

To Modify Test Definition

Change default values and add parameters (ex: Pcomp_d)

€ Trog Ven BEX]
File Help
[Test Information ]
Caeeey: R e e e o120 o=
Test Name: |Tng Vih g =]
MOSFETQOId-VoRtEERE L. EEFECSoTUEEBE (V&
Tcon: [C:\Program Fles\Agient\B1500\EasyEXPERT\G! Browse...| Clear HFBe . LR MR =
Device Parameters Definition Properties ]
e | [osee] | [wwin] wr—)| This area sets the
Name: Default: De: (.58 el R
~ oy i I oo o s Forea T e e v ) [ wacpew——E|| properties of the
e :
e ‘o0 o Wete ten - o T specified parameter.
- [ H[iooum “8l[eere i = e “Min
« [reme =500 “B|[Tempereure =
Typical Values...
- e - L NG *Max
[Test Parameters Definition ] . .
Back ind: |C:\P: Files\Agilent\B1500\EasyEXPERT\G! B Cl .Dlglts
ckground: G- ogram Fles Agien = | Browse...| Cear
Add Delete Up 'Res()luti()n
Name: Type: Default: Description: Align: X: v: width:  Ext:
c [egtms m[stng =][weomn e = Floo Epo Hpe gHr & *Unit
c [HoiTme  ml[iumeric  =][os 8]frois = I | T | 4 "l‘ypical Values
¢ [oskyrime  miumerc =[os “lfosay ome I e i [ .
*Symbols
© [davh ®[Numeric _7][1.0E-067(Vg/Lg) TH][Dran current to decde the vth = (w0 Bl 10 & v
 [prntinRng m[stng =l[tnA ] frmam range for the dran curent messvremed 7 [0 B0 Bl ER |-
c lpcomo g emllyrarc 100 oV 81Poyar comolance of dan tarminal sl Bl gleo Rl )

Test Definition editor

On the Test Specification tab screen, you can add new parameters or change parameter settings.

This example changes the default value of the Module parameters for the MOS FET class exercise
typical setup and adds the Pcomp_d test parameter (drain terminal power compliance).

The Module parameter default values are changed as follows. See the actual settings on the test
definition editor.

Drain: SMU4

Gate: SMU3

Source: SMU2

Subs: SMU1

The Pcomp_d parameter is defined as follows.

Name=Pcomp_d, Type=Numeric, Default=1 mW, Description=Power compliance for drain terminal,
Align=check, X=550, Y=120, Width=80, Ext=uncheck

Properties: Min=1 mW, Max=20 mW, Digits=4, Resolution=1 mW, Unit=W

For Align, X, Y, and Width values, consult the settings of the other parameters for the same terminal
(ex. Drain). For example, Pcomp_d must be located between Vd and Subs entry fields (see
application test screen on the main window). So X and Width should be the same as the settings of
Vd, and Y should be between 90 and 180 (see the actual settings of Vd and Subs on the test
definition editor).

Typical Values... button opens a dialog box used to define the typical values used for the selections
of the parameter value in the Application Test mode. For example, set 2 mW to 20 mW in 2 mW
step for Pcomp_d.

Symbols... button opens a dialog box used to map a numeric value to a string. For example,
Value=1 and Symbol=ON are set, typing ON enters 1, and typing 1 enters ON. The value must
satisfy the Min, Max, Digits, and Resolution settings. The value and the symbol must be one by one.
The definition is effective only for the parameter.
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To Modify Test Definition

Change or set test parameters (ex: Pcomp_d)

€ Trog Ven BEER]
File Help
Test Speciication ([Test Contents |
==
B 0 ® H & A
BLOCK F Loop FOR  ASSIGN COMMENT  END ERROR
Program Companent | Appication Test | Analyss ] Cassic Test] Miscelneous | My Favorice Setup
= ®@[1/V Sweep Setup Name: |Veh Const 19 =
= 53‘:;"‘“" Delete Channel Setup Measurement Setup | Function Setup | Auto Anaiysss Setup | Dispi Setup |
=l vARL I
2 R
ange
a unit: [SU=Gate 8] <
Y A g Name: [Vgate = e
o Integ
Direction: [snale v
Local Variables Defini =
&l Linear/Log: [LIEAR - Ad-
BLOCK i vanced
txx%xx Integration T Start: [VgsarcPoarty B
IF IntegTime="SHORT" |
: [VostopPobrey B
IntegMode = "MANUA S b
AdcFactor = 8 Step: [VoStenPorty B
ELSE IF IntegTime="M C—
- et [
IntegMode = "PLC" No of Step: s
AdcFactor = 1 Compliance: [lalm= []
ELSE IF IntegTime="L  Cerrm— |
: [Pomp_3 W
IntegMode = "BLC" FuECony: = J
AdcFactor = 16 [Timing
END IF
xunuk Ty Sweep *kE Hold: [4odTme ] Delay: [PsTme 8]+ sweep [CONTIUE ATANY =] status
Vin const ld ]
END BLOCK unit: V Name: IName: Mode: Source: Compliance:
[SWU=Source  H|[Vsource e [fsource =V B|[Vpomry ] [tatax El ?i
! |[puu=omn  &][varan =l [idran =V B[vapomrty  @]|1amax ||
‘ | v AGnu=sies— Elfvaes @l [lsubs =V Bl[Vsubspoirty Bl[lubsme @l [v]

Test Definition editor

On the Test Contents tab screen, you can change the test execution flow (program flow),

measurement conditions, display setup, and so on.

To add the Pcomp d parameter to the measurement setup, click the Vth Const Id line in the program
list. And in the I/V Sweep setup editor, display the Measurement Setup tab screen. And enter

Pcomp d to the Pwr Comp entry field.
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Modifying Application Test Definitions

To Modify Test Definition

Change display setup and define external variables
€ s BE]

File Help

Test Specfication|_Test Contents

B h O® M O ¢ A

sLock F loOP  FOR  ASSIGN COMMENT  END  ERROR
External variables must
Program Companent | Application Test| Analss | Classic Test| Miscelaneous | My Favortie Setup
o @[1/VSweep  SetupName: [hcosls | be defined before making
i e r Delete || Channel Setup | Measurement Setup | Function Setup | Auto Analyss Setup Display Setup | the matching table.
3 L Assign to extemal variables... | ‘
8 [X-¥ Graph
T copy cut ast i ... || External Variable
L s -
Name: Scale: Min: R
Local Variables Defini = . [vgam =T 3] Fosmepon -
Leca] F ox  [em o e 3] [resmeron it - ; ‘
.
S e © v fien & iner [ Joa External variable: Measurement data:
IntegMode = "MANUAR g = = -15%Pokr
reractor = 8 ® w2 | Elffics ENCEEE N e rewern T Tvn =)
ELSE IF IntegTime="M
Integrods = "PLC F Joen =i m 5 |
AdcFactor = 1
ELSE IF IntegTime="L
IntegMode = "PLC" [0t | P ) B Jvazte R |
AdcFactor = 16 L
END IF Add Add o |{~ ID_data -] [1drain |
b IV Suesep *xx
Vvth Const Id || [Vaste = 1"‘ o T f
TETTEy .
=D Bzock o [ S H External variable
o - —
E| - —— = I'est setup internal variable
% | )—J‘—‘ Vsubs L Ij
I'est Definition editor |

On the Display Setup tab screen, you can change the graph scale Min/Max values or add/delete the
list parameters.

This example makes the matching table between the External variables and the Measurement data.
The measurement data can be referred outside the test setup via the external variable.

Where, the measurement data means the variables used in the test setup. And the external variables
means the parameters defined in the Test Specification, the Local Variable Definition, or the Test
Output’s Analysis Parameter Definition.

This example sets the matching table as follows.
Vth_constld external variable: Vth internal variable
GM_ data external variable: gm internal variable
VG_data external variable: Vgate internal variable
ID_data external variable: Idrain internal variable

External variables must be defined before making the matching table. In this example, the variables
are defined in the Analysis Parameter Definition. See the next page.
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To Modify Test Definition

Define Test Output and Analysis Parameters

¥ Define own Output Parameters.

F.Trngvth <
File Help
"

-V Graph

Analf

arameter Definition

Name: Scale:

Min: Max:
| [vestert=Polarty ®] [Vgstop*Poe

rameters

e [ve_data =

c  [p_saw =

c [ev_dam =

I  [Veh_constld

¥ x: [vo_dam =] [tinear
Name: Unit:

cove s =] [ear = [or ] [avmcross| | [FHeew =[S =
oy [ondem =] [Grewr =] [os & foms | c [ve_dam v =][Va data of ven =

¢ [D_data EIR ~|[td data of VenConstid me: =

- i
Scalar Paramters ‘
[Gist Display. Parameters
Add 3 Add [aad | [oee| |0 | i |

[ ¢ [th_constld

Name:

Unit: Description

EIE =][Threshod vokage

)

Close

|

Test Definition editor

This example defines the Test Output and the Analysis Parameters.

1. Display the Test Output screen.

2. Check the Define own Output Parameters.
3. Click the Define Analysis Parameters button.

4. Define the analysis parameters (ex. GM_data, VG _data, ID data, and Vth constID).

5. Define the X-Y Graph, List Display, and Parameters.

Note

External variables must be defined before making the matching table shown in the previous page. In

this example, the following parameters can be the external variables.
Parameters defined in the Test Specification

Variables defined in the Local Variable Definition
Variables defined in the Analysis Parameter Definition (this example)

Note

If this test definition is used in the other test definition, the analysis parameters can be referred
outside this test definition. This means that the analysis parameters can be the Measurement data in

the External Variable Setup as shown in the previous page.
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To Modify Test Definition

Add local variable (ex: Yes for Message box)

Trng Vth
g

BEX]

File Help

Test Spaciication Test Contants l

B &

-

O ® M O © A

BLOCK  ONERROR  FINALLY ¥ Loop FOR  ASSIGN COMMENT  END ERROR
Program Component | Application Test| Analyss ] Classic Test] Miscelaneous | My Favoriie Setup
= || [Local Variables Definition statement ]
B o Add Numeric | Add Vector | AddSting | Add Module
= Variable Variable Variable Variabl
g
£ String Variable |
=
Break

Name: [Integiiode & Value: [PLC” & Description: [Varzble for ntegraton mode =

<

Local Variables Defini

IpEsrs Integration T

IF IntegTime="SHORT"
IntegMode = "MANUA
AdcFactor = 8

ELSE IF IntegTime="M
IntegMode = "PLC"
AdeFactor = 1

ELSE IF IntegTime="L
IntegMode = "PLC"
AdcFactor = 16

END IF

wker -V Sweep *#%

Jth Const Td

: [t 8| Description: [Varable for ADC factor =

Numeric Variable |

Name: [Yes & Value: [0 B| Description: [User response = ]

Variable Yes is used in
the message box.

Message

TND-ETOCE

| N

Test Definition editor

Click Local Variables Definition line to display the local variable list. And define variables.

This example defines Yes variable as follows. This variable is used in a message box. See the next

page.

Name=Yes, Value=0, Description=User response
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To Modify Test Definition

Define Message box

€ Trog Vth BEx .
il Tilp . This message box

Test suecmcatmh asks you clicking the
oaE s OK button to display

GPBYO  Message Command Data Store

Execution  Control the gm curve.
Program Component ] Appication Test] Analyss)] Chssic Test Miscelaneous [My Favorte Setum '

[Message
o cisply the O curve, Cick OK.

This setup displays the message
“To display the gm curve, click OK.”
Local varisbies pefin: || ON the message box.

g

| Debug  Edit

Break

Pxkmek Integration T
IF IntegTime="SHORT"
IntegMode = "MANUA
AdcFactor = 8
ELSE IF IntegTime="M .
=S i This setup makes the OK button on
AdcFactor = 1
Erse 17 mregrime=rz || the message box.
IntegMode = "PLC"
AdcFactor = 16 [tk Hoopiise J
END IE Label: Selected:
e ————

Uih coner i Buton1 [ =) = | The value of the local

Message Buonz || & = . ble Y .
ENL oo L) ig ® variable Yes is set to 1
Button 3

from 0 by clicking the
OK button.

= Button 4

5 | il
Test Definition editor

Click the Message line in the program list. And define the message box.

This example defines the message box that opens after the Vth Const Id measurement and displays a
message and the OK button.

1. Enter the message.

2. Enter the button name.

3. Select the variable used to keep the status of the button.
4. Repeat 2 and 3 for all buttons you want to add.

5-12



Module 5
Modifying Application Test Definitions

To Modify Test Definition

Example: Displaying Message box

r. Vith Const Id - Agilent EasyEXPERT mE
File Edit Marker Cursor Line Window Help

Haadid-BrER e U560

Setup Name:  [Vth Const Id X
X-¥ Graph Plot Properties... [Parameters ‘
7 Agilent  curson| < v A x)

® A Vth fL-10910v

10m 10m
© Message
- To display the gm curve, click OK.
3

1.00m

s00m Vaate (V) 200m/div 2
[List Display Properties...
Index_ [ Vgate [ Vsource | Vdrain | Vsubs [ Idrain [ am s/
1 -500 my oV 2v ov 233 pA -165.28 pS —
2 450 mv ov 2v ov -5.934 pA 46.87 pS [se]
<l 2]

In this modification example, the message box opens after the Vth Const Id measurement is
completed. This message box asks you clicking the OK button to display the gm curve.
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Modifying Application Test Definitions

Class Exercise

1. Open Id-Vd test definition.
2. Modify it as follows.

tangent line to Vdrain=1 point.

. Use the debug tools.

. Perform the test.

Perform the following modification example.
If Yes is clicked after Id-Vd test, move marker and
If Yes is clicked, perform Vth gmMax test.
3
4. Save the definition as a new one (ex. Trng IdVd Vth).
5
6

. Export the new definition, and import it.

1. Add the Yes variable to the Local Variable Definition.

2. Insert the following lines between the lines Id-Vd and END BLOCK.

Message
IF Yes=1

Auto Analysis
END IF
Message
IF Yes=1

Vth gmMax
END IF

3. Define the first message box.
Message: Do you perform auto analysis?
Buttonl Label: Yes, Selected: Yes
Button 2 Label: No, Selected: (blank)

4. Define the second message box.

Message: Do you perform Vth gmMax test?
Buttonl Label: Yes, Selected: Yes

Button 2 Label: No, Selected: (blank)

5. Define the IF statements.
Condition Expression: Yes=1

6. Define the Auto Analysis.
Line 1: Enable, Tangent, Axis: Y1, Data Condition: Vdrain=1
Marker: Enable, Condition: Vdrain=1

7. Change the Vth gmMax test parameters as follows.
Drain: Drain

Gate: Gate

Source: Source

Subs: Subs
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Modifying Application Test Definitions

To Use Debug Tools

Test Speckiaton Test Gontents | Test Output |

= o= =8

GPB L0 Message  Command Dats Store
Execution  Control

Pragar Coroonert | Ropirten Tox | Al PE ﬁﬂ]
é P el e R L e e “12::&:"[
ﬁ String Variable
Break Inspect
- Vartable: [Fetordor =] value: [sU0T !|]
Local Variables Defini
BLOCK lhmuvnrhlln
cpib( ' b | 2 | Retumch - : T;
:;;bi ; ) variable: |Re = valve: [ouT !] ]
stringP "sMuUl*®
Gpib{ *Write' )
Spib{ twriva: )
e el ReturnPort = SMU1
Gpib{ 'Read' )
StringCl "oUT1"
. Spin( ) ReturnCh = OUT1
Break point ikl )
pibi sad' )
> = crib( 'write' )
Gpib{ 'Read' )
END BLOCK
q
Variable Inspector

This slide shows an example of using the Variable Inspector for debugging. Confirm whether the
correct values are passed to the variables properly.

Set the break point, and click the Run button. After the program is paused, click the Inspect button.
The Variable Inspector is displayed. You can check the values by using the variable display fields.
The field can be displayed by using the Add XXXX Variable button. XXXX will be Numeric,
Vector, String, or Module.
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Modifying Application Test Definitions

To Use Debug Tools

@ Untitled

BEX]
File Help

Test Specfication Test Contents | Test Outpu|

BE 4 ® n O ® H O o A

BLOCK  ONERROR  FINALLY ¥ LooP. FOR ASSIGN  COMMENT ~ END ERROR

i+ [Appiication Test | Anaysis | Classic Test] Miscelaneous Wy Favorte setup

BLOCK statement

ebug | Edit

Break

Local Variables Defini =
BLOCK

*Run

*Abort N
.Stop s
*Break
*Inspect

M

The Debug tab menu provides the following buttons:

*Run button starts the debug (executes the test flow). During execution, the label changes to Pause.

Clicking Pause button pauses the execution, and changes the label to Run that is used to continue the
debug (execution).

*Abort button aborts the debug (execution).

*Step button executes the highlighted line of the test flow. Clicking the button repeatedly continues
the execution by a line.

*Break button sets/releases the break point. For the break point, this button releases the break point
from the highlighted line. Program execution will break at the break point automatically.

Inspect button is available when the debug (execution) is paused or breaked. This button opens the

Variable Inspector used to monitor value of device parameters, test parameters, analysis parameters,
local variables, or system variables.
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Modifying Application Test Definitions

To Use Debug Tools

Debug: Inspect button

@ Trngidvd idvg M]=)% ]

File Help

Test Speciication  Test Contents ‘mt outpue|

B n m ®# O® HH O © A

BLOCK. F ELSE IF ELSE LOOF. FOR ASSIGN  COMMENT ~ END ERROR.

Program Companent [ Application Test | Analysis] Cassic Test | Miscelaneous | My Favorte Setup |

= [iF statement ]
2 R Abort st
1= " o = € Variable Inspector PR
2 TF || add numeric Add Vector | Add string | Add Module
1 Variable | Variable Variable Variable
Break | Inspect
Numeric Variable |
Local Variables Defini 4 Variable: |8 ] value: i |
. BIOCK &
Break point o Tavd
\ Message
[ IF ves=0
END
. END IF v
Paused point 1dvg

END BLOCK

The Variable Inspector is displayed by clicking the Inspect button after the program is paused, and is
used to monitor or change the value of the device parameters, test parameters, analysis parameters,
local variables, or system variables. For the vector variables, only data monitor is available. The
Variable Inspector provides the following buttons to add the variable monitor area.

* Add Numeric Variable
* Add Vector Variable

* Add String Variable

* Add Module Variable

The following functions are available for the menu displayed by clicking the banner of the variable
monitor area.

*Up: This button shifts the variable monitor area upward.
*Down: This button shifts the variable monitor area downward.

*Remove: This button deletes the variable monitor area.
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Modifying Application Test Definitions

To Resave and Close Your Test Definition

Close the definition editor, and overwrite your test definition

© Trog Vith [m=]
File | Help
Save Ctri+S Fesgoncente| 7ot output|
Close ]
Category: [Exercse Description: [ <enguagzOption lang=1a'> )
= /th Const Id: EERVEh (A.01.20) Ef,!
Test Name: [Tma Ve = ]
HMOSFETOIS-VoRIHEBIEL. EERECLTUSBBE(Vh
Teon: |C:\Program Files\Agilent\B1500\EasyEXPERT\Gr  Browse...| Clear HIB. ‘:‘
Device Parameters Definition [Properties ]
Add Up Do
- N i NP Min: [1 W 8
Name: Default: Description:
¢ [poary i "H]F= the specfied valie) ar peh (MU force the nedziie sacfed vl &) Max20 Y/ g
Confirm Test Definition Save X igits: |4 (]
c o &][100 i 8][Gete L X
jon: |1 MW &
9} Doyouwant to save this test definton? Resolution:
« jwg i 10.0 um ||Gate widt| \‘J =
TestName: Trng vth Unit: |W 2]
Fa— AFement] Category: CHOS
(a{ P = Sreer ypical Values... | symbos... |
- T = - —
T T — Confirm Test Definition Overwrite
An application test definition of the same name already exists.
Background: [C:\Program Fies\Aglent\B1500\EasyEXPE TOTSE T\ Test cefinton: Trmg vih
Test categoriest CHOS
Name: Type: Default: Descri Do you want to replace it?
¢ [ntegTime  md[sting |[MEDIUM |[incegretio
—UK Cancel
¢ [HodTme  m[numerc <[ s “8[[Hold tme
¢ [peleyTime  m[lumerc <[5 “&][Deley tme El ] i
o [eevih  m[numenc ~][t0E06"(Waita) "8][orain current to decie the veh = e o Bl Er
¢ [prantinrag m[strng  =][ina _=]finmum range for the drain current measureme & 7 ] 8 v H
& [peompd  m[lumenc  <][10 mw “&[[Power complance of dran terminal = wlE g Ee w5 g

Test Definition editor

After you create your test definition, save the definition and close the Test Definition editor.

Click File > Close. Confirm Test Definition Save dialog box is opened. Click Yes to save your test
definition and continue the close operation. The Confirm Test Definition Overwrite dialog box is
opened. Click OK to overwrite your test definition.
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To Export/Import Test Definition

Click Library>Export Test Definition or Import Test Definition

Category - | (D] Vth Const1d Setup Name: [Voh Const 1o - |
L1 ~ [Device Parameters 1
oS — — _
1 Dieyet Canc) Polarity: [1ich ] Lg: [100nm @] Test Definitian import )%
Discrete . Lookin: [ t=st_defintion 5 «EerE
Expreise Temp: EZS.O deg ] TdMax: |10.0 ma ] L;é @
Memary
MixedSignal v st
‘[ Ll ~ llcancel D(%
efine New Test... L
Open Definition of This Test... J
:d-\rglzl initi i My Documes nts
Import Test Definition... —
xport 1est Definition... o
e r po | My Computer
Bd-vg pulse =
[ Subs 'Q
. i x|
A =
. e Swein: [Dtest defnton =] 4= @ cFE- A
ld-\'[g] Gate: [SHUHR : 5 —
pulse(3 vgstart: 500~ &
My Recent
Efi e —
7
Vih gmbdax vgstep: [S00mv W ] e
A
d Mfﬂﬁ\en\s
vth Const 14
My e Fl rame [Tron ) Save
Save as type: EasyEXPERT Test Definition Files R Cancel

The test definition can be exported as the EasyEXPERT test definition file format or XML file
format. And the file can be imported to the EasyEXPERT later.
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Modifying Application Test Definitions

Absolute value:

Averaging:

Data conversion:
Difference:

Differentiation, integration:
Exponent, logarithm:
Maximum, minimum:
Reading data :

Square root:

Trigonometric function:

To Use Built-in Functions

abs(A)

avg(A), mavg(A,B)

string(A), value(A)

delta(A)

diff(A,B), integ(A,B)

exp(A), Igt(A), log(A)

max(A), min(A)

getNumericData(A), getVectorData(A)
sqrt(A)

acos(A), asin(A) , atan(A), atan2(A,B),
cos(A), sin(A), tan(A)

The EasyEXPERT software provides the built-in functions to calculate the display data and

parameter or to get the test result data. The built-in functions can be used in the user function and

analysis function of the test setup, and in the test execution flow of the test contents.

The following functions are also available.

at(A,B), at(A,B,C), ceil(A), cond(A,B,C,D), dim1Size(A), dim2Size(A), floor(A), index(A,B),
isValid(A), setDeviceld(A), storeAt(A,B,C,D), substring(A,B,C), swmToModule(A)

For details of the functions, see User’s Guide or online help.
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To Use Built-in Functions

User function setup example

'© Trog 1dVg Auto Ana BEx]

Fle e

Test Spachcation Test Contents | Test output

40 4

UVSweep | TVt  CVSweep
Sampling

Program Component | Application Test | Analsi| chssic Test JMiscelaneous|

= @|1/V Sweep Setup Name: [idvg El
B et | msen Delete || Channel S2tun | Measureman Setup [ Foncoon Se0p ) oty Setup |
- -
E Copy Cut Paste Add Delete Up Down
Name: Unit: Definition:
I};Zgz; Variables Defini 4| 5 [ =5 S 3
vessage e o =[S S &
h-_iii = gm = diff(1d,Vg)
VG=getVectorData(Vg) il gmMax = max(gm)
ID=getVectorData(Id) VG = getvectorba
1D = getvactorpa
GM=getVectorData(gm) o = getvectorda | |[ARaiysis Funcion
. VTH = getNumeric — —— . o
VTH=getNumericData(Vth) SIS midecs ) - | | | |
isplay, Vth and Name: Unit: Definition:
i
GM_MAX=getVectorData(gmMax) ey 1o ¥ - @ EY e o
END IF
END BLOCK
< 1 o

This is an user function setup example. This example uses the diff function to calculate gm values
and the max function to get the maximum gm value.

Also, the getVectorData and getNumericData functions are used in the test execution flow to get the
test result data.
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To Use Read Out Functions

Marker index value: @MI

X coordinate value: @MX, @CX

Y coordinate value: @MY, @MYn, @CY, @CYn
Regression line parameter: @L1CO, @L2CO

Line slope: @L1G, @L1Gn, @L2G. @L.2Gn
Line X intercept: @L1X, @L.2X

Line Y intercept: @L1Y, @L.1Yn, @L2Y, @L2Yn
Intersection of lines: @IX, @lY, @IYn

n: integer. 1 to 8.

The EasyEXPERT software provides the read out functions to read the marker position, cursor
position, line slope, line intercept, and so on. The read out functions can be used in the analysis
function of the test setup.
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Modifying Application Test Definitions

Analysis function setup example

To Use Read Out Functions

€ TrogldVg Auto Ana mEx
Fie e
Test Spachcation Test Contents | Test output
4)0 4
UVSweep | IVt CVSweep
Sampling
Program Component | Application Test | Analsi| chssic Test JMiscelaneous|
£ ooa @|1/V Sweep Setup Name: [idvg =
Selection |  Insert Delete || Channel Setup | Measurement satup [Fancon setun | ooy setup|
o [User Function
2
& Copy Cut Paste Add Delete Up Down
Name:  Unit: Definition:
Local Variables Defini A
BLOCK c Jom =|s aiad va) 6
Message e foriex e[S Hfmextorm) &
CE—
AULC ANAlysis
Message
IF Yes=l
VG = getVectorDa
ID = getVectorDa
GM = getVectorDa |Analysis Function
VTH = getNumeri
G MK = getvect J T T
Display, Vth and Name:  Unit: Definition:
Ruto Analysis
END IF e v fetix |
END IF
END BLOCK
Vth = @L1X
“ | >

This is an analysis function setup example. This example uses the @L1X function to get the X

intercept value of the line 1.
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Modifying Application Test Definitions

Data display

To Add Data Display

Analysis: Display Data Setup

€ Trog IdVg Auto Ana okd
Fie Felo
Test Specficaton Tesk Contants | Test Outaut |
= (=
B B
Auto |Display Datalpata Displa
Analysis | Setup
Program Component | Application Te:
8 Block S e
_ selection =t e |I Setup Name:  [Dispiay, Vth and Tangent Line C}
E)
E Y Graph
& Copy ct Paste
= add Delete D
Measurement, Local variables Defini 4] Nene: Scale Mes Max:
. BLOCK ¥ ox |6 ] [tinear =] [dVo Vostat 8] [idVo_Voston 8]
data display, and Message
= c vz [D ~| [Cnear - o &] [o.001 ]
data save [ 3 [CSsE—— I =] KN &l |
Auto analysis cova: [em | [Lnear N 8] [o.001 |
Message
IF Yes=1
VG = getVectorDa
ID = getVectorDa
st Display. TPai

GM = getVectorDa

VTH = getNumeric
Display, Vth and
AUCO ANalysis
END IF
END IF
END BLOCK

~

VG

c [o 5

e [em =

~

-

[ - ]

GH_MAX E
VTH =

The test setup performs measurement, displays the test result, and stores the test result data to the test

record.

In addition to the default test result display, you can make additional data display by using the
Display Data Setup statement. The statement provides the user interface as same as the Display
Setup of the Classic Test or the Test Output of the test definition. The above example displays the
ID-VG/GM-VG curves, GM_MAX and VTH values, and tangent line by using the extra Data

Display and Auto Analysis function. See next slide.

Note:

This additional display data cannot be saved to the data record. However only the last display data

can be saved if the Test Output has not been set.
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To Add Data Display

Additional data display example

'@ Display, Vth and Tangent Line - Agilent EasyEXPERT

%]

]

File larker

Cursor Line Window Help

HaQXd ORHHHE® &

-FA-EE

Setup Name:  [Display, Vth and Tangent Line

X-¥ Graph Plot

- BAE4000u

l [parameters |
£E Agilent
0 MameR ] 0 GM_MAX 5454 4
im m
Inte t 0
164500 VTH  [207.854785478¢
Gradient:

VG () 200 m /div 2
List Display |
Index_| A D | [~
10 s0.00m 135.640 U 52062 U =
11 0 162420 u 540.8 U
12 s0.00m 189.720 U 5454 U ol

This is a test result example displayed on the Data Display window.

The auto analysis setup for this example is shown in the next page.
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e Linel
e Line?2
e  Marker

To Use Auto Analysis Function

Analysis: Auto Analysis

® Trog ldVg Auto Ana

B[EX]

Fie el

Test spechication Test Contants | et Output |

[ ] =7

2 =
Auto isplay Data Data Display

Analysis Setup Control

¥ Interpolation Mode

Program Component | Application Test| mw;! Classic Test | Miscelanaous |
Block =
Selection Insert Delete Line 1

=
g
=l ~Type 1 AXS 1
2 A { - Mormail - (cradienit /&1 Tangent, C Regrsscion [ i v
3 copy at Paste
o —First Point
€ X-Y Coordinate  Data Condition
Local Variables Defini 4
BLOCK | Condition: [em = = [or_max = [ after | =Ml ﬂ‘
Message Second Point.
IF Yes=1 { GM=GM_M A Xndton ‘
Idvg —
X: Y
Auto Analysis I £l I Ll
Message [ ‘
IF Yes=1
VG = getVectorDa I Enable ~Type [Axis
D = getvectorpa @ Normal € Gradent € Tangent ¢ Regression ‘
GM = getVectorDa [~First Point
VTH = getNumeric & X-Y Coordinate € Data Condition
GM_MAX = getVect
Dizolo — ] H v =
END IF & XY Coordinate € Data Condition ‘
END IF
x v
eNp LOCK I = I =
[Marker ]
I enae
. ’ >’J' condiion: [ EN Elt EN =

The Auto Analysis statement is used to apply the automatic analysis function to the last test result
before this statement. When the test finishes, the function automatically draws lines, a marker, or
both on the X-Y Graph of the Data Display window. This statement provides the same GUI as the

Auto Analysis setup in the Classic Test.

You can set up two lines and one marker for the automatic analysis function by using the setup

editor.

In the Line 1 and Line 2 areas, you can set up the lines to be drawn.

In the Marker area, you can set up the marker.

This example draws the tangent line for the Y1 data at the maximum GM point.
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To Control Test Result Data Outputs

Analysis: Data Display Control

Test Spacification  Test Contents | Tast Output |

[ ] =
2 &
B i
Auto Analysis Display Data Data Display
Setup Control

Program Component | Application Test ! Analysis | Classic Test

Miscellaneous | My Favorite Setup
Data Display: OFF/ON

Miscellaneous: Data Store Control

Tast Specification  Test Contents | Test Dutputl

E O &=

GFIB /O Message Command Data Store
Execution Control

Program Component | Application Test | Analyss | Classic Test {Wiscalaneous | My Favorite Setup

Data Store: OFF/ON

By the default setting, the results of the tests defined in your test definition are displayed on the Data
Display window and are stored to the data record.

You can control the data display of the tests by using the Data Display Control statement. Insert the
statement, and remove the check from the Enable Data Display box to disable the data display.

You can also control the data storage of the tests by using the Data Store Control statement. Insert
the statement, and remove the check from the Enable Creating Test Result Record box to disable the
data storage.

The functions cannot control the following data output. They are always enabled.
-Data output by the Test Output of the test definition
-Data output by the last test setup if the Test Output has not been set
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To Use Test Setup Internal Variables

Llgks

|

or

Al

ess the (Add]

‘ From Display Setup screen
of Classic Test setup

=

‘ I e | Jotea] L] Lo

® Untited E@-ﬁ‘ﬁ”

External Variable Setup

[Variable assignments

Delete.
External variable: Measurement data:
© [EEROR | T =

Internal variable

From Application Test setup

*Local variable
*Device parameter
*Test parameter
*Analysis parameter

Close

External Variable Setup

You may want to read the parameters/variables used in Classic Test setup or Application Test setup
defined in the Test Contents. Then use the External Variables Setup window used to make a
mapping table between the test setup internal variables/parameters and the external variables (local

variables, device parameters, test parameters, or analysis parameters).

To open the External Variable Setup window from a classic test setup:

*Specify the classic test.
*Click the Display Setup tab.

*Click the Assign to external variables... button.

To open the External Variable Setup window from an application test setup:

*Specify the application test.

*Click the Assign to external variables... button.

Note: Application test internal parameter/variable to be connected to an external variable must be the
analysis parameter in its test definition. For the analysis parameter, see “To Define Test Output” in

Module 6.
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To Use Test Setup Internal Variables
Setup example |Assign to external variables... |

L

External Variable Setup
Variable assignments
TN
External variable: Measurement data:
e v = [veh |
o v =1l [vg g
o fom Ei Jarm El
o [em_max = Jammax Bl
r |o | | -

This example makes the mapping table between the test setup internal parameters and the analysis
parameters.

*Define VTH, GM_MAX, VG, ID, and GM as the analysis parameters.
*Set these analysis parameters to the display parameters.

*Open the External Variable Setup dialog box.

*Assign VTH to the internal parameter Vth.

*Assign VG to the internal parameter Vg.

*Assign GM to the internal parameter gm.

*Assign GM_MAX to the internal parameter gmMax.

*Assign ID to the internal parameter Id.

For the example definition, open the Trng idvd idvg2 definition stored in the ¥data folder on the

Manual CD. The Manual CD stores the example test setup and definition data used in this manual.
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To Use Test Setup Internal Variables
Result example

€ Trog idvd idve? - Agilent EasyEXPERT BE x|
File Edit View Marker Cursor Line Window Help

BEEEEEuQAld-BEHREs@E-B-5ily

SetupName:  [Trng idvd idvg2

X
X-Y Graph Plot Properties... | \ [Parameters |
¥% Agilent
(a) (s) VTH 1.02606
im 15m

GM_MAX 112100 mS

D

W2

100y
Jdiv
0 0
-500m VG (V) 200 m/div 2
<] ] | [

Tt Drepiay Properties... | |
Index | v | ] G | =
1 500 my’ 46074 -206.000000000... B
z 490 my 2.50A 147.5 05
3 -480 mv 249pA  17.5ps vl

This is a result example of the test output setup shown in the previous pages.
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Using built-in functions

To Use Test Setup Internal Variables

Local Variables Definition
BLOCK
IdVg «— Test setup
VG = getVectorData(“Vg”)
ID = getVectorData(“ld”)
GM = getVectorData(“gm”)

Display parameters of
the last Data Display window

(SE=]

T

VTH = getNumericData(“Vth”)
IdVd<+~— Test setup
END BLOCK

GM_MAX = getVectorData(“gmMax”)

Vg, Id, gm, gmMax, and Vth
must be the display
parameters of IdVg.

This example shows another way to read the value of the internal variables (Vg, Id, gm, gmMax, and

Vth). In this example, you do not use the mapping table but use the getVectorData and

getNumericData built-in functions. The functions can be used to read the value of parameters

displayed on the last data display.

To read the value:

*Define VG, ID, GM, GM_MAX, and VTH as the analysis parameters.

*Set these analysis parameters to the display parameters.

eInsert the ASSIGN statements to add the formula shown above.

Note: Application test internal parameter/variable to be connected to an external variable must be the
analysis parameter in its test definition. For the analysis parameter, see “To Define Test Output” in

Module 6.
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To Use Test Setup Internal Variables
Using built-in functions, setup example

@ Trngidvd idva3 [m=)]X]
File Help
B h 0O ® @] A
BLOCK F LOOF FOR ASSIGN  COMMENT  END ERROR
Program Companent [ Application Test | Anatysis] Cassic Test | Miscelaneous | My Favorte Setup
= [Message ]
L Block Do you perform 1d-Va measurement?
—_ selection pelete =
o
3
a
Copy cut
Local Variables Defini -
BLOCK
Message
IF Yes=1
1dvg
V& = getVecterDat
D = ge
GM = gef
GM_MAX
VIH = getNumericD:
END IF
Message Hesrioie e
IF Yes=1 Label: Selected:
1dvd
END IF Button1  [Ves ERG =l
Message
i i =
e Button2 |l ER -]
Buton3 | EN =l
=] Buttona | = | |
. >

This example sets the following test flow:

Local Variables Definition

BLOCK
Message
IF Yes=1

Idvg

VG=getVectorData(“Vg”)
ID=getVectorData(*“Id”)

GM=getVectorData(“gm”)
GM_MAX=getVectorData(“gmMax’)
VTH=getNumericData(“Vth”)

END IF
Message
IF Yes=1
Idvd
END IF
Message
END BLOCK

| Defiles Yes variable

! Do you perform Id-Vg measurement?

! Classic test setup for Id-Vg measurement

! Do you perform Id-Vd measurement?

! Classic test setup for Id-Vd measurement

! Click OK to display VTH and GM_MAX values and end the test

For the example definition, open the Trng idvd idvg3 definition stored in the ¥data folder on the
Manual CD. The Manual CD stores the example test setup and definition data used in this manual.
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To Use Test Setup Internal Variables
Using built-in functions, result example

© Trog idvd idvg3 - Agilent EasyEXPERT N[E X
i i i Marker Cursor Line Window Help

Dacfd-BEREsE-H-FEl s

Setup Name: |Trng idvd idvg3 b4
KX GinapltRiol _Properties... | | [Parameters |
T% Agilent

(A) ) VTH 1.02693 V

im 1.5m
| | | | GM_MAX 112600 mS

= 2
100u

Jdiv

0 0

500 m V6 (V) 200 m/div 2
€] m | [
List Display Properties...
Index | vG | o G| ~
1 500 mV 300 fA -292.000000000... o
2 490 mv -2.53 pA 128,505
3 480 mv 218 pA  -2.99999900090... vl

This is a result example of the test output setup shown in the previous pages.
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Class Exercise
To use Auto Analysis twice

You will:

« Make two kinds of MOS threshold voltage (Vth) measurements

« Observe how the user functions and analysis functions are used in the
analysis

« Observe how auto analysis works twice

To Get Started:
« Use the standard MOS device and pin connections
« Get the Vth gmMax setup
« Open test definition editor
« Modify the definition for Vth measurement by using the constant
current method.

In this exercise you will observe how auto analysis works. You will understand each setup screen
required to implement an auto analysis process.
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To Modify Test Definition
Opening Vth gmMax test definition

category  +| @] Vth gmMax Setup Name: [th gmMax K
BT

e IDevll:e Parameters
1 w CMOS
Discrete Polarity: [Nch I} Lg: [100 nm ] wg: [10.0um ]
Exercise
GenericTest Temp: [50dsg 8] IdMax: [10.0 mA []

Justin

Memary v
3 W E—— | e
_
A Define Mew Test..

Open Definition of This Test 4
Delete Definition of This Test
Simple Vth Import Test Definition.. Drain: [SMU4HR =
Export Test Definition_
ﬁ eq 4 vd: [100mv B
Vth Const Id o
2 . Gate: [SMUZ:HR/: v Subs: [SMUS:MP v
Vih gmMax vgstart: [soomv 8] | % + vsubs: [0V B
% vgStop: [200V B %
Vih-Lg vgStep: [S0my B o
Source: sz;HRh hd
Sab %
vihwg

1. Select the CMOS category.

2. Open the Vth gmMax test definition.

3. Click the Library button.

4. Select the Open Definition of This Test... menu.

The test definition editor is opened with the Vth gmMax test definition.
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To Modify Test Definition

Setting properties of numeric variable

Vth emMax and Id

(Test Specification | Test Contents \ Test Output \

Test Information ]

1 Category: [MOs Sampe | Description: [ <langusgeCption lang="J

"
Vih gmidax: SRRESEREVER (A.01.20) + CIds S

Test Name: [vth gmMax and Id El

(]
Icon: [C¥Program Files¥AGIENt¥81S00¥EsYEXPERTYC Browse... | Clear MOSFET I Vo I MAFARIT - SHGARIEN HEC40, LEVER

[Device Parameters Definition |Fmperlies |

et | [osite| [oown |

-

Name: Default: Description: Min: |1 pA g

; — - — & Max: [10.00 ma 8
~ o w100 i ] [Gate Length = N
- [ s Hlfe v = Resolution:iA B
 [Temp mm[25.0 deg 8[Temperature El unit: [ -
o fioax =[1In0ms 8][Drain cunent compliance = | DopicalVakes.. | symbols..

[Test Parameters Definition ]

Background: [C:¥Frogram Files¥Agient#E1S00¥EasyEXPERTHC Browse .. @ Loyt T ™
Name: Type: Default: Description: Align: x: 4v ﬁ: f
LI e g v mjppos o 1= = L] = g
o~ [igtimit =fumeic | [100mA 8] [Gate coment compliance ElE ][ f BF 1
o [ubstimit mfmeic > [[i0.0ma 8|[substrate curent complance Eldl | f B|W
o JodTime  mlfmeic ~[os 8]JHod time o 7 f ] B~
o pelayTime  mllmeic ~[os 8] [Delay time o 7 || ] Il
o [orartirerg - mlfsting < |fine _~|[um range: for the drain curtent measurement & 17 | [ [ 11
2 ‘ & [davth &|umeric  ~[[1.000us 8|[prain curent to decice the th ® Voo 820 Ble0 BT l 3

1. Save the test setup as a new one. For example, save it as Vth gmMax and Id of the Exercise
category.

Click Add button to display the entry fields for the parameter.
2. Select the Id@Vth variable and the type of Numeric.
3. Set properties of the Id@Vth variable.
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To Modify Test Definition

Analysis function setup

AdcFactor = 8
ELSE IF IntegTime="M

Vth@gm, @Id ‘T”§|§‘
Eile Help
1 Test Specification | Test Contents frest output ‘
= = ] i
& 3 v 4 g
IV Sweep  Multi IV List IN-t CWSwesp  SPGU Switthing  Direct
Chanrell.. Swesp  Sampling Control Matrix ...  Control =
Program Component | Application Test | Analysis Classic Test | Miscellaneous | My Favorite Setup
z @ I/V Sweep Setup Name: [vth_gmmax )
. ?‘Dik Delste || Channel Setup | Measurement SE(UDI Function Sefup ] !um Analysis Setup | Display Setup |
—  Selection - L
E} user Function |
E|
2 [ W o=l e ] o]
Copy Cut Name: Unit: finition:
o fom s (idrain,Ygate) g
Local variables Defini =
BLOCK
L**%*% Integration T
IF IntegTime="SHORT"
IntegMode = "MANUA

IntegMode = "PLC"
AdcFactor = 1
ELSE IF IntegTime="L |Analysis Function

|
Mcraeror < 16 [ o W o o TN o]

END IF Name: Unit: Definition:
2 N | ¥
END BLOCK e fvan el | &
[ =V - | [vor-(vd"Poarityi2) |
4 o e = ] fmwx ]

K I ;Ij

1. Display the Test Contents screen.

2. Highlight the Vth gmmax line.

3. Click the function Setup tab.

4. Add the Analysis function. Set the following parameters.
<Name> <unit> <Definition>
Vth@ld V @MX

This is an analysis function setup example. This example uses the @MX function to get the X

coordinate value.
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Auto Analysis Setup
Auto Analysis Setup

rsﬁ] Classic Test ] Miscellaneaus ] My Faworite Setup

@| 1/ Sweep =
Charnel Setup I Measurement Setup ‘ Function Setupd | A0to Andlysis Setupf| Display Setup
W Interpolation Mode
Line 1 |
¥ Ensble | TV s
2 - € Mormal  Gradient & Tangent (" Regrassion Tl 2
Hint
€ %Y Coordinate & Data Condition
Check this box. Candition: [am = = fomhax [ after | =R =
Second Paint
@& % Coordinate " Data Condition
m | =2 v =
Line 2
iz
I~ Encble Type
B i ¢ Mormal & Gradient " Tangent ¢ Regression
First Paint
%Y Coordinate & Data Condition
Condition: | El = [ afer | ER El
Gradient
Gradient: &)
Marker
I Enable
Condition: ER B [ afer EN =

1. Click the Auto Analysis Setup tab to display the Auto Analysis setup screen.

2. Check the box to fix the Line 1. If the box is not checked, the line will be moved when the 2nd
Auto Analysis is done.

The 15t Auto Analysis is set in this slide.
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To Set Display Setup
.
Display Setup
@ 1/\ Sweep Setup Name: |\/th7gmr' El
Channel Setup] Measurement Setup | Function Setup ] Auto Analysis Setup | Display Setup I
Assigh to external variables... ‘
X-¥ Graph
wi | | | |
Name: Sharing: Scale: Min: Max:
W X |\.’gate j | J |Lmear j ‘Vgstart*Dnlarityy |\/g5tnp*Dn\arity E
¥l |I|:Ira|n j |(Nume) j |L\near j ‘DA E |IdMax*PUIanty E
vz |gm j |(Nume) ﬂ |L\near j ‘DS ﬂ |1Ei E
& ¥3: |Idrain j |(Nnme) j |Lng j ‘1E715*Pn\aﬂty ﬂ |IdMax*PnIaritv E
List Display Parameters
add | \ 2 | Add || Delate | |  w |
c [vgate 5 = o vth =l
« fvsource -] o |
© fwcrain B 3 [G [vthigtd j]
& |\/subs j
hd

1. Click the Display Setup tab.
2. Click Add button to display the entry fields for the parameter.
3. Select Vth@]d to display.
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Auto Analysis Setup
The 2" Auto Analysis Setup

Vth emMax and 1d 1

Eile

Help

Test Specification | Test Contents || Test Outuut}

i

Auto Pisplay Data Data Display 2
Analysis ) Setup Control

Program Component | Application Test] anah

55 |\Classic Test | Miscelaneaus | My Favarite Setup |

|Debug|  Edit

ook Insert Delete
selection

b
¥ Interpalation Mode

Copy Cut

Local Variables Defini =«
BLOCK
L***** Integratien T
IF IntegTime="SHORT"
IntegMode = "MANUA
AdcFactor = 8
ELSE IF IntegTime="M
IntegMode = "PLC"
AdcFactor = 1
ELSE IF IntegTime="L

IntegMode = "PLC"
AdcFactor = lo
END IF

LARERE ToV Sweep AAE
Vth_gmmax
Auto Analysis

END BLOCK

Idrain=Id@ Vth*Polarity

Line 1 ——
I™ Enable Type s
€ Mormal € Gradent ¢ Tangent ¢ Regression
First Point
& % Coordinate  Data Condition
| ERRa| =
Second Paint
€ X Coordinate € Dela Condiian
6 =R e
ine 2
I~ Enable Type s
" i @ Mormal € Gradient € Tangent ¢ Regression
First Foint
& %7 Coordnate € Dela Condiion
X o =
Second Paint
% Coordinate  Data Condiion
M| CR El
Marker
IV Enable
Cordition: [ldran | = [ld@Vth*Polarity = I afer | E- =

SN

Display the Test

Contents screen.

Click the Analysis Setup tab.

Highlight the Auto Analysis icon.

Hit Insert button.

Check the box of Interpolation Mode.

Check the box of Enable. Then enter Idrain=Id@ Vth*Polarity to find the constant current Vth.

The 2" Auto Analysis is set in this slide.
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To Use Auto Analysis Twice
Result example

th emMax and/1d [(1) . 2008/10/02 16-20-46] - Asilent EasyEXPERT
Fils Edit View Marker GCursor Line Text Pointer Window Help

QAKX 2 EEHHES @ I

Els

Setup Name: |Vth gmMax and Id [(1) ; 2008/10/02 16:20:46]

X

X-¥ Graph Plot

Properties... \

Parameters |

e

TE Agilent
MARKER( B S000000000E-001 Y 7.3868700000E-007 & 1.8957130000E-005 S ) vth W
n 1om
- Intercept: Intercept: gmMax 93150 us
5 -676.306 UA EIE
= Gradient: Gradient: =
S Em 5 S51500E-004 7 03 1500E-002 El vth@ld 550300 my
m u
fm
sm
4m
= am
g m
im
0 ol 640
Som -200m 0 200m 600 m 1 12 14 16 18 z
wgate (W) 200m fdv < | &
List Display Properties... \ |
Index_| vgate | Wsource wlrain | weubs | Ickain | gm | 4
-500.0 my oV 100.00 rny v 10.053 pA -62.44000000 pS
-450.0 my ov 100.00 Y v 6.921 pA -46.68000000 pS +

| >

This is a result example of using two times Auto Analysis shown in the previous pages.
Vth, gmMax and Vth@]Id are automatically calculated.
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Class Exercise

To Use Vector Data.
1. Open the Cgg-Vg test definition.

2. Modify it for the multiple frequency test using a
vector variable.

Use the debug tools.
Save the definition as a new one (ex. Trng Cgg-Vg).

Perform the test.

S

Export the new definition, and import it.

See the following pages which show an example to use a vector data. The Cgg-Vg test definition is
used as the reference of this example. The FREQ variable in this test definition will be changed from
the numeric type to the vector type.
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To Modify Test Definition
Opening Cgg-Vg test definition

Category =~ @J[ng—\lg Setup Name: [Caa-va ]
0 8IT _+||Device Parameters
v [ —
1 3 Disciote Polarity: [ch | Lg: (100 nm | wg: [100um  H|
[ Exercise =
WO GenericTest Temp: [B50deg 8]
[ Memary
[ MiedSignd x|
3 ‘ LI:-;; S Cancel Extended Setu___~
Linear = -
Open D nis Test...
is; St =ik
D
Cog-Freq
LDQL s - Subs
£ FREQ: [To0M: 8]
Cag-Vg E
“Freq L OscLevel: ED my il -
Ll
2 ¥ Gate: EMUI'MF -I
Cgg-vg s =
" YgsStart: |-2,mv iI
ﬂ VgsStop: E‘DD v iI
T pubser vgsstep: [10mv 8]
;
i.lﬁ
Tr-vid :J

1. Select the CMOS category.

2. Open the Cgg-Vq test definition.

3. Click the Library button.

4. Select the Open Definition of This Test... menu.

The test definition editor is opened with the Cgg-Vg test definition.
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)

1)

To Modify Test Definition

Setting properties of vector variable

Ting Cgg-¥g _ =10l
Test contents | Test Output |
[Test Information ]
Category: [Exereise | Description: [<languageOption lang="ja"> B
; Cgg-Vg: Cog-vgHytE (A.01.11) :|
Test Name: [Tma Cog-Va El E
MOSFETQVF — ME B{Coa)ERIE L. Cog-VoRIEE? 0y hT 3.
Icon: IC \Prooram Filest Aglent\B1500VEasyEXPERT\Gr Browse, Clear L‘

[Device Parameters Definition

[Properties \

Name: Default:

€ e 100 i
¢ [wa w00 um
¢ [temn =250 deg

[Test Parameters Definition

Background: [G\Program Fles\Ag 4
Name: Type:

€ [aate #[vodie v

Dim1Min:
Dim1Max:
Dim2Min:
Dim2Max:

Add Delete g Do
ive specified valu ;

Description:

e oty ElE

Close

Il

Min; [Infinity He
Max; [Infinity Hz

Digits: [
Resolution: |1 mHz
Unit: [z ~

—Iﬁymm‘g'

I messLremer g

¢ [vosstart  md[umerc ¥lf200v

"8 [oC bias start voltage

¢ [vasston md[numeic Floov

"B [oc bias stop voltage

¢ [vasster  ml[Numeric <1100 mv

"] |PC s sten valtage

€ [oscievel wl[numenc w50 mv

"B [veastrement signal level

& [FREQ =lvector ~Jfe]

"B [Meastrement frequency

=
=
=
=
=
=

~ InidTime = I +lin <

Bl fime

Layout.. Add Delete U Down

Align: X: % width:  Ext:

wloo @z ElEo w|r
S o o
o2 T T
e e o

[ T T LT | = |
[ T e = [

1. Save the test setup as a new one. For example, save it as Trng Cgg-Vg of the Exercise category.

2. Select the FREQ variable and change the type from Numeric to Vector.
3. Click the Dimension... button. The Define dimensions dialog box appears.
4. Set the dimension of the FREQ variable.

The example in this slide sets the one dimension and three elements vector variable.
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To Modify Test Definition

Setting vector data

Ting Cgg-¥g
File Help

Test Specification | Test Contents | Test Output |

Category: [Brerdse

Test Name: [Tma Cog-vg

arame Eig  Eie

1
1.000 MHz
2.000 MHz

Name:

© [Palarity

m‘m‘»-‘

(]
¢ [wa

Background

Name:
Gl 2 Ok | Caneel |

| Description: [<languageOption lang="ja"> f’ El
Cgg-vo: Cog-VoHitE (A.01.11)

[mZ]
MOSFETQY - M5 8(Con)EMEL. Cog-VoHTEE70vhT2.

[Properties ]

& specified valu ;

Up Do

s [y e ]
Digits: | B
Resolution: |1 MHz ]
wnittfe ]

Dimensian. Symbol..

measLremer &

c [vastart =
© [osston sfomenc xlloov "B [oc bias stop voltage =
o [vassten  w[Nuwerc ][00 mv T [oC b step veltage =
€ fosctevel wl[numenc) w50 mv "B [veastrement signal level El
& [rREQ ‘I "B [Meastrement frequency =

=l

ETT Bl fime

~ InidTime

Layaurt.. | Add Delete Up Down

Align: X: % width:  Ext:

wloo @z ElEo w|r
S o o
o2 T T
e e o
Pl &0 sl 8-

e e e el 2

1. Click the Grid button of the FREQ variable. The Define vector data dialog box appears.

2. Define the vector values for the FREQ variable.

The example in this slide sets the value 1 MHz, 2 MHz, and 3 MHz to the FREQ three elements

vector variable.
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Trng Cog-Vg

To Modify Test Definition

Using the at( ) function to read vector data

L***%% ADC/Integ ***
IF IntegTime = "MEDI
IntegMode = "PLC"
AdcFactor = 1
ELSE IF IntegTime

Start: [subsstart*Polarity 8
stap: [subsstop*Polarity B!
Step: [subsstep*Polarity B!

i ~=lolx=|
Hell
ITast Contents I Test Output |
="n O ® 8 A
BLOCK b3 LooP FOR  ASSIGN COMMENT  END ERROR
Frogram Cornponent: | Appication Test | Analysi | Gassic Test ] Miscelaneous | My Favorits Setup
= g‘ G-V Sweep Setup Name: [Cog-va =
e . E\‘“tk e Delote Channel Setup [Mestrament SStup ) Function Setup | Auto analysis Setup | Display Setup |
—_ Selection
E] -y Signal Source |
2 n Rangs
& v Name: [sibs = | Frequency a4 ek i B
copy cut Pasto Model: [5G 3] e
 [tFrEQLL B oy
St e - [FrE021) 8
g — | [FHFREG 2, .
Local variables Defini 4 s Nome: [5va = FName: [Freg El
BLOCK  [tFrEQ3D) 8
' Direction: [Single - AC Level: [Osclevel [

3

Integration Time

=] Factor: [adcFactor

* Sweep [CONTINUE AT ANY ~|status

5

Source:

IntegMede = "PLC" Noofstep: [ | | Mode: [integriode
AdcFactor = :‘LE Timing ‘
ELSE IF IntegTime =
IntegMode = "AUTO" Hold: [HoldTime 8| Delay: PelayTime 8]
AdcFactor = 6
END IF Constants
: Unit: V Name: 1Name: Mode:
VsubsStart = -VgsSta
VeubsStop = -VgsStop
= -vgsitep

VsubsStep
!

2

e o e
)

There is o item to display i tis area.

Compliance:

1. Display the Test Contents screen.
2. Highlight the Cgg-Vg line.

3. Click the Measurement Setup tab and set the Frequency List using the at( ) functions.
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Module 6
Creating Your Test Definitions

In This Module

*  What is Test Definition

*  What is Test Contents

* To Open Test Definition Editor
* To Define Test Specification

¢ To Define Test Contents

* Available Elements

* Available Variables

* To Define Test Output

This section explains how to create your test definition. You will perform the above tasks to create
the definition.
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Creating Your Test Definitions

What is Test Definition

Test Specification

*Test name *Multi display mode

*Test description *Variables

«Variables *Analysis parameters
*Device parameters *Test result display
*Test parameters *X-Y graph

*Entry fields *Data list

*Parameter display

*Local variables
*Test execution flow
*Test setup
*Classic test
Test Contents *Application test
*My Favorite setup

Test definition consists of test specification, test contents, and test output setup. The test
specification contains test name, description, device parameters, and test parameters. The parameters
will be the variables used to pass the test conditions to the test execution flow or test setup defined in
the test contents. Especially for the test parameters, you can specify the position of entry field for
each parameter. You can see the entry fields when the main screen displays this application test
setup. The test contents are the core of the test definition. You will define the local variables, test
execution flow, and test setup. You can define the test setup by selecting application tests, classic
tests, or my favorite setup, and entering the test conditions.

The test output setup is optional. If you have the following requirements, declare the analysis
parameters and define the display parameters on the Test Output tab screen.

-To send the test data to the subsequent tests

-To make the program branching depends on the test data

-To display/record the calculation result using the test data

-To display/record the test data of this application test

-To change the multi display mode of this application test

Note: You can use the device parameters, test parameters, and analysis parameters in the test
execution flow (program flow) of the test contents without declaration of local variables.

Note: If the multi display mode is Disabled, the all test result data will be displayed on the singular
Data Display window. Ifthe multi display mode is Enabled, the test result data of the same test setup
name will be displayed on the exclusive Data Display window and the test result data of the different
test setup name will be displayed on the new Data Display window.
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What is Test Contents

Test Specification Test Output

Variables
*Analysis parameters

Variables
*Device parameters
*Test parameters

Local variables

Program Component

Application Test

Miscellaneous

Test contents are the test execution flow (program flow), and is the core of the test definition. In the

test contents, the following elements can be defined.
*Local variables

*Program components

*Application tests

*Classic tests

*My Favorite setup

*Analysis components

*Miscellaneous components

*Device parameters defined in the test specification
*Test parameters defined in the test specification
*Analysis parameters defined in the test output

The program is executed from top to bottom in the test execution program list.
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To Open Test Definition Editor

File DataDisplay Help

Application Test

] GenericTest
] Memaory
[ MixedSignal |

Llnrﬂ v Cancel

Tl choose test categories from the left area.

st...
rof This Test...
tier of: This Test

Ia.!'

- o
Trng Idvd Delete Defi

o

@ Define New Test...

test object from the left area.

Vth
Import Test Definition. ..
ey

Export Test Definition.,.
A4
q‘r

Trng
Cgg-vg
8l
Trng idvd
idvg2
A2l

To start test definition, open the test definition editor.

Select the Application Test tab, click the Library button, and select the Define New Test... function.

The test definition editor will be opened. See next slide.
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To Define Test Specification

[ Bunded JT=TE
File_Help
Test Sperification | Test Conterts | Test Output |
Test Information
category: | [} Description: |Description of this test, BE|
et e oo | Set test information
Teon: | Browse... | Cear &

Device Parameters Definition Properties

Add Delete U Down

Name: Default: Description:

Set properties
To add a device parameter, press the [Add] button in this area,
of parameter
Define device parameters
est Parameters Definition
Bockgrdind: Sowse. | e | Layout., e W i

Name: Type:  Default: Description: Align: X: ¥: width:  Ext:

To add a test parameter, press the [Add] button in this area

The test definition editor provides three tabs, Test Specification, Test Contents, and Test Output. At
first define the test specification. Click the Test Specification tab.

In the Test Information area:
*Click the right button in the Category field to specify the category the new test definition belongs.
*Enter the Test Name.

*Select the Icon that will be displayed on the list area below the Library button of the main screen. It
is the image file used to select the test definition. See previous slide.

*Enter the Description of the test.
In the Device Parameters Definition area:
*Click Add button to display the entry fields for the parameter.

*Set the Name, Default value, and Description for the parameter. When you add a parameter, you
will see the entry fields at the Properties area. The area shows you the properties (minimum value,
maximum value, number of effective digits, resolution, and unit) for the device parameter or the test
parameter specified by the radio button put on the left of the parameter name.

For the Typical Values... button and the Symbols... button, see online help or User’s Guide.
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To Define Test Specification

[Bunried =IOl
File_Help
Test Sperification | Test Conterts | Test Output |
Test Information ]
category: | [} Description: |Description of this test, BE|
Test Name: [Untitled Cl
Teon: | Browse... | Cear B

Device Parameters Definition Properties

Add Delete Up Down

Name: Default: Description:

Set properties
To add a device parameter, press the [Add] button in this area,
of parameter
Test Parameters Definition
Background: Sowse. | e | Layout., e W i

Name: Type:  Default: Description: Align: X: ¥: width:  Ext:

To add a test parameter, press the [Add] button in this area

Define test parameters

In the Test Parameters Definition area:

*Select the Background that will be displayed on the application test setup area of the main screen.
Usually it is the image that shows the device connections.

Set the Name, data type, Default value, and Description for the parameter. When you add a
parameter, you will see the entry fields at the Properties area. The area shows you the properties
(minimum value, maximum value, number of effective digits, resolution, and unit) for the device
parameter or the test parameter specified by the radio button put on the left of the parameter name.

*Set the X, Y, and Width values to specify the position of entry field displayed on the application test
setup area.

*Check the Align box to set the X origin of entry field to the left edge of the entry field. Uncheck
this box to set it to the left edge of the parameter name placed left next to the entry field.

*Check the Ext box. The entry field will be put on the Extended Test Parameters dialog box that is
displayed by clicking the Extended Setup button on the application test setup area of the main screen.
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Setup example

1=k

File Help

Test Specification |Test Contents | Test Cutput |

[Test Information J

Category: IE}{EV[\;E ] Description: [This algorithm perfarms [d-vd measurement and Id-vig =
measurement, and then returns Vth value.
Test Name: [Tna idvd idvg =
Icon: [C:\Program Flest Agient\E 1500\EasyEXPERT\GY Browse.., | Ciear
I Bowse. | e | ]
[Device Parameters Definition [Properties ]
Add Delete Ug Down

Name: Default: Description:
¢ [pod ElB "8 o time =
¢ [pely =0 “8][pelay tme =

[Test Parameters Definition ]

Background: [C:\Program Fles\agient\B1S00IEas/EXPERTIGY Bowse... | Clear o e 5 e

te
Name: Type: Defauit: Description: Align: X: ¥: Width:  Ext:
B - s SFoeew R e e
o Jeate Evodie ][ SMUSHR =l for gate = Pl 8 sk 8- :I
c [poures E[vodds[SMUZHR =50 for source I I EE | X |
o Jus EModie =] SMULHP =l for s = FFEo B ER ®5C
© [ievd_vastartt_m[omenc=][1.000 "B gate start voltage 1= 2 T | e | ]
¢ fivd_vzstep ma[Nmerc =[50 mv “B[[idvd gate step voltage 1= I S | ] | e
~ bavd vonon wllaimens  <lla Bl imher of ctanc fr Trvd Uars & chin abn @k @8-

This example sets:
Category: Exercise (This category may be created by the class exercise in Module 5)
Test Name: Trng idvd idvg
Icon: MOSFET.bmp
Device parameters:
Hold and Delay
Background: Vth_Const 1d.PNG
Test parameters:
Drain, Gate, Source, Subs, Idcomp, Igcomp
IdVd Vlstart, IdVd Vlstep, IdVd Vlstop, IdVd V2start, IdVd V2step, IdVd V2nop
IdVg Vlstart, IdVg Vlstop, IdVg Vlstep, IdVg Vdrain
Vsource, Vsubs
Entry field properties: 80 (width) x 30 (distance in vertical direction)
Press the Layout... button to open the Define Layout dialog box.

6-8



Module 6

Creating Your Test Definitions

Setup example - Layout

Define Layout

File Edt “iew Align Distribute Centralize Tab Order

Idvg_Vistart: [-S00mv B Idvg_¥drain: |1I]EI '

£l

Idvg_Yistep: |10 mv B

Idvg_Vistop: 2000V B

0K | Cancel

Primary Entry Field

The Define Layout dialog box is used to define the layout of the test parameter entry fields displayed

on the application test setup screen.
The following methods are available for selecting the entry fields.

*Click on the entry field. Multiple entry fields can be selected by clicking on the entry field while
holding down the Ctrl key on the keyboard.

*Drag the mouse to draw a rectangle around multiple entry fields.
*Select Select All from the EDIT menu to select all entry fields.

The selected entry fields are outlined by the blue rectangles. The primary entry field, which is the
base for layout operations, is surrounded by a highlighted blue rectangle. Only one primary entry
field can be selected. To change the primary entry field, click on a selected entry field. The entry
field is always that was most recently clicked will be the primary entry field.

The following methods are available for releasing (unselecting) the selected entry fields.
*Click the selected entry field while holding down the Shift key on the keyboard.

*Click outside of the selected entry fields to release all selected entry fields.

The following methods are available for defining the layout of the selected entry fields.
*Drag & drop with the mouse to move the selected entry field(s).

*Change the X/Y values in the property window to move the selected entry field(s).
*Press the arrow keys on the keyboard to move the selected entry field(s).

*Use the functions in the Align menu to align the selected entry field(s) to the primary entry field.

*Use the functions in the Distribute menu to evenly distribute the selected entry fields horizontally or

vertically.

*Use the functions in the Centralize menu to move the horizontal or vertical center of all selected
entry fields to the horizontal or vertical center of the entry field area.

For more information, see online help or User’s Guide.
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Creating Your Test Definitions

Result example

Category _~| @[ Trngidvd idvg Sotup Name: [Trrg idvd idvg
Cor =l [peviceparameters

‘ﬁm Hold: 05 IO Delay: [0s ]

~ -

[ GerericTest

L] Mamory

Ol Miedsignd =]

= | |Test Parameters

H Idvd_v2start: |1.r.mv il

| TWV;M 1dvd_vastep: Fo0my 8]
ﬁ tavd_vznop: i 8|
C;g"_ﬂq Gate: fA5P =]
% Igeomp: [ioma &)

Trw 1dvg_Vistart: [S00mv 8]
ﬁ Idvg Vistep: [[Omv  #]
Trng dvd 1dvg_Vistop: 2000V 8]
dvg3
i Source: FETRIE] subs: TP 3]
Tn‘gg idvd vsource: PV ] e vsubs: PV ]

Tdeomp: Em il
:| Idvig_Vddrain: [100mv @]

v

N

T ™

This is a result example of the test specification setup shown in the previous pages.
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Creating Your Test Definitions

To Define Test Contents

[ Buniied -lofx|

File Help
Test Specification  Test Contents |TEEI outpu

B & & 0 O ® M O © A

BLOCK ~ OMERROR  FINALLY F LOoP FOR ASSIGN  COMMENT END ERROR

4. Select available element
Program Component Application Test | Analysis | Classic Test | Miscelaneous | My Favorite Setup
= SEEED
Block -
ek cion Inisert Delate.

= 5. Click Insert or
desired button A
1 e [T e s 2. Define the local variables used

BLOCK in this test contents
END BLOCK

abugl Edi

3. Specify the line
to insert element No Parameter Settings
or to be edited

6. Define the setup required for
the highlighted line (element)

Starting to define the test contents:

1. Highlight the Local Variables Definition line.

2. Define the local variables used in this test contents (test execution flow).
3. Highlight the line that an element has to be inserted.

4. Highlight an element of Program Component, Application Test, Analysis, Classic Test,
Miscellaneous, or My Favorite Setup tab menu.

5. Click the Insert button of the Edit tab menu. The element will be inserted between the highlighted
line and the next line.

6. Define the required setup.

To edit the test contents:

1. Optional. Highlight the Local Variables Definition line.

2. Optional. Define the local variables used in this test contents (test execution flow).
3. Highlight the line to be edited.

4. Highlight an additional element if you need.

5. Click the desired button if you need.

6. Define the required setup if you need.

Repeat this to create the test contents (test execution flow).
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Available elements

B A m n O ® H I © A

Mo ohEwA PN B 6 R aew cwer Do Gwe Program Component
= = 0 B ] ot

wiocr T e R W Application Test
Fwd Rev GummelPlot

——— 5

ks, (ol B iy Ana]ysm

Analysis Setup Control

v BB §

i o Classic Test
W B3 3 B .
” g s 030 e Miscellaneous
et croar s @ ==
- Bl wors e m‘;t v My Favorite

Available elements are shown above. The Program Component provides the typical program
statements such as IF, LOOP, FOR, and so on. They are used to control the test execution flow. The
Application Test, Classic Test, and My Favorite are used to define the test setup/test condition. The
Analysis provides the elements used to control auto analysis function and data display. And the
Miscellaneous provides other useful elements. For details of elements, see online help or user’s
guide.
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Available variables

Test Contents
*Local variables

Test Specification
*Device parameters
*Test parameters

Test Output
*Analysis parameters

Do not set the same name
for variables and
parameters. The name
must be unique.

I Assign to external variables... I

..................

e

You can connect the
variables in test setup with
*Local variables
*Device parameters
*Test parameters
*Analysis parameters

In the test execution flow (program flow), you can use the following variables.

*Variables defined by the Local Variables Definition component

*Device parameters defined in the Test Specification

*Test parameters defined in the Test Specification

*Analysis parameters defined in the Test Output

You may want to read the parameters/variables used in Classic Test setup or Application Test setup
defined in the Test Contents. Then use the External Variables Setup dialog box or built-in functions.
They can connect the test setup internal variables/parameters to the external variables listed above.
For the example variable connections, see “To Use Test Setup Internal Variables” in Module 5.

Note: Application test internal parameter/variable to be connected to an external variable must be the

analysis parameter in its test definition.
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Defining local variables

Local Variables Definition

@ Untitled BEX]
File Help
Test Specfication  Test Contents ‘Test Outuut‘
% *
2 A & n O B8 0 o A
BLOCK  ONERROR  FINALLY F Loop FOR  ASSIGN COMMENT  END ERROR
Program Component | Appication Test| Analyss | Cassic Test| Miscelaneous | iy Favarize Setwp |
= (|[ocal variables Definition statement ]
& Block Add Numeric | Add Vector | Add string | Add Module
e ecledion Variable Variable Variable Variable
5
“ Numeric Variable |
a
k Name: [lIUMD & value: [0 | Description: [ =
Vector Variable ]
Local Variables Defini =
BLOCK Name: [VECTO = Count:|1 'H| Description: | =
END BLOCK
@ Assign Linear Values FROM [0 # 10 [0 |
 Pssign Linear Values FRoM | i ster | Ol
String Variable |
Name: [STRD m Value: | = Description: | El
Module Variable ]
Name: 11000 - Description: =
8 —— ||

Add Numeric Variable button displays the Numeric Variable area that provides the following fields.

*Name: Numeric variable name

*Value: Initial value of the variable

*Description: Additional information for the variable

Add Vector Variable button displays the Vector Variable area that provides the following fields.

*Name: Vector variable name. Two dimensional array.

*Count: Number of elements, or array size

*Description: Additional information for the variable

This area also provides the following radio button used to specify how to set the initial value of the

array data automatically.

* Assign Linear Values FROM [value of first element] TO [value of last element]
If Count>1, this sets first value + (N-1) x (last value-first value)/(Count-1) to the N-th element. If

Count=1, this sets first value(=last value) to the element.

* Assign Linear Values FROM [value of first element] STEP [step value]
This sets first value + (N-1) x step to the N-th element.

Add String Variable button displays the String Variable area that provides the following fields.

*Name: String variable name

*Value: Initial value of the variable

*Description: Additional information for the variable

Add Module Variable button displays the Module Variable area that provides the following fields.

*Name: Module variable name

*Description: Additional information for the variable

6-14



Module 6
Creating Your Test Definitions

Editing test contents

€ Untitied . BEX]
File Help

Test SDE(ﬁ(at\nn Test Output |
B &4 & 0 O ® I A

BLOCK  ONERROR  FINALLY F LooP. FOR ASSIGN  COMMENT  END ERROR

oqram Component | Application Test| Analysis| Cassic Test] Miscelaneous | My Favorite Setup

BLOCK statement

Local Varisbles Defini =
BLOCK

2o socK *Block Selection
*Insert N
Delete
*Copy

*Cut

*Paste

B

The Edit tab provides the following buttons:

*Block Selection/Line Selection toggle button selects the edit target selection mode. In the line

selection mode, clicking line just selects the line. In the block selection mode, clicking line selects
the block the line belongs.

*Insert button inserts the specified element between the highlighted line and the next line.
*Delete button deletes the highlighted line.

*Copy button copies the highlighted line to the clipboard.

*Cut button moves the highlighted line to the clipboard.

*Paste button inserts the line in the clipboard between the highlighted line and the next line.
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Debug menu

© Untitled . REX]
File Help

Test SDE(ﬁ(at\Dn Test Output |
B &4 & nn O ® I A

BLOCK  ONERROR  FINALLY F LooP. FOR ASSIGN  COMMENT ~ END ERROR

3
i

anent [ Application Test | Analysis| Cassic Test | Mscelaneous | 1ty Favortce Setup |
BLOCK statement

£

Debuz | Edit |2

Break

20 Bnock Run
.Abort No Parameter Settings
*Stop
*Break
*Inspect
p——

The Debug tab menu provides the following buttons:

*Run button starts the debug (executes the test flow). During execution, the label changes to Pause.
Clicking Pause button pauses the execution, and changes the label to Run that is used to continue the
debug (execution).

*Abort button aborts the debug (execution).

*Step button executes the highlighted line of the test flow. Clicking the button repeatedly continues
the execution by a line.

*Break button sets/releases the break point. For the break point, this button releases the break point
from the highlighted line. Program execution will break at the break point automatically.

Inspect button is available when the debug (execution) is paused or broken. This button opens the
Variable Inspector used to monitor value of device parameters, test parameters, analysis parameters,
local variables, or system variables.
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Class Exercise

Create test definition and perform test.
. Open test definition editor.
. Define Test Specification (see previous page)
. Define Test Contents shown below.

1
2
3
4. Save the definition as Trng idvd idvg.
5
6

. Use debug tools to check the definition. SMU4

. Connect device, and perform test. SMOHF s
SMU1

SMU2

Test Contents:

Local Variables Definition
BLOCK
IDVD
Message
IF Yes=0
END
END IF
GMMAX
END BLOCK
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Test Definition E 1
€ Trng idvd idvg Lok
File Help
Test Specfication  Test Contents | Test Dutwtl
& 1 ] ] ] = ] 5
3 9] g g ] ] g T
rectoro: | {8 ] A O 4 4 4 4 4 4
Demo = 1d-vd VD RVR Paralle! REKELY  Parallel-ifvm Zero-check Zero-che... VG VG-t
Program Component | Application Test | Analysis| Chssic Test | Mscelaneous My Favorite Setup
= @|1/V Sweep Setup Name: [IDVD =
Mook nsert Delete || Channel Setup Measurement Setup | Function Setup | Aute Analysis Setup | Displey Setup
Selection
o [var1 [var2 |
2 Range
8 Units [SH0: 8| 50 9
Copy. Cut Name: ,‘m Vg ADC/
i Single = integ
Local Variables Defini =
— i Log: [LINEAR - Ad-
BLOCK mear/Log vanced
IDVD start: fiove_viseart 16vd_vastart
?isizg: stop: [1dve_viston iah v 8 .
END Step:‘ dVd_V1step Tdvd_Vastep — Varlables
END > No of Step: [liall B|[i5vd_vanop
END BLOCK ‘Compliance:| dcomp Tacomp
Pwr Comp: |OFF B|[oFF ]
[Timing
Hotd{ o o |
[Constants I
Unit: V Name: I Name: Mode: qurce: Compliance:
[smufsubs | &j[vsib = [1sub =V [Vsubs 100 mA [
! |[smufsource | &j[vs i =V @|vsource Ja][100 ma |
4 3

Use IDVD and GMMAX in the Demo preset group (My Favorite Setup) for the test setup.

Use the variables defined in the Test Specification to set the Unit on the Channel Setup, the source
values on the Measurement Setup, the Min and Max values on the Display Setup, and so on.

For the example definition, open the Trng idvd idvg definition stored in the ¥data folder on the
Manual CD. The Manual CD stores the example test setup and definition data used in this manual.
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© 10VD [(1); 12/15/2006 7:37:43 D] - Agilent EasyEXPERT BE=]
File Ed‘ﬂ‘i’” Marker Cursor Line Window Help
HEErEaQld@ EEHRHEE-F-A8cs
Setup Name:  [IDVD [(1) ; 12/15/2006 7:37:43 PM] x
[x-¥ Graph Plot Properties... |rarameters ]
3% Agilent
& MARKER( 1.500000G0DOES000 Y 2 3554000000E-005 & - ) Tdrain  [33584 uA
50m
© GUIAX [(1) ; 12/15/2006 7:37:59 PM] - Agilent EasyEXPERT BE=|
File Edit View Marker Cursor Line Window Help
S 7‘7 H S ol o Il © = ool =
ETE DR Q- [ e e - FA- F
- [ =LY X
S0 (XY Graph Piot Properties... | | [Parameters ]
Agil
% ﬂo " e v ¢ } o | v sy
0 067.. 100m
Intercapt: Intercept: BETA  [5.03475E-003
0 vd (V) 200 ;ﬁﬁ‘f‘ gﬂ:ﬂ
o S 5108teE-002 20m7295E-002
[t Dispiay 2 il
Index_| 7 v & -
i v (K] 70.6
# 1v 30 mv 10.868|
3 iv 60 mv 16.424120.0 m
= E =
i Intercept: i
500 m Vo (V) 200 m/div 2
List Display Properties...
Index | Vg SORT Id | PEAK| o
1 -500 mvV  064.365076099...  174.303219803... b=
2 490mV  2,70739727413...  79.257234034...
3 S0y 2a00To0n. 792 00RN0 Y B

This is a test result example displayed on the Data Display window.
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Trng idvd idvg
Fis Help

Test 5Demﬁ(allnn| Test Contents| Test Output ‘

1 |¥ Define own Dutput Parameters =% I

To Define Test Output

2. Define the analysis parameters

Define Analysis Parameters

Allocate Data Display for each test: [Comply with above level = 6. Select the multi displ ay IJ‘ ode

[%-¥ Graph

Name: Sharing:

Add Delete Up Do
Min: :

=] [ere) =] Jonear

Max:
=P IRz g

To add a V-axis parameter, press the [Add] button in this area

3. Specify X axis and Y axis

[List Display

[Parameters

Add Delete Up Do

To add 2 parameter, press the [Add]
button in this area.

Aild Delete Up D

To add a parameter, press the [Add]
button in this area

Bl x|

Comply with above|level
Enable
Di§able

4. Select variables to list 5. Select parameters

to display

The test output setup is optional. If you have the following requirements, define the analysis
parameters and set the display parameters.

-To send the test result data to the subsequent tests in an application test

-To make the program branching depends on the test result

-To make the calculation using the test data in the Test Contents

-To display/record the test result of this application test

-To change the multi display mode of this application test

To define the test output:
1. Check the Define own Output Parameters box.

2. Click the Define Analysis Parameters... button. And define the analysis parameters on the
Analysis Parameter Definition window.

3. Specify X axis and Y axis of the X-Y Graph of the Data Display window.
4. Select variables to list in the List Display area of the Data Display window.
5. Select variables to display in the Parameters area of the Data Display window.

6. Select the multi display mode using the Allocate Data Display for each test pull-down menu.

Note: If the multi display mode is Disabled, the all test result data will be displayed on the singular
Data Display window. If the multi display mode is Enabled, the test result data of the same test setup
name will be displayed on the exclusive Data Display window and the test result data of the different
test setup name will be displayed on the new Data Display window.
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To Define Test Output
Analysis Parameters

| Define Analysis Parameters...

:

Analysis Parameter Definition

Vector Parameters

Name: Unit: Description

c |ve EIN _r|[gate vorrage i
e o ElB _x|[prain current =
[T =|s = |[Transconductance =
& [GH_MAx = = |[Maxmum Transconductance =

Scalar Paramters

|

Name: Unit: Description
& [vmH =V _=|[Threshoid Volrage =
_ dose |

Define the analysis parameters as shown below:

At the Vector Parameters area or the Scalar Parameters area:

1. Click the Add button.

2. Enter the Name, Unit, and Description of the parameter.

For the sweep output/measurement data, use the vector parameter.

For the spot output/measurement data, use the scalar parameter.

For the data given by the max( ) and min( ) built-in function, use the vector parameter.

In this example, VG, ID, and GM are the vector parameter and VTH is the scalar parameter.
GM_MAX is the vector parameter because the max( ) built-in function is used to calculate this value.
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Creating Your Test Definitions

To Define Test Output
Display Parameters

@ Trog idvd idvg? B@
File Help
Tast Specification | Test Contents Test Output

¥ Define own Output Parameters

[X-Y Graph

Name: Scale: Min: Max:
P ox [® = [ =] [vovomr 8] [dvevems &

c v [o | [tnear | o & [Tma 8
covx o fon | [tnear =l fos & [lsms )

List Display Parameters

| o N o ] | o W el ]

- e ~ e [vm ~
c o v ¢ [aMmAx ~

o Jam 5

This example sets:

X-Y Graph: ID-VG plot for Y1-X graph and GM-VG plot for Y2-X graph
List Display: VG, ID, and GM

Parameters: GM_MAX and VTH

All parameters must be defined in the Analysis Parameter Definition window shown in the previous
slide.

The X-Y Graph area is used to set the X axis and Y axis of the X-Y Graph Plot area on the Data
Display window.

*Name: Name of variable to plot on the X axis
*Scale: Linear or Log

*Min: Minimum value of the specified axis
*Max: Maximum value of the specified axis

The List Display area selects the variables to be listed on the List Display area of the Data Display
window. Up to 20 variables can be set.

The Parameters area selects the variables to be listed on the Parameters area of the Data Display
window. Up to 20 parameters can be set.
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Module 7
Advanced Definitions and Operations

In This Module

To Control External GPIB Devices
* To Call Execution Files

* To Perform Repeat Measurements
* Prober Control Script

*  Thermo-trigger
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Advanced Definitions and Operations

To Control External GPIB Devices

Miscellaneous: GPIB 1/0

Write String  to send a string command to GPIB device
Write Value  to send a command to GPIB device
Read String  to read a string value from GPIB device
Read Value  to read a numeric value data from GPIB device
Read List to read a vector data from GPIB device
Read STB to read status byte of GPIB device
GP-IB Control Group Execution Trigger

Device Clear

Go To Local

Local LockOut

You can control external GPIB devices from the EasyEXPERT by using the GPIB /O statement.

The GPIB 1/O statement provides the write/read functions shown above. Select a write function and
enter the necessary parameters to send a command to the GPIB device. Select a read function and
enter the necessary parameters to read response from the GPIB device. For details, see online help or
User’s Guide.

The followings are the GPIB Control functions.

*Group Execution Trigger: Sends a trigger to the specified GPIB device.
*Device Clear: Sends a device clear to the specified GPIB device.

*Go To Local: Returns the specified GPIB device to the local state.
*Local LockOut: Locks the specified GPIB device.

Note: Before starting, enable System Controller. See Module 8. Also establish the GPIB connection
with the external GPIB devices.
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To Control External GPIB Devices

Agilent B2200 control example

To send command (evemw
File Help

E|W B =

GFBUO| Message Command Data Store
Execution  Control

Program Component | Application Test| Analyss | Classic Tesg w;(euanenusl
n Function

Lo&

Programming image:

Run

*RST
:ROUT:FUNC ACON

3
i
o
2
8 Bk

© write String
© Read String

GP-IB Control

l & write Value l

© Read Value

© Read List

© Read STB

. Local Variables Defini A ¢ Group Bxecution € Device Clear € GoToLocal € Local LockOut
(enters “SMU1” to StringPort) BLOCK e
» » Gpib( 'Write' )
:ROUT:SYMB:PORT {0},”{1} Coib( 'Write' ) Write Vaie
StringPort = "SMU1"

:ROUT:SYMB:PORT? {0} Gpib( mritat ) o TR &

. Gpib( 'Write' )
(reads string data) GEibY SHeads § Formats  [FOUTSYIBGHAR (93,020, (17 |
*OPC? o B Valve1:  [Gareio CI Tl T —
(reads operation complete flag) L v [ 8 vaes | H

GP1b (
Gpib (
Gpib( 'Write' )
Gpib( 'Read' )

END BLOCK

‘Write' )
'Read' )

(enters “OUT1” to StringCh)
[:ROUT:SYMB:CHAN {0},{2},"{1}"
:ROUT:SYMB:CHAN? {0},{2}
(reads string data)

*OPC?

(reads operation complete flag) |L« 1

Valuel — {0}
Value2 — {1}
Value3 — {2}
Value4 — {3}

M

This slide shows an example setup of the GPIB /O statement. This is a component of the test
contents used to control the Agilent B2200 switching matrix.

This example uses the Write Value function to send the following command to the B2200.
:ROUT:SYMB:CHAN {0},{2},”{1}”

where, {0} is CardNo, {1} is StringCh, and {2} is ChanNo.

The followings are the reference of the setup editor.

*Address: GPIB address of the device

*Terminator: EOI, LF, CR/LF, LF+EOI, CR/LF+EOI, or NONE (no terminator)
*Format: Command (header and parameters) sent to the device

*Value 1: Value for {0}

*Value 2: Value for {1}

*Value 3: Value for {2}

*Value 4: Value for {3}

{0}. {1}, {2}, and {3} are variable available in the Format field only.

Note: Use double quotes to enter a string to a local variable by using the Assign statement.
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To Control External GPIB Devices

Agilent B2200 control example

TO l'ead data © TestB2200 [m=)]X]
File Help
Test Specification  Test Contents ‘rm outpue|

Bl B =

GFBI/O| Message Command Data Store
Execttion  Control

Program Component | Appication Test | Anafyss | Cassc Teg wsze\lanenusl
Function

Programming image:

i © wWrite string © write Value

*RST g sreak § | & Read String | © Read Value © Read List © Read STE
:ROUT:FUNC ACON _Local Variables Defini = GHE c‘::‘::lmﬂmﬂ"  Device Clear © GoTo Local € Local LockOut
(enters “SMU1” to StringPort) BIOCK M

:ROUT:SYMB:PORT {0},"{1}" Stk waiten _—_.

:ROUT:SYMB:PORT? {0} eyt W T
(reads string data) o ey N e —

*OPC? ‘;iﬁjﬁ :ﬁ;ﬁ?’ )) LengthToRead: [10 8| Length Actually Read:  |Lengthil ]
(reads operation complete flag) Bnata TR Terminator:  [FEOL ] Terminated: C—
(enters “OUT1” to StringCh) e e »

:ROUT:SYMB:CHAN {0},{2},"{1}"|| [ T 0 T

:ROUT:SYMB:CHAN? {0} {2} END/BLOCR
((reads string data)

*OPC? 2

(reads operation complete flag) [l | £

This example uses the Read String function to read the response from the B2200. This example
reads the :ROUT:SYMB:CHAN? query command response. The result (ReturnCh value) must be
OUTI.
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To Call Execution Files

Miscellaneous: Command Execution

© Wait Lo
File Help

(@] = :
GFBUO  Message [Command Data Store |
Execttior

Control

Program Component ] Appication Test ] Analyss] Ciassic Test] Miscellaneous

= [Windows Command Execution ]
Block

Selection

Insert Delete

Command Filename: |C:\Program FiestAgiant|B1500\EasyEXPERT \Utlties\sleen. exe =

|Debug|  Ed

ar Argument: I =

2

Local Variables Defini 4| Write Type: " string @ List
BLOCK
. Read Type: © string @ Value € ust © None
Command (_'sleep' L) WD
Bisplay Data Setup T
END BLOCK

Values: [T -1 Specifies vector variable or
el string sent to the exe file. =
#eaﬂvahle
Result:  [Passfal - Value: [Retumiabe <] \

Specifies variables used to receive execution
results or output data. This area is deleted
by Read Type: None.

A\ J

by

You can call the execution file (EXE file) from the EasyEXPERT. Use the Command Execution
statement and define the setup editor as shown in this example.

*Command Filename: Execution file name (command name)

*Argument: Command parameter or argument

*Write Type: String or List (vector data)

*Read Type: String, Value (numeric data), List (vector data), or None (no read data)
If you specify Write String, enter the string sent to the command.

If you specify Write List, enter the name of vector variable sent to the command, and specify the
format of data element sent to the command. See next slide.

In the Read String/Value/List area, specify the variables used to receive execution result and output
data. There is no entry field for Read Type: None.

*Result: Numeric variable name. Used to store the execution result.

*Value: Numeric variable name for Read Value, or vector variable name for Read List. Used to
store the returned data.

+String: String variable name. Used to store the returned data.
*Length Actually Read: Numeric variable name. Used to store the byte length of the returned data.

The above example calls the sleep.exe file used to insert the wait time for program execution. The
WAIT value must be defined in msec. After the normal command execution, the sleep.exe returns 1
for Value and O for Result. The sleep.exe file is stored in the following folder.

C:¥Program Files¥Agilent¥B1500¥EasyEXPERT¥Utilities

1-6



Module 7
Advanced Definitions and Operations

To set Format field

ULA]:F]

L | List data index. Or index of element. Integer.

c A Character length of the specified data element.
Positive integer for right-aligned, or negative
integer for left-aligned. Optional.

* F Format identifier. C, D, E, F, G, N, P, R, or X.
Lower case is available. Optional.

Example:

{0,5:E} First element, 5 characters, exponential notation.
{1:G} Second element, general.

{2,10} Third element, 10 characters, general.

The Format field is used to specify the data format of List (vector variable). The strings shown in the
above example can be defined in the Format field.

In the strings, the list data index is mandatory. The character length and format identifier are
omissible. Then the length is not limited, and the format G is set.

Cor c: Circulation

D or d: Decimal numeral

E or e: Exponential notation
F or f: Fixed point

G or g: General

N or n: Numeric

P or p: Percent

R orr: Round trip

X or x: Hexadecimal numeral
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Exercise

Try to improve your test definition as you want.

* To Use Built-in Functions
* To Use Read Out Functions
* To Control External GPIB Devices

* To Call Execution Files
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Start (Run)
Repeat Procedures Count=0
Slarl Pruvedure:
[C¥Program Files¥Agilent¥B 1500¥EasyEXPERR] | Erowst... | | Start Procedure | |
Anqumentf.:l H
Iteration Procedura:
C:¥Program Files¥Agilent¥B1500¥EasyEXPERE ~ Browse...
Arguments: | =
Final Procedure:
|C:¥Program Files¥Agilent¥B1500¥EasyEXPERE|  Biows... |
Arguments: .
I = @——> | Test Execution |
¥ Automatically fill in Device ID I
o Ioney | Count=Count+1 |
I Enabled Thermo-trigger N1265A Thermo-trigger List.. | - I
| | Iteration Procedure | |
Rapeat Stop Condition | -
' —— T
Stop repeating by: 1
¥ Counter reaching to:  [5 ﬂj

> Reset counter before repeating | Yes |[&—m
Canczl

| | Final Procedure | |

[ Procedure retirn condition |

|
[ 1f Abort is clicked } {

I

Count is set to 0 when repeat measurement is started.

Repeat measurement is performed as shown in this flowchart. The status is a response returned by
the start/iteration procedure. The Count is the accumulated number of test executions. They are the
stop condition of the repeat measurement.

The repeat measurement stop function is enabled by the following check boxes.
*Counter reaching to
*Procedure return condition

If the first box is checked and the limit value is specified, the repeat measurement will be stopped if
Count >= limit. To perform the repeat measurement, set the limit value more than the number of
devices under test or remove check from this box.

If the second box is checked, the repeat measurement will be stopped if status = True.

When the second box is checked, the device ID automatic setup function is available and is
enabled/disabled by the Automatically fill in Device ID check box. The function enters the
device_id value to the Device ID of the test result record. The device id is a response returned by
the start/iteration/subsite procedure.

The Repeat Measurement Setup dialog box provides the following action buttons.
*Run: Starts repeat measurement.

*Abort: Stops repeat measurement immediately.

*Cancel: Closes the Repeat Measurement Setup dialog box.

Start/Iteration/Final Procedure:
Enter the full path name of the procedure. For example, enter as follows.
C:¥Program Files¥Agilent¥B1500¥EasyEXPERT¥Ultilities¥ProberControl¥suss¥Start _suss.exe

Arguments:
Enter the options of the procedure. See the following pages describing about procedures. For
example, enter —a GPIBO0::5::INSTR -1 C:¥temp¥prb.log.

For the sub die move operation (subsite procedure), see page 7-18. Flowchart is changed.

For the Thermo-trigger, see page 7-19.
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Subsite move Test Setup

category - | g Subsite move |setup Name: |Subste move C | ,ﬁ
Memary -~ |Device Parameters
— =
NaneTech
Reliability Count: |0
Structure Device ID:
TFT —_

w Utility w

| Library 'I Test Parameters

23, ProberType: [BEcdaNBwE <]
L]

| Tmggm
Suss Microtec
Vector Semon
. CustomProber;
Trng gmir
. Specify ProberType.
Tl e Or specify driver for your prober in
. CustomProber.
V';
Trng gm | .g
classic auto SWM-open

a “ gor
Subsite frices 4
moye - | m-out-1-7
|

If you do not use the sub die (subsite) move operation, skip this page.

Click Application Test tab and open the Subsite move test setup in the Utility category. On the
Subsite move setup screen, specify ProberType (Cascade, Suss, or Vector) or driver for your prober
in CustomerProber, and save it as a setup in your preset group (My Favorite Setup). Then you can
use the setup for your quick test. See next page.

The Subsite move setup moves wafer chuck to the next subsite, reads device ID from the prober, and
sets it to the Device ID of the test result record.

For more details of the test setup, open the Test Definition window.

In the Subsite move test definition, an execution file callProbeDvr.exe is used. This file is used to
send Subsite xxxx.exe to the prober specified by the prober info.ini file and receive the response;
status and device id. The callProberDvr.exe has the following input/output parameters.

Input: Full path of Subsite xxxx.exe
Output: status; True (break) or False
Output: device_id

Note: The callProberDvr.exe refers to the prober info.ini file for the GPIB address and log file
name. Do not set the Arguments of Subsite xxxx.exe.
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To Use Subsite move

[my Favorite Setup  ~

“ Preset Group: |TRIG g <
| Setap tome
j idva - Repeat Procedures
— Slarl Procedure:
E Id-vd [C:¥Program Files¥Agilent¥B1500¥EasyEXPERS  Erowse... |
B et =

Iteration Procedure:

|C:¥Program Files¥Agilent¥B1 500¥EasyEXPE§ Browse...
Arguments:| E]

Final Procedure:
|C:¥Program FiIes¥AgiIen!¥B1500¥EasyEXPE@ Biuwse... |
Arguments:| =

~ Automatically fill in Device ID

Thermo-trigger

I Enabled Thermo-trigger N1265A Thermo-trigger List...

Repeat Stop Condition | un

Stop repeating by:
¥ Counter reaching to: |5 2l LI

[¥ Reset counter before repeating ‘
Cancz

[# Procadure return condition

If you do not use the sub die (subsite) move operation, skip this page.

To perform the test with the sub die move operation, do as follows.

AN

Start repeat measurement.

Add the Subsite move test setup to your preset group (My Favorite setup).
Set your preset group and test setups in the Quick Test tab screen.
Open the Repeat Measurement Setup dialog box.

Specify the procedures and the repeat measurement condition.

The Subsite move setup must be entered after measurements for a sub die.
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Prober Control Script

* Prober information file Use prober control script in EasyEXPERT
prober_info.ini Repeat Measurement Setup window

« Start Procedure
Start_xxxx.exe

e Iteration Procedure
Iterator_xxxx.exe

Final Procedure
Final xxxx.exe

Subsite Procedure
Subsite xxxx.exe
Xxxx: ° cascade

¢ suss

* vector

Prober control script is sample program used for semi-automatic prober control. The Agilent
EasyEXPERT can call the script by using the Repeat Measurement Setup window.

See page 7-9 to call the script and perform repeat measurement.
See page 7-14 for the prober information file.

See page 7-13 for the start procedure.

See page 7-15 for the iteration procedure.

See page 7-16 for the final procedure.

See page 7-17 for the subsite procedure.

To use the prober control script, specify the start/iteration/final procedure in the Repeat Measurement
Setup dialog box (see page 7-9). And use the Subsite move test setup in your quick test to control
sub die move. The Subsite move setup uses the subsite procedure for moving wafer chuck to the
next subsite. See page 7-10 and 7-11.
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Start xxxx.exe

-
* Arguments: -a GPIB_address

-1 log file name | Displays Device ID Entry dialog box |
- - I
Example: | Updates prober_info.ini file |

—a GPIB0::5::INSTR -1 C:¥temp¥prb.log
* Response: XML format data

I
Displays Start Confirmation dialog box

I
| Moves to the first position |

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response> Gets X-Y coordinate
stat.us: . True (break). or False
device_id: prefix:coordinate
Example: | Ch”ik up
I

<Response> |
<Break>False</Break>

<Target>waf1a:3 1</Target>

</Response>

Returns response |

To specify the start procedure in the Repeat Measurement Setup dialog box, enter the full path name
of Start xxxx.exe into the Start Procedure field.

After the repeat measurement is started, this procedure displays the Device ID Entry dialog box and
waits for your input. On the dialog box, enter a string used for the prefix of device id. After that,
you will see the Start Confirmation dialog box that is used to confirm your wafer setup status. Load
wafer and perform wafer alignment, then click OK on the dialog box. The procedure moves wafer
chuck to the first probing position, checks the prober status, gets the X-Y coordinate of the probing
position, and sets the wafer chuck to the UP position. At last, the procedure returns the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When
the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the
repeat measurement will be stopped if status = True.

The device _id is a string for the Device ID of the test result record. When the Automatically fill in
Device ID box is checked in the Repeat Measurement Setup dialog box, the device id will be entered
to the Device ID of the test result record.

For the sub die move operation (subsite procedure), see page 7-18. Flowchart is changed.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.

7-13



Module 7
Advanced Definitions and Operations

Prober_info.ini

[Prober]
Address=GPIB::5:[INSTR —— GPIB address of prober
LogMode=True

LogName=C:¥temp¥prb.log — Full path name of log file

[Target]
UselD=True »device_id = prefix:coordinate
Subsitelnfo=False |

Wafer‘nfo=FaIse <Response> £
ID @ <Break>False</Break>

i <Target/Target>

</Response>

ou enter in the Device ID Entry dialog box.
ID is automatically recorded in the prober_info.ini file.
The Device ID Entry dialog box is opened by Start xxxx.exe.

The prober information file is necessary to execute the prober control script. Before starting tests,
open this file, edit it as you want, and overwrite it. The name must be prober_info.ini.

The prober _info.ini file stores the information shown below.
*Address: GPIB address of prober

*LogMode: Log file creation mode; True or False

*LogName: Log file name (full path)

*UselD: Device ID creation mode; True or False

*Subsitelnfo: Set always False. This is just a place holder.
*WaferInfo: Set always False. This is just a place holder.

*ID: Ignore this variable. This is just a pass parameter.

If the procedures specify the —a option, the Address value is not used.
If the procedures specify the —1 option, the LogName value is not used.
To create a log file, set LogMode=True.

To use the prefix:coordinate format for the device id value, set UseID=True. If UseID=False, the
device_id value will be coordinate, not prefix:coordinate. The prefix will be the value entered in the
Device ID Entry dialog box that is opened by Start xxxx.exe. This function is available when the
Automatically fill in Device ID check box is checked.
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Iterator xxxx.exe

* Arguments: -a GPIB_address
— Chuck down |

-llog _file name |
_a GPIB0::5::INSTR -1 C:¥temp¥prb.log
No

* Response: XML format data | Moves to the next position |

<Response> Prober error?
<Break>status</Break> ‘
<Target>device_id</Target>

Gets X-Y coordinate
</Response> . '

status: True (break) or False
device_id: prefix:coordinate

Example:

Yes
Prober error?

| Chuck up
Example: |
<Response> | Returns response |
<Break>False</Break>
<Target>waf1a:4 1</Target>
</Response>

To specify the iteration procedure in the Repeat Measurement Setup dialog box, enter the full path
name of Iterator xxxx.exe into the Iteration Procedure field.

The procedure is called after the measurement is completed for a die. This procedure sets wafer
chuck to the DOWN position, moves it to the next probing position, checks the prober status, gets the
X-Y coordinate of the probing position, and sets the wafer chuck to the UP position. At last, the
procedure returns the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When
the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the
repeat measurement will be stopped if status = True.

The device _id is a string for the Device ID of the test result record. When the Automatically fill in
Device ID box is checked in the Repeat Measurement Setup dialog box, the device id will be entered
to the Device ID of the test result record.

For the sub die move operation (subsite procedure), see page 7-18. Flowchart is changed.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Final xxxx.exe

* Arguments: -a GPIB_address
-llog _file name
Example:

* Response: none

( Start )

| Chuck down |

End

Stop condition ———

—a GPIB0::5::INSTR -1 C:¥temp¥prb.log

Hepeat Measurement Setup

Repeat Procedures

Slarl Procedure:

[C¥Program Files¥Agilent¥B1500¥EasyEXPER] Erowse...
Arqumants:l !

Iteration Procedure:
|C:¥Program Files¥Agilent¥B1500¥EasyEXPERE  Browse...

Arguments: =

Final Procedure:

|C:¥Program FiIes¥Agi\ent¥B1500¥EasyEXPEE Browse... |
Arguments:| =

[+ Automatically fill in Device ID

Thermo-trigger
I Enabled Thermo-trigger N1265A Thermo-trigger List...
[Repeat Stop Condition \ n

Stop repeating by:

i Abart
¥ Counter reaching to: |5 C] !

¥ Reset counter before repeating
Canczl

i

¥ Procadura return condition

7

To specify the final procedure on the Repeat Measurement Setup dialog box, enter the full path name

of Final xxxx.exe into the Final Procedure field.

The procedure is called after one of the stop condition is detected. This procedure sets wafer chuck

to the DOWN position.

Note: To ignore the Arguments, set the GPIB address and log file name in the prober_info.ini.
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Subsite xxxx.exe
-

* Arguments: -a GPIB_address
-1log_file name | Chuck down |

Example: -
—a GPIB0::5::INSTR —1 C:¥temp¥prb.log
No

* Response: XML format data

[ Moves to the next subsite |

No

| Gets X-Y coordinate |

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response>

status: True (break) or False

device_id: prefix:coordinate

Chuck
Example: | U(|: — |

|
<Response> | Returns response |

<Break>False</Break>
<Target>waf1a:3 1</Target> End
</Response>

To realize sub die move operation, you need to define Subsite xxxx.exe in your test definition and
create your application test setup. However, you do not need to take care of this procedure by using
the Subsite move test setup included in the application library. The Subsite move setup moves wafer
chuck to the next subsite, reads device ID from the prober, and sets it to the Device ID of the test
result record.

Open the Subsite move test setup and save it as a setup in your preset group (My Favorite Setup).
Then you can use the setup for your quick test.

Note: To use the Subsite move setup, set the GPIB address and log file name in the prober_info.ini.
And ignore the Arguments for Subsite xxxx.exe.

Note: If you use a Suss prober, the number of Subsite move setups used in your quick test (die test)
is important. It must be N-1; N is the number of subsites defined in the prober.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop function. When
the Procedure return condition box is checked in the Repeat Measurement Setup dialog box, the
repeat measurement will be stopped if status = True.

The device id is a string for the Device ID of the test result record.
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To Change Execution Flow

[ TestExecution |

| |Subsite F;rocedure| |

Yes

]
[ [Move to the 15t subsite |
[

To use the subsite procedure, change the flowchart as follows.
On the page 7-9, replace the box A with the block A shown above.
On the page 7-13 and 7-15, insert the box B shown above to the position B of the flowchart.
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Thermo-trigger — BISOSA and N1265A

HRepeat Measurement Setup

Start (Run)
Repeat Procedures Count=0
Slarl Pruvedure:
[C¥Program Files¥Agilent¥B1500¥EasyEXPERE | Erows... | | Start Procedure | |
Arquments: | =
Iteration Procedura:
C:¥Program Files¥Agilent¥B1500¥EasyEXPERE  Browse...
Angumerlis:l =

Final Procedure:
|C:¥Program Files¥Agilent¥B1500¥EasyEXPERE|  Biows... |

Al ants: .
rouments:| = @——> | Test Execution |
¥ Automatically fill in Device ID

Thermo-trigger

Count=Count+1 |
I” Enabled Thermo-trigger N1265A Thermo-trigger List.. | | | 1
Iteration Procedure | |

peat Stop n | Run
- e
Stop repeating by: 1
¥ Counter reaching to: |5 ] $

¥ Reset counter before repeating Yes [&—mM8M8M8Mmm™8™8™—
Canczl |

| Final Procedure | |

¥ Procadura retirn condition

|
[ 1f Abort is clicked } {

e Thermo_trigger

Thermo-trigger function is valid only when the N1265A ultra high current expander/fixture is used.

If this function is enabled, the repeat measurement execution flow is changed. See the next page.
The following steps are added.

1.After Count is judged, temperature (Temp) is measured.

2.If the measured temperature is in the range of the temperature condition (Center and Radius), the
action (Action) is executed after the delay time (Delay) elapsed. Or else, the temperature
measurement and this judgement are repeated.

The terms in (') are the parameters you can set by using the dialog box opened by clicking the
N1265A Thermo-trigger List button. The dialog box is shown in the next page.
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Thermo-trigger — Execution Flow

Delay time

Action:]NOP END

Test Execution (Status=True)

Thermo—trigeer List

Add | Deletel Up! | menl

Center

0.5 deg C
0.5 deg C End
0.5 deg C
0.5 deg C

0.5 deg C

Thermo-trigger List
dialog box for setting
temperature conditions

Import... Export... Ok Cancel Apply

To use the Thermo-trigger, change the flowchart as follows.
On the page 7-19, replace the box A with the block A shown above.

The Thermo-trigger List dialog box is used to set the temperature conditions. You can set a
maximum of 1001 conditions.

Temp specifies T1, T2, or T1-T2.

T1: Temperature value measured by the thermometer channel 1.
T2: Temperature value measured by the thermometer channel 2.
T1-T2: Difference between T1 and T2.

Center and Radius specify the temperature range, Center +/- Radius.
Delay specifies the delay time before Action is executed.

Action specifies TRIG, NOP, or END.

TRIG: Does the single test execution after the specified delay time, and then goes to the next
operation. This is useful to do the single test execution in the specified temperature range.

NOP: No operation (single test execution is skipped). Waits for the delay time, and goes to the next
operation. This is useful to wait in the specified temperature range.

END: Sets the status to True, and exits the repeat measurement after the delay time. This is useful to
exit the repeat measurement in the specified temperature range.
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Module 8
Miscellaneous Operations

In This Module

* Function Status Indicators

*  Run Option

* Automatic Data Export and Data Record
* Calibration

* Configuration

* XSLT Filters

* To Enable System Controller

* To Start Desktop EasyEXPERT

* To Use 415x Setup File Converter

This module describes the above topics. You will understand what is the function status indicator,
how to change the function status, how to perform selftest and calibration, how to perform SMU zero
offset cancel, and so on.
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Function Status Indicators

| Date

| Count | Device ID

2009/09/18 16:59:38
d 2008/10/02 16:20:46
4T 0.1V step  2008/02/05 11:24:50
2008/02/01 20:36:02
2008/02/01 20:36:02
2008/02/01 20:35:43

1
1
1
1
1

1

| Remarks |i|

Id-vd

[

T|_ Thermometer OFF| | Multi Display OFF || Standby GFF [ 10| SMU Zero OFF |5 Auto Export OFF f§ = Auto Record ON |

|55 Multi Display ON

4] dT:4.8 deg. C

[lb] Standby on

Standby function OFF m ON

PO} SMU Zero ON |

SMU zero offset cancel OFF mp ON

Multiple data display OFF = ON

Thermometer OFF =) T1: XX deg C ™ T2: XX deg C m dT: XX deg C

|51 auto Expart on

] Auto Record OFF

Automatic data record ON =) OFF

Automatic data export OFF m) ON

Function status indicators let you know the status OFF or ON of the following functions. The
indicators are placed at the bottom of the main screen.

Thermometer indicator shows the thermometer OFF status, temperature (T1 or T2) measured by the
thermometer channel 1 or 2, or difference (dT) between temperature values measured by the

channels 1 and 2.

T1, T2, or dT is shown while the Thermometer is enabled. They are toggled by clicking the indicator
if the channels 1 and 2 are enabled. Where, XX indicates the temperature value.

Multi Display OFF/ON: Shows the multiple data display function OFF or ON status.
Standby OFF/ON: Shows the standby function OFF or ON status.

SMU Zero OFF/ON: Shows the SMU zero offset cancel function OFF or ON status.

Auto Export OFF/ON: Shows the automatic data export function OFF or ON status.

Auto Record ON/OFF: Shows the automatic data record function ON or OFF status.

Clicking indicator controls the function ON/OFF directly or opens the dialog box or window which

controls the function status.
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Run Option

-

Save Data button

Auto Export and Auto Record status:

[SlavoespotofF [ auworecordon | o
[Blatoeporcon  [EaoRemdon | g appears if the last
BlauoEporton B auto Record OFF test result data is in

My Favarite Setup- ul
Run Option / _ the memory when

both Auto Export and

Device ID:

¥ Record Test Result Data Automatically
» Auto Record are OFF,
¥ #llocate Data Display for each test I
S ~—| and allows you to save
0
Close the last data as the

test result record.

Multi data display ON &5 it cisplay on —
&

—

, Auto Export OFF and Auto Record OFF
™ Record Test Result Data Autornatically [ST futo Expart oFF ] Auto Recard oFF
I_I Allocate Data Display for each test

Multi data display OFF
ﬂl ~ Multi Display OFF

Run Option button opens the Run Option dialog box used to change the status of the automatic data
record function, the automatic data export function, and the multiple data display function.

If the Record Test Result Data Automatically check box is checked, both or one of the automatic data
record function and the automatic data export function will be set to ON. To specify the function
status, see the next page.

If the Record Test Result Data Automatically check box is not checked, both functions are set to
OFF. In this status, both data record and data export are not performed. So the test execution time
will be reduced. Also, EasyEXPERT memorizes the last test result data. And it can be saved as a
test result record by clicking the Save Data button right next to the Run Option button. This status
will be useful for probe contact check, defect analysis, and so on.

The multiple data display function ON or OFF can be controlled by clicking the Multi Display
indicator or by using the Allocate Data Display for each test check box on the Run Option dialog
box.

About the multiple data display function:

If this function is OFF, the all test result data will be displayed on the singular Data Display window.
If this function is ON, the test result data of the same test setup name will be displayed on the
exclusive Data Display window and the test result data of the different test setup name will be
displayed on the new Data Display window.
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File Data Display Help
g @[ 1/V Sweep Setup Name: [I/V Sweep
5 easurement Setup | Function Setup | Auto Analysis Setup | Dis
5 Channel Setup | M 't Setup | Function Setup | Auto Analysis Setup | Di
3 Channel Definition ¥ Jrnable automatic data export to the specified storage device
-
[3 [~ Destination for Export
Add SMU
— —I Folder Path :
B Unit: V Name: I Name: Mode
& . C:¥ Temp¥EasyEXPERT¥ TestData a Browse...
o | Multi Channel - |SMU1:MP jl\’l H|‘1 !|V
i TV Sweep o
2 -File
. o [smuzmc vz ElE ElN & Default Format  Custom Format | sttinos
; IV List Sweep o [smuzmc (e [ [V e.q., # 'Setup Name' ['Device ID'(123) _Remarks’_; 2012_10_10
= N [~ File Typ:
— s o [smoamc -|[va 14 coMM
5 ‘\D I K| = =  Test Result ( EasyEXPERT format )
g
% | vv-t sampling £ Compressed Test Result ( EasyEXPERT format )
=]
L= . € oy
8
C-V Sweep My Format
My Format:
[C:#Program Files (x86)¥Agilent¥B1500: g Browse.
Czncs NN Ememna G e[ E
Select All
Unselzct Al
€ TextFile Settings,
Djsplay Data =)
Recall iscellaneous Variables P
| Data storage
L = e Index Name: nable automatic data record to the internal storage
Transport Data ML i.{
B ¥ Export s Test Result.
B~ . Exeort s Comoressed Test Result
7| Properties. Export fis O5Y. oK Cancel
» TV | Export s AL Sprezd Shest 9/09/18 16:59:38
. vih (AR 8/10/02 16:20:46
2 Char| Exgert As Text File B
g ALW  Text File Export Setting -
ALW  Folder Export IS auto Exprt ony B Auto Record oFF
PG 8
[Initial Workspace. # . Multi Display OFF |[&)] Standoy OFF b

The automatic data export function and the automatic data record function can be enabled or disabled
by using the Test Results Data Auto Export dialog box. This dialog box is displayed by clicking
these indicators or selecting the Results > Transport Data > Auto Export Setting... menu.

The automatic data export function is used to export the test result data automatically to the storage
device you specify. You can specify the destination (storage device), exported file name, and file
type. To set the automatic data export function to enable (set to ON), check the Enable automatic
data export to the specified storage device check box.

The automatic data record function is used to save the test result data to the internal HDD
automatically. This function can be disabled if the automatic data export function is enabled. To
disable the automatic data record function, remove the check from the Enable automatic data record
to the internal storage device check box.

Even if both data export and data record functions are enabled, the functions can be set to OFF by
removing the check from the Record Test Result Data Automatically check box on the Run Option
dialog box.
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Module Self Calibration JOY Calibration

Module Self Calibration |
| Name \ Full Range | Status | Notes
GNDU+ADC PASS
WGFMU1:RS,WGFMU2:RS ~ ---- PASS Unselect All
SMU1:HR PASS
SMU2:HR PASS
SMU3:MP PASS Start Calibration
I Full Range
Calibration
<] >
I~ Enable Auto Calibration

The Calibration window is opened by clicking the Calibration button. The Module Self Calibration
screen of this window is used to perform the calibration of SMUSs. The list area of this screen lists
Name, Full Range, and Status.

Name: Name of module. To select, check the left check box.

Full Range: For the high resolution SMU (HRSMU) connected to the atto sense/switch unit (ASU).
Full range calibration on or off.

Status: Calibration status. Pass or fail.

Notes: Error information when calibration failed.

To perform the self-calibration, specify the modules, open the measurement terminals of the
corresponding modules, and click the Start Calibration button.

Full Range Calibration:

For the HRSMU connected to the ASU. Enables or disables the full range calibration. If this box has
been unchecked, the BI5S00A does not use the 1 pA range.

Enable Auto Calibration:

Enables or disables the auto-calibration capability. If this box has been checked (function ON), and
the B1500A/B1505A automatically starts calibration for all modules every 30 minutes if the output
switches of all modules are off for 30 minutes.

NOTE:

To perform calibration correctly, open the measurement terminals. If auto-calibration is enabled, do
not forget to open the measurement terminals or disconnect the device under test from the terminals
after measurement.

8-6



Module 8

Miscellaneous Operations

SMU Zero Cancel JOY Calibration

SMU Zero Cancel

Name | Full Range | 1nA 100pA | 10pA | 1pA
O sMUL:HP
O SMU2:HR
O SMU3:HR
O SMU4:HR
1 SMUS:HR (41fa 35.9fA  16.28fA |

™ Full Range Integration Time:

Measure...
3 Close

]

PO} SMU Zero ON |

Select All Unselect All

The SMU Zero Cancel screen is used to perform the SMU zero offset current measurement and set
the SMU zero offset cancel function.

This function subtracts the offset current from the current measurement raw data, and returns the
result as the measurement data. This function is used to compensate the error factor (offset current)
caused by the measurement path such as the measurement cables, manipulators, or probe card.

To enable this function, perform the following procedure.
1.Check the left box of the Name column to specify the module to enable this function.

2.Click the Measure... button to perform the zero offset current measurement and wait until the
measurement is completed. The measurement data will be displayed in the appropriate cell.

3.Click the Close button to enable the zero offset cancel function.
To disable the function, uncheck the left box of the Name column, and click the Close button.

Note:

The offset cancel is not available for measurement over 100 nA range. For 10 nA range
measurement, the offset cancel is performed by using the 1 nA range offset value. For measurement
by a range less than 10 nA, the offset value measured by each range is used.

For more information, see online help or User’s Guide.
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Miscellaneous Operations

CMU Calibration JOY Calibration

CMU Calibration
- | [For the accurate ~
¥ Phase Compensation Measure. |  |measurement, perform
———  |Open/Shert/Lead correction
|at the measurement
}r:equer:u before starting the
| [cepecitence measurament
¥ Open Correction P | " a &

1[I the messurement frequency
ed in the default
ouen belarr, click

[~ Short Correction Measure.

[ Load Correction Moaturd |
- Advanced
Options...
Advanced Options for CMU Calibration

[Frequency | [Reference standard value |
& Use factory specified frequencies (Default) Open Reference
 Specify list of calibration frequencies Model: | Co-G =d

1MHz T ol Capaci i g
Conductance: [0 5 0]
Short Reference
Model: | Ls-Rs. d
0H []
 specify frequencies by range Resistance: [0 ohm []
start: | 8] stop:| ]| Load Reference
steps: | | scale: | = Model: [ LsRs -
0H []
[integration Time | g Foom  H
‘ © Auto Mode @ PLC Mode Factor: [16 O

13 Cancel

The CMU Calibration screen is used to perform the measurement data correction of the multi
frequency capacitance measurement unit (MFCMU). For the easy way, perform the phase
compensation and the open correction at least. The check boxes left of the Open/Short/Load
Correction and the Phase Compensation are effective after the corresponding measurement is
performed.

Measure...: Opens a dialog box used to perform correction/compensation data measurement. To
perform the measurement, follow the dialog box.

Advanced Options...: Opens the “Advanced Options for CMU Calibration” dialog box used to set
the frequencies for the correction data measurement and the reference values of the working
standard. See the next page.

To perform the open correction and the phase compensation, open the measurement terminals.
To perform the short correction, connect the measurement terminals together.

To perform the load correction, connect your load standard between the high terminal and the low
terminal.

NOTE:

For a more accurate measurement, perform Open/Short/Load correction at the measurement
frequency before starting the capacitance measurement.

If the measurement frequency is not included in the list of default frequencies below, click the
Advanced Options... button and set the measurement frequency on the Frequency area of the
Advanced Options for CMU Calibration window.

Default frequencies:

1k, 2k 5k 10k, 20k, 50k, 100 k, 200k, 500k, I M, 1.2 M, 1.5 M, 2 M, 2.5 M, 2.7 M, 3 M, 3.2
M,3.5M,3.7M,4M,42 M, 4.5M, 5 MHz
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Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency ‘ |Reference Standard Value |
# Use factory specified frequencies (Default) Open Reference
¢ Specify list of calibration frequencies Model: | Co-G hd
1 MHz l—E Capacitance: 1!] F =]
Conductance: 10 5 B

Short Reference

lete f t Model: | Ls-Rs =
Inductance: [0 H B

" Specify frequencies by range Resistance: |0 ohm B
Pk I EJ Slog l E] Load Reference

Steps: ] ;ij Scale; ] _] Model: | L5-Rs =

Inductance: ]D H Z]

|] bt ‘ Resistance: ]SU ohm B

‘ " Auto Mode  * PLC Mode Factor: 116 )

oK I Cancel ‘

This dialog box is opened by clicking the Advanced Options... button, and is used to set the
information required to measure the open/short/load correction data and the phase compensation
data. This dialog box provides the following action button.

OK: Applies the setup changes and closes this dialog box.

Cancel: Cancel the setup changes and closes this dialog box.

Frequency: You can select the measurement frequency setup mode from the following modes.
Measurement frequency setup modes:

Default (Use factory specified frequencies): Usually, select this mode. 23 points are automatically
set. They are 1 k,2k, 5k, 10k, 20k, 50k, 100k, 200 k, 500k, 1 M, 1.2 M, 1.5M,2 M, 2.5 M, 2.7
M,3M,32M,3.5M,3.7M,4M,42M, 4.5M, and 5 MHz.

Specifies by list: Select this mode when you want to set the frequencies independently. The
frequency must be 1 kHz to 5 MHz. The number of frequencies must be 1 to 101. Click Add to open
a dialog box, and enter the value. For the unnecessary value, highlight the value and click Delete.

Specifies by range: Select this mode when you want to set the frequencies sequentially and
automatically. Specify the start frequency, the stop frequency, the number of steps, and the scale
LINEAR/LOG. The start frequency must be less than the Stop value and at least 1 kHz. The stop
frequency must be more than the Start value and no more than 5 MHz. The number of steps must be
2 to 1001.

NOTE:
If the device measurement frequency is not equal to the correction data measurement frequency,
calculation will be performed automatically to get the correction data for the device measurement

frequency, and the calculated correction data will be used for the data correction of the measurement
data.
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Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency

Hneference Standard Value

1 MHz

" Specify frequencies by range

# Use factory specified frequencies (Default)

¢ Specify list of calibration frequencies

T

Open Reference

Model: | C0-G -
Capacitance: ;EF—E]
Conductance: ;—US—‘E
Short Reference
Model: | Ls-Rs =
Inductance: !IJ H B

Resistance: !U ohm B

start: | B stop: [ 5 Load Reference
Steps: I ;ij Scale; j L] Model: | L5-Rs =
Inductance: iﬂ H Z]
[Integration Time | Resistance: [50 ohm E

|l"" Auto Mode  # PLC Mode

Factor: 116 izl |

oK I Cancel ‘

Integration Time area defines the integration time used for measuring phase compensation data or
open/short/load correction data. The number of averaging samples (Mode=AUTO) or the averaging

time (Mode=PLC) is set.

Mode: A/D converter operation mode, AUTO or PLC.

Factor: Factor for the initial value. For details, see online help or user’s guide.
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Advanced Options for CMU Calibration

Advanced Options for CMU Calibration

Frequency

Reference Standard Value

# Use factory specified frequencies (Default)

¢ Specify list of calibration frequencies

1 MHz {_—‘E

" Specify frequencies by range

Start: I Ej Stop: i i E‘
Steps: I ;ij Scale; j L]
|]nIEgrah'on Time

‘ " Auto Mode  * PLC Mode Factor: ilﬁ )

Open Reference

Model: | Cp-G '
Capacitance: ;EF—E]
Conductance: ;—US—‘E
Short Reference
Model: | Ls-Rs =
Inductance: !I] H B

Resistance: !U ohm B

Load Reference

Model: | Ls-Rs -
Inductance: iﬂ H B

Resistance: iSU ohm B

oK I Cancel ‘

Reference Standard Values area provides the following entry fields used to set the reference values
of the open/short/load standard. If you use the standard, enter the reference values to the entry fields.

OPEN Reference: Capacitance and Conductance. If you do not use the reference, enter 0 in the both

fields.

SHORT Reference: Inductance and Resistance. If you do not use the reference, enter 0 in the both

fields.

LOAD Reference: Inductance and Resistance
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Main Frame Configuration

System Information |
Model Identification: |B1500A Line Frequency: |30Hz :l,
EasyEXPERT Rev.: |E.A.03.20.2008.081° Firmware Rev.: |E.A.03.20.2008.091;

Host ID: |00089bb7f1de

Main Frame Diagnosis |

| Item Status
Trigger I/O -
Digital I/O
Touch Panel Switch Unselect All
LCD -

High Voltage LED

Measurement LED

Start Diagnosis
Front Key

i

OEEEEEE

The Configuration window is opened by clicking the Configuration button, and is used to display the
system information and event log, as well as to perform diagnostics and self-test.

The Main Frame screen is used to display the system information and perform diagnostics.
Model Identification: Displays the instrument ID. B1500A or B1505A.

Line Frequency: Sets the power line frequency, 50 Hz or 60 Hz.

EasyEXPERT Rev.: Displays the revision number of the EasyEXPERT.

Firmware Rev.: Displays the revision number of the BIS00A/B1505A firmware.

Host ID: Displays the host id of the B15S00A/B1505A internal computer.

Main Frame Diagnosis: This area lists [tem and Status.

Item: Name of diagnostics item. To select, check the left check box.

Status: Diagnostics status. Pass or fail.

To perform diagnostics, specify the items to perform and click the Start Diagnosis button. A dialog
box is opened. Follow the dialog box to perform the diagnostics. Some items need your judgement,
pass or fail. Also you will need to connect an adapter, press keys, check LEDs, and so on.

The Host ID is important for the B1540A-002 users and the B1541A-002 users. It is necessary to
activate the EasyEXPERT or Desktop EasyEXPERT Software Plus features. For details, see the
Software Entitlement Certificate.
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Modules Configuration

Slot Configuration |
| Slot [ Module Type | Name | Status | SCUU | Notes
M 11 B1500A GNDU+ADC PASS
M 1 B1530A WGFMU1:RS,WGFMU2:RS PASS
B 2 BI517A SMU1:HR PASS Unselect All
B 3 BI517A SMU2:HR PASS
B 4 BI1511A SMU3:MP PASS
Start
Self Test
< | >
Accessory Configuration
Status LED: F

The Modules screen is used to perform self-test of modules.

Slot: Slot number where the module is installed. To select, check the left check box.
Module Type: Module model number

Name: Module name

Status: Self-test status, Passed, Failed, Recovered, or ---- (self-test has not been performed)
SCUU: Specifies if the module is connected to the SCUU.

Notes: Error information when the module self-test failed.

To perform self-test, specify the modules, open the measurement terminals of the corresponding
modules, and click the Start Self Test button.

Recover Module button is for the service use only. This button makes the failed modules respond
again. This button does not solve the problem that causes the Failed status.

Status LED: Enables (ON) or disables (OFF) the status indicator (LED) of the ASU (Atto Sense and
Switch Unit) and the SCUU (SMU CMU Unify Unit).
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ASU - B1500A Configuration

ASU List |
| Slot [ Module Type [ Name | ASU Serial Number [Asuy/opath |
5 B1517A/E5288A SMU3:HR/AS JP10M00172 SMU |
6 B1517A/E5288A SMU4:HR/AS JP10M00300 SMU
* NOTE: The specifications are satisfied and
guaranteed for the exclusive combination of the ASU ASU I/0 Path: |SHU =
and the HRSMU. So confirm the serial number of the
ASU and connect it to the dedicated HRSMU properly.

Only for the BIS00A. This screen is available if the B1500A installs the HRSMU connected to the
ASU (Atto Sense/Switch Unit), and shows the ASU information.

Slot: Slot number
Module Type: Type of module
Name: Module name or SMU name

ASU Serial Number: Serial number of the ASU registered as a pair with the HRSMU. This cell
displays an error message instead of the serial number if unpaired ASU is connected.

ASU I/O Path: ASU input to output connection, SMU or AUX

If the ASU I/O Path field is set to SMU, the ASU makes the path from the ASU Force input to the
ASU output.

If the ASU I/O Path field is set to AUX, the ASU performs automatic switching in every test. The
ASU makes the path from the AUX In input to the ASU output for the test without the HRSMU and
makes the path from the ASU Force input to the ASU output for the test with the HRSMU.
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Switching Matrix — B1500A Configuration

General Information |

Switching Matrix Type: |B22DDA Fernto Leakage Switch MainFrame o
GPIB Address: [22 g pall Self Test
B2200A/B2201A Input Port Configuration [ Extended Configuration ~ ||
SWM IN1: [SMULHP ~| I Kelvin swmino: [ =]
swminz: | 7] swMminio:| 0000 <]
SWM IN3: [SMUZ:HP ~| I Kelvin swaini: | <
swMing: | 0 ] swainiz:[| 7]
SWM IN5: | SMUZ:HR | I Kelvin SWM IN13: | CHULMF -] ™ cmu
swmine: | 7] swMmiNia:| 0000 <]
SWM IN7: | SMU4:HR | I Kelvin
swMins:| 0000 -]

Only for the BIS00A. This screen is used to establish the GPIB connection with Agilent
B2200A/B2201A/E5250A switching matrix and define the B2200A/B2201A/E5250A input port
connections.

Switching Matrix Type: Displays the type of the switching matrix or No Switching Matrix.

GPIB Address: Specifies the GPIB address of the switching matrix. 1 to 30.

Poll: Confirms if the switching matrix of the specified GPIB address is connected to the B1500A.
Start Self Test: Starts the selftest of the switching matrix.

SWM IN#: Switching matrix input ports. Enter the label used to specify the input port to the right
entry field. The port name and the connected module name can be the label. The character : (colon)
cannot be used. Checking the Kelvin check box grays out the coupled even number port. Checking
the CMU check box grays out SWM IN10 for the E5250A or SWM IN14 for the B2200A/B2201A.
The input ports IN11 to IN14 are not available for the ES250A.

Kelvin: Check this box if this port is used for the Kelvin connection.

CMU: To perform capacitance measurement through the switching matrix, check this check box and
set CMU1:MF to the SWM IN9 for the E5250A or the SWM IN13 for the B2200A/B2201A. And
connect MFCMU to the Input 9 and 10 of the E5250A or the Input 13 and 14 of the
B2200A/B2201A. To perform capacitance compensation, see User’s Guide.

Extended Configuration: Opens the Extended Configuration dialog box. See the next page.

Note: Standard revision of EasyEXPERT does not support the ES250. The E5250 control is a feature
of the B1540A-002/B1541A-002.

Note: The E5255A installed in the E5S250A is not supported.
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Extended Configuration — B1500A

Extended Configuration
Save As Hardware Profile |

To save current configuration as Hardware Profile, =
click this button. S
(CMU Compensation
Start
Self Test € No Compensation
B2200A/B2201A
|[Extended Configuration ~] & Select
DUTI/F: |B22204 ha
=

Cable: |16494A-002 (3 m) ol

" User Compensation Data File

2 I |

ES5250A
1U1:MF = I cMu

" User Compensation Data File (E52504)

4 H

Length:

Triaxial Cable: E| Meters
User Triaxial Cable: E| Meters
User Coaxial Cable: E| Meters

Close

This dialog box is opened by clicking the Extended Configuration button in the Configuration
window Switching Matrix screen.

Save as Hardware Profile is used to save the hardware profile that is the B2200A/B2201A/E5250A
hardware configuration and the measurement module connection. Click the Save button to save the
present hardware profile. The hardware profile can be made for each workspace individually.

CMU Compensation is used to select the compensation mode of the capacitance measurement using
the B2200A/B2201A/E5250A. Click one of the radio buttons, No Compensation, Select, and User
Compensation Data File. For the capacitance compensation, see User’s Guide.

* No Compensation:

Select this radio button if you do not need the capacitance compensation. The raw data without
compensation is displayed and saved.

« Select:

Select this radio button to perform the capacitance compensation for the path from the
B2200A/B2201A input ports to Agilent 16495F/G connector plate or Agilent B2220A probe card
interface. The data after compensation is displayed and saved.

DUT I/F field is used to specify the model number of the path you use. The selections are the
16495F/G and B2220A.

Cable field is used to specify the model number of the cable from the B2200A/B2201A output to the
DUT I/F. The selections are the 16494A/B/C-001/002/005. This mode cannot perform the
capacitance compensation for the cables to positioner/manipulator or the probe card.

* User Compensation Data File:

Select this radio button to perform the capacitance compensation for the path from the
B2200A/B2201A/E5250A input ports to the end of positioner/manipulator or probe card. See User’s
Guide. The data after compensation is displayed and saved.

Note: Standard revision of EasyEXPERT does not support the ES250. The E5250 control is a feature
of the B1540A-002/B1541A-002.

Note: The E5255A installed in the E5S250A is not supported.
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SMU/PG Selector — B1500A Configuration

16440A SMU/PG Selector

¥ Enable SMU/PG Selector

SMU Assignment: Input/Output Path:

Selector CH1:|5MUZ:HR _x|normaly PeU (AUX) x|
Selector CH2: |5MU3:HR. || Alvays sMU [
Selector CH3: |5HU4:HR. _>||mormaly PGU (AUX) =]
Selector CH4: |5MUS:HR || Always smu ]

Only for the BI5S00A. This screen is used to specify the input connection and the channel connection
status of the Agilent 16440A SMU/PG selector.

Enable SMU/PG Selector: Check this box to use the selector.
Selector CH1/CH2: Indicates the channels 1 and 2 of the first selector respectively.
Selector CH3/CH4: Indicates the channels 1 and 2 of the second selector respectively.

SMU Assignment: Specifies the SMU connected to the SMU input of the selector channel CHI,
CH2, CH3, or CH4.

Input/Output Path: Specifies the connection status of the selector channel CH1, CH2, CH3, or CH4.
Always SMU: Makes the selector channel “SMU on” state.

Normally PGU (AUX): Performs automatic switching in every test. The selector channel normally
makes the “PGU on” state and makes the “SMU on” state only for the test which uses the SMU
connected to the Input SMU terminal.

The CH1 and CH3 also provides the “PGU open” state which is set by using the Advanced window
of the Measurement Setup.
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SMU/PG Selector — B1500A

« Easy to switch between SMU and PGU
« Solid state relay

16440A Selector
Input SMU
Channel 1 —® ToDUT
Input PGU
Input SMU
Channel 2
—® ToDUT
Input PGU

SW1 & SW2 : Mechanical Relay
v Flash Memory Test SW3: Solid State Relay
v Transistor photomos

The selector has two channels as shown above. Each channel has two ports (SMU and PGU).

External pulse generators can also be connected. The connectors are Triax for SMUs and outputs,
and BNC for PGUs.

Up to two selectors (four channels) may be required for some reliability tests such as Flash
EEPROM.

As a special design for Flash memory, a solid state relay was added to float the drain. This
eliminates wear and tear of millions of closures that would occur with a mechanical relay.
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Dual HCSMU Combination Configuration
— B1505SA

Dual HCSMU Combination

[~ Enable Master HCSMU: I =
Slave HCSMU:I -

Apply |

Only for the BI505A. This screen is used to set the dual HCSMU operation.

Enable check box enables/disables the dual HCSMU operation. If this box is checked, the dual
HCSMU operation is enabled and two HCSMU modules can be a SMU which supports =40 A
(pulse), =2 A (DC).

Master HCSMU specifies the HCSMU module used as the master channel of the dual HCSMU
operation. The module must be connected to the Master port of the 16493S-020/021 dual HCSMU
adapter.

Slave HCSMU specifies the HCSMU module used as the slave channel of the dual HCSMU
operation. The module must be connected to the Slave port of the 164935-020/021 dual HCSMU
adapter.

Apply button applies the dual HCSMU operating condition. To apply the setup changes successfully,
the B1505A must be in the idle state and the Standby output must be OFF.
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Module Selector — B1505A Configuration

N1258A/N1259A-200 Module Selector

¥ Enable Module Selector

Input Output

HVSMU: [smusHy =

- Enable Series Resistor
(100k ohm) for HYSMU Default: |smUi:HP -

HCSMU: [smuzHC =
HPSMU: [suut:ip -

Diagnosis

Status: Communication Established Start Diagnosis

Status: ----

™ Auto Detection

Apply

Only for the BI505A. This screen is used to specify the input connection and the default input-
output path of the module selector.

Enable Module Selector check box is used to enable/disable the module selector. If this box is
checked, the module selector can be used.

Input: Specifies the modules connected to the module selector’s HVSMU, HCSMU/DHCSMU, and
HPSMU input ports respectively. For the port which no module is connected, blank the entry field.
The Enable Series Resistor (100 kohm) for HVSMU check box must be checked if you want to insert
the series resistor to the HVSMU path.

Output: The Default field is used to specify the module connected to the module selector output port
in the idle state. When a measurement is performed, the module specified by the test setup is
automatically connected.

Status: Shows one of the following status.
*Not Detected: Module selector has not been detected yet.
*Communication Established: Normal status. Module selector can be used.

«Communication Lost: Once the module selector was detected. However the communication has
been broken now.

Auto Detection check box is used to enable/disable the module selector automatic detection. If this
box is checked, the automatic detection of the module selector is performed when EasyEXPERT is
launched.

Start Diagnosis button is used to start the module selector diagnosis. And the Status shows the
diagnosis result.

Apply button applies the setting.
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Module Selector — B1505A

« Easy to switch High open, HPSMU, HCSMU/DHCSMU,
HVSMU, or HVSMU via 100 kohm

« Upto30Aand3000V

F: Force

S: Sense

P.A:
Protection adapter

GNDU force and sense

are connected to Low
sense line.

HVSMU force is connected
to High sense line.

GNDU HCSMU HPSMU HVSMU

Module selector is used to switch the measurement resource connected to the device under test
(DUT) automatically. The measurement resource will be HPSMU, HVSMU, or HCSMU/DHCSMU.
One selector provides one switching channel.

The N1258A is used with a DUT interface such as your own test fixture and prober station.
The N1259A with option 300 is for the packaged device test.

CAUTION: If dual HCSMU (DHCSMU) is used with the module selector, the maximum current
must be =30 A to prevent the module selector from performance degradation and failure.
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UHC Expander / Fixture Configuration
— B1505A

N1265A Ultra High Current Expander / Fixture |

[ Enable Ultra High Current Unit

Control Self Test Self Calibration
Voltage Control SMU: ISMU2:MC -l Start... Start... |
Current Control SMU: [spMU3:MC  « Status: ---- Status: ----

¥ Enable Selector [¥ Enable Gate Control
Input Output Gate Control

UHCU: ISMU?:UHCl 'l [# Enable Series Resistor SMU: ISMU4:MC -
100k ohm) for HVSMU
HVSMU: ISMU?:HV 'l ( :

Default: IGNDU:GND v[ Resistor: |1000 ~| ohm
SMu: ISMUl:MP v[

Thermometer

v Channel 1 [v Channel 2 Interval: |2 5 E Format: |T1={U},T2={1},T1-T2={2} deg. C g

Diagnosis
Start...

Apply Status: --—-

¥ Auto Detection Status: Communication Established

Only for the BI5S05A. This screen is used to set the N1265A ultra high current expander/fixture.
The N1265A can be controlled by the BIS05A via the Digital 1/0 connector.

Enable Ultra High Current Unit enables/disables the ultra high current unit (UHCU). If this box is
checked, Control, Self Test, and Self Calibration fields become effective. The UHCU is effective by
setting the Voltage Control SMU and the Current Control SMU. The UHCU can be identified by the
SMU set to the Voltage Control SMU. In this slide, SMU2 specifies the UHCU.

Enable Selector enables/disables the N1265A built-in selector. If this box is checked, the Input and
Output fields become effective. The Input field specifies the UHCU and the measurement resources
connected to the selector’s HVSMU and SMU inputs. The Output field specifies the Default
measurement resource connected to the selector output in the idle state. When a measurement is
performed, the measurement resource specified by the test setup is automatically connected. Enable
Series Resistor (100 kohm) for HVSMU enables/disables the 100 kohm series resistor on the
HVSMU path.

Enable Gate Control enables/disables the Gate path of the N1265A.

Thermometer Channel 1 and Channel 2 enable/disable the thermometer of the N1265A. Interval sets
the temperature measurement interval, and Format specifies the format for recording the temperature
data. The data is recorded by adding to the end of the Device ID string. Variables {0} for the
channel 1 temperature, {1} for the channel 2 temperature, and {2} for the difference between {0}
and {1} are available for setting the format.
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N1265A UHC Expander / Fixture — B1505A

« SMU path, 3 Kelvin (6 non-Kelvin)

« UHVU path, up to 10 kV

« UHCU path, up to 1.5 kA, through built-in selector
« Gate path

« CMU path through bias tee

« Thermometer, 2 channels

B1505A N1265A UHC expander/fixture
Digital 170 Digital 1/0
Interlock Interlock High
GNDU GNDU " DuT _ | Drain
HVSMU f---->] HVSMU—0 g
HP/MPSMU}---->| SMU—0  o— T [«
% Source
UHCU «
MC/HCSMU I-control Low
MC/HCSMU V-control

N1265A is a test fixture which contains a ultra high current expander (UHC expander) and a built-in
selector.

The fixture provides several paths listed above and the thermometer channels.

The UHC expander configures the ultra high current unit (UHCU) which supports up to 500 A or 1.5
kA with the option N1265A-015. And the output can be connected to the device under test (DUT)
through the built-in selector.

The selector output can also be extended to a prober station by using the N1254A-524 prober system
cable.
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N1265A Built-in Selector — B1505A

o Easy to switch the open condition, GNDU only, UHCU only, or
GNDU with SMU, HVSMU, or HYSMU via 100 kohm

« Upto1l.5KkA and 3000 V

1 Gate o 2 Low - 5 High ; o
ow® ig ensecD orce ensecD @ orce : Force
— ¢ b S: Sense
‘ 1 b I ® b l P.A: Protection adapter

\ \ \‘ 100 kQ

HVSMU force is

S E connected to
S||F UHCU High sense line.
F V-control| [l-control § F F

MCSMU GNDU MCSMU MCSMU  SMU HVSMU

S

N1265A built-in selector is used to switch the measurement resource connected to the device under
test (DUT) automatically. The measurement resource will be UHCU, SMU, or HVSMU. One
selector provides one switching channel.

The N1265A also provides the series resistor control for the Gate path. The resistance can be
selected from 0, 10, 100, or 1000 ohm.
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HVSMU Current Expander
— B1505A

Configuration

N1266A HVSMU Current Expander

[V Enable High Voltage Medium Current Unit
Input/Control

HVSMU: |SMU?:HV vl
Voltage Control SMU: Ismuz;Hc vl
Current Control SMU: ISMUB:MC vl

Output
[" Enable Series Resistor (100k ohm) for HVSMU
Default: |

["' Auto Detection Status: Not Detected

Apply |

Self Test

Start... |

Status: ——-

Only for the BI505A. This screen is used to set the N1266A HVSMU current expander. The
N1266A can be controlled by the BIS05A via the Digital I/O connector.

Enable High Voltage Medium Current Unit enables/disables the high voltage medium current unit
(HVMCU). If this box is checked, Input/Control and Output fields become effective. The HVMCU
is effective by setting the HVSMU, the Voltage Control SMU, and the Current Control SMU. The
HVMCU can be identified by the SMU set to the Voltage Control SMU. In this slide, SMU2

specifies the HVMCU.
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N1266A HVSMU Current Expander — B1S05A

o Easy to switch High open, HYMCU, HVSMU, or HYSMU via
100 kohm

« Upto25Aand3000V

B1505A N1266A HVSMU current expander
MC/HCSMU > |-control
MC/HCSMU V-control High
HVMCU DUT Drain
A
HVSMU HVSMU ———o [«
VV o
Open Source
GNDU > GNDU 1 L N1261A-002
OW ™ oro0a1) [
Digital I/0 Digital 170

*1: N1261A-002/004 protection adapter is required for connecting prober.
Not requred for connecting N1258A, N1259A, N1259A-300, or N1265A.

N1266A is used to expand the HVSMU maximum current up to 2.5 A. The N1266A also provides a
built-in selector to switch the measurement resource connected to the device under test (DUT)
automatically. The measurement resource will be HVMCU or HVSMU. The GNDU is always
connected to the Low output terminal.

The Output field shown in the previous page specifies the Default measurement resource connected
to the selector output in the idle state. When a measurement is performed, the measurement resource
specified by the test setup is automatically connected. Enable Series Resistor (100 kohm) for
HVSMU enables/disables the 100 kohm series resistor on the HVSMU path.
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UHV Expander
— B1505A

Configuration

N1268A Ultra High Voltage Expander

¥ Enable Ultra High Voltage Unit
Input/Control

Voltage Control SMU: ISMU2:MC vl
Current Contrel SMU: |s|\.1u3;|\.1c vl

[" Auto Detection

Status: Not Detected

Apply

Diagnosis
Start...
Status:

Only for the BI5S05A. This screen is used to set the N1268A ultra high voltage expander. The
N1268A can be controlled by the BIS05A via the Digital I/O connector.

Enable Ultra High Voltage Unit enables/disables the ultra high voltage unit (UHVU). If this box is
checked, Input/Control fiecld becomes effective. The UHVU is effective by setting the Voltage
Control SMU and the Current Control SMU. The UHVU can be identified by the SMU set to the

Voltage Control SMU. In this slide, SMU?2 specifies the HVMCU.
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N1268A UHV Expander — B1S05A

« Ultra high voltage up to 10 kV

—— Interlock circuit

B1505A N1268A UHV expander
MCSMU I-control Interlock Output
MC/HCSMU V-control .

High

Interlock > Interlock Input Low

Digital 170 Digital 170 _|

I—» UHV Low Gate

MCSMU Gate Source
MCSMU Chuck Chuck

DuT

Gate [

Source

Drain

Chuck

N1269A UHV connection adapter

N1268A is used to expand the maximum voltage up to 10 kV.
If you use the N1265A test fixture, connect the UHVU output High and Low to the N1265A UHV

High and Low terminals.

If you use a prober station, use the N1269A UHV connection adapter as shown above.
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SMU Output Setting Limit Configuration
_ B1505A

SMU Output Setting Limits

Voltage Setting Limit: IlD kv @I
Current Setting Limit: |1_5 kA El

Apply |

This screen is used to set the upper limit of the SMU output
value and compliance value.

Voltage Setting Limit: Sets the upper limit of the voltage output value and compliance value.
Effective value: 200 V to 10 kV, in 100 V step.

Current Setting Limit: Sets the upper limit of the current output value and compliance value.
Effective value: 1 Ato 1.5 kA, in 1 A step.

Apply button applies the setting.
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Event Log

Configuration

4/11/2006 4:48:33 PM

Event Log |
Date/Time ] Message 1 D ] Process User Host
4/12/2006 3:00:35 PM  Configuration query completed. 110001 StaDaemon B1500user B1500A-0...
4/12/2006 3:00:29 PM  Service started successfully. 102001  StaDaemon  B1500user B1500A-0...
4/12/2006 2:25:56 PM  Service stopped successfully. 102002 AppSetup B1500user B1500A-0...
4/12/2006 2:00:41 PM Service started successfully. 102001 AppSetup B1500user B1500A-0...
4/12/2006 2:00:38 PM  Service stopped successfully. 102002  StaUpd B1500user B1500A-0...
4/12/2006 2:00:37 PM  Service started successfully. 102001 Stalpd B1500user B1500A-0...
4/12/2006 1:52:48 PM  Service stopped successfully. 102002 StaDaemon B1500user B1500A-0...
4/12/2006 12:44:00 ... Configuration query completed. 110001 StaDaemon B1300user B1500A-0...
4/12/2006 12:43:51 ... Service started successfully. 102001 StaDaemon B1500user B1500A-0...
4/12/2006 12:40:29 ... Service stopped successfully. 102002 AppSetup B1500user B1500A-0...
4/12/2006 12:14:57 ... Service started successfully. 102001 AppSetup B1500user B1500A-0...
4/12/2006 12:14:53 ... Service stopped successfully. 102002  StaUpd B1500user B1500A-0...
4/12/2006 12:14:52 ... Service started successfully. 102001 Stalpd B1500user B15004-0...
4/11/2006 6:30:48 PM  Service stopped successfully. 102002 StaDaemon B1500user B1500A-0...
4/11/2006 6:50:47 PM  GPIB timeout occurred.Int... 103008 StaDaemon B1500user B1500A-0...
4/11/2006 4:51:15 FM StaDaemon B1500user B1500A-0...

StaDaemon B1500user

B1500A-0...

This screen displays the event log.

Date/Time: Displays date and time of the event.
Message: Event message

ID: Process ID of the event

Process: Process name

User: User name. Windows login name.

Host: Host name of the BIS00A/B1505A

The Refresh button refreshes the event log.
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XSLT Filters

Select XML Style Sheet File
Lookin: [ 3 X5LT o & ek E-
File Data Display Help 5 [#csv sl
% [ca +| @ Trng idvd idvg Setup Na Lﬁ \meas_index_meta-csv.xsl
= Y o] _ MyRocert | iPimes_inderx_metartabosv.xs!
5 |CEn PErai i s Documents |ig8inas,index_meta-miss.xsl
§ |0 awos | - = I Fmess_ndex-csv xsl
= |0 irect contrt| 7| Hold: [05 | Delay: [0 =
g u mess_index-tzb-svaxsl
= |0 oiscrete Desktee |igneas rdexamice. s
m meas_meta-csv.xsl
SO EPR— i Fimeas_meta-tab-sv.xs!
IZlmeas_mete-xmiss.xsl
My Format: | o o5 ———
[€:Program Fies\Agient\B1500\EasyEXPERT\Utiites\XSLT\meas_index_meta-cov.i e (_Browse__) — (mess-tab-sv.xe
:ile fmeas-smiss.xsl
e s
LIS hamiss. xsl
-5
My Network  Filz name: [mezs_index_meta-covsl ) Open
Trng Idvd' — Flaces
\?/(h Gate: |SMU3:HR v Files of type: XL Style Shest Fies = ﬂ]
Al Igcomp: [10ma @
&= Export As B]%]
Cancel Vg_Vistart: [500mv B Savein: | (3 DATA | e@mcrEr
Select All vg_vistep: [[0mv ] » [i @R SAVPL_NEG_HOLD.XTR @FZERC_CHECKXTR
Unsclect Al 3 € Ti6106ITR  @7ERO_CHECK ASUXTR
\Vg_Vistop: [2.000V B Recent EMO KPG
Display Data g Dobyrents @y vercise X
Recall ( @ crmax TR
Source: [SMU2:HR ¥ ¢
Filter »
: .
| Edit » (s Test Result...
FE—— Compressed Test Result...
u | Export AS\CSV.
T’ﬂg Ig Export As WL Spread Sheet... 8:36:42 A
Click this button Arey If_gm n 1y Format. 8:35:03 A e
gscvl 0:44:34 PARALLEL.KTR
qscui | FolderBeport. 7 4:34:20 @ - &l
. . . 1. ! GSCVL | Auto Export Setting ... 7 4:20:09 j\ i
Highlight this line TFT Id- My Network il e | - Sove
s - Places
I Smeastpe  [A Fies - Cancel

The XSLT (XSL-Transformation, eXtensible Stylesheet Language Transformation) filter files are
used to export test records. The fifteen filter files listed below are stored in the
C:¥Program Files¥Agilent¥B1500¥EasyEXPERT¥Utilities¥XSLT folder.

The following filter files are used for exporting the measurement data only.
meas-csv.xsl, meas-tab-sv.xsl, meas-xmlss.xsl

The following filter files are used for exporting the measurement data with the index.
meas-index-csv.xsl, meas-index-tab-sv.xsl, meas-index-xmlss.xsl

The following filter files are used for exporting the measurement data with the meta data.
meas-meta-csv.xsl, meas-meta-tab-sv.xsl, meas-meta-xmlss.xsl

The following filter files are used for exporting the measurement data with the index and the meta

data.

meas-index-meta-csv.xsl, meas-index-meta-tab-sv.xsl, meas-index-meta-xmlss.xsl

The following filter files are used for exporting all data including the test setup.

csv.xsl, tab-sv.xsl, xmlss.xs

Where, the meta data contains the test name, the setup name, the record time of the test results, the
device ID, the counter number, the flag of the test results, and the remarks on the test results.

Filter files that contain xm/ss in the file name export test record in the XML Spread Sheet format.

Filter files that contain csv or tab-sv in the file name use a comma or a tab for the data separator.

For more information, see online help or User’s Guide.
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Fle Opton

Agilent 10 Library Connection Expert
e ) <4

Start EasyEXPERT

To Enable System Controller

_ hgilent 82350 PCI GPIB Interface - GPIBO &)

[Hodify configurable properties for this GPIB PCI interface card

VISA interface Dt

GPIB ackress!

im0 v

B

| Hsistem contoler ecommenciea) |

T nterface 10

' Agilent Connection Expert

PR

File Edit View I/O Configuration Tools Help

=

Logical unit;

gpibd v
N

B Refresh Al o8 Lo
Task Guide

Tasks for This Interface

2 Propeties

18 interactive 10 B Add nstument B Add Inteface 9 Delete.

S

Refiesh al

2 Refresh this GPIB interface
£

Changeproperties
P Gk

5 8, 51500800065
55 Com1 (asRLY)

An Agilent GFIB interface card installed in a FCI ot in this

Q=

Change Properties

g o e
X o Seriel rumber Myasss0as2
T adiress: 7
eneral Tasks )
System Controle: No =
4y Refreshal ;
t= SICL nterfaee I0: apb0
g Ao enivtnmnt Logiealurit 7
Auto-dscover: No
IMore Information
@ fonseiwmea
@ ‘owoismmes?
) Where canTfind
programming samples?
L= vl
4 b¢] I I3

to thisinterface

’4

' Reboot Required

to reboot now?

Reboot Now:

RebootLater:

Cancel Changes:

Changes to the /O configuration were detected that require the computer
system be rebooted in order for the changes to take effect. Would you like

I Reboot Now I

The system wil reboot immediately. Save any unsaved workin other.
‘appications before pressing this.

‘ou wil choose when to reboot. Some of the changes made in
necton il not be viibe t0 other t
system s rebooted.

The changes that led to this required reboot il be discarded. You
willoose some recent wark you have dane.

Reboot Later Cancel Changes Help

Agient VISA s the prmany VISA lbrary

To control external GPIB devices, the B1500A/B1505A must be set to system controller. Exit the
EasyEXPERT, and close the Start EasyEXPERT window. After that, launch the Agilent Connection Expert by
clicking Start, All Programs, Agilent IO Library Suite, and Agilent connection Expert.

On the Agilent Connection Expert, change the GPIB configuration of the BIS00A/B1505A.

«Select GPIBO.

*Click Change Properties. .. button.

*Change GPIB address to 21 that is the typical address number for the system controller.

*Check System controller box.

Click OK button.

*Reboot the BIS00A/B1505A.
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To Start Desktop EasyEXPERT

GPIB Communication
Codre
8 ot GPIB address: |7 vl
Start EasyEXPERT & Offiine
‘ Model: |B1SO0A >
B15004 [l (u]'4 Carcel
File | Option

Execution Mode
EasyEXPERT Databaze »

Database Backup Creation Wizard

Database Restoration Wizard

Mave To

Backup EasyEXPERT Database
Festore EasyE=PERT Database
Move EasyEXPERT Database

EasyEXPERT Database Path:

[ #usere1 Browse...
Cancel

4

To open the Start EasyEXPERT window, click Start > Programs > Start EasyEXPERT menu. This
window provides the Option menu used to open the following dialog box.

Gpib Communication:

Select Online if the BIS00A, B1505A, 4155B/C, or 4156B/C is connected to your computer and you
want to control it via GPIB. Or else select Offline.

Database Backup Creation Wizard:
Use this wizard to create the EasyEXPERT database backup (xdb file).

Database Restoration Wizard:
Use this wizard to restore the EasyEXPERT database backup. The wizard can restore the xdb file or
the backup which is a copy of the folder that contains the EasyEXPERT database.

EasyEXPERT Database:
Specify the EasyEXPERT Database path if you want to move the database to the other folder.

To launch Desktop EasyEXPERT, click the Start EasyEXPERT button.

Note: Desktop EasyEXPERT supports most of the EasyEXPERT functions. However, some
functions are not supported on an external computers due to differences in hardware and so on.

Note: For the installation procedure, see the readme file stored in the Desktop EasyEXPERT CD-
ROM.

Note: For the offline mode. To use the same module configuration as the BIS00A/B1505A, copy
the UnitConfigB1500A.xml/UnitConfigB1505A.xml file to your PC which the Desktop

EasyEXPERT runs. The file is stored in the BI500A/B1505A hard disk drive. For details, see “To
Install Desktop EasyEXPERT” in Agilent B1540A User’s Guide or Online Help.
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Import

I 1

- goooooan

{
i

(file extension: MES or DAT (file extension: XTS)

b[SetupFileConverter.exep

Execution example:

[4155/4156 setup file EasyEXPERT setup file
)

C:¥Mydata>SetupFileConverter.exe setupl.dat
C:¥Mydata>SetupFileConverter.exe *.mes

You can reuse the 4155/4156 setup file (MES file or DAT file) for the test using EasyEXPERT. This

is realized by Setup File Converter which has the function to create the XTS file by converting the
MES or DAT file to the EasyEXPERT format. This executable file is stored in the following folder.

C:¥Program Files¥Agilent¥B1500¥EasyEXPER T¥Ultilities

You can execute the setup file converter on the Command Prompt as shown below. If you want to
use the Windows desktop instead of the Command Prompt, see the next page.

1. Create your working folder (for example, C:¥415xdata).

2. Copy your MES or DAT files to this folder.

3. Copy SetupFileConverter.exe file to this folder.

4. Launch the Command Prompt.

5. Go to your working folder (for example, C:¥> cd 415xdata).

6. Execute SetupFileConverter.exe as shown in the following example.
C:¥415xdata> SetupFileConverter.exe *.MES

This example converts all MES files in your working folder to the EasyEXPERT setup file format,
and creates the XTS files in this folder.

Note: If you execute the setup file converter without the parameter, the help message will be
displayed.

Note: The setup file converter provides some options. See User’s Guide or online help for the
options.
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To Use 415x Setup File Converter
1. Drag and drop the shortcuts of the MES/DAT file on

nthe shortcut of the Setup File Converter.

R

3. XTS file and shortcut are created.

2. File conversion is executed and system message is displayed.
ol

SetupFileGonverter.exe : Uersion A.A3Z.18

Start Conversion : E:\Documents and Settings\nGIL4155.RGILENT\Desktup\R.
ES1.DAT

ExportFile ¢ E:\Documents and Settings\AGIL4155.AGILENT“\Desktop-RE|

Setuplersion : HP4155_CB2 .24
Conversion successfully completed.

——— Press Enter key to guit.

You can perform the file conversion on the Windows desktop as follows.

1. Create a shortcut of the SetupFileConverter.exe on the desktop.

2. Copy your MES/DAT files to the desktop.

3. Drag and drop the shortcuts of the MES/DAT files on the shortcut of SetupFileConverter.

This starts the file conversion and displays the system message. And if the conversion is completed
successfully, the setup file converter creates the XTS files and the shortcuts on the desktop.

Note: The setup file converter provides some options. See User’s Guide or online help for the
options.
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B9 Aeilent 4155/4156 Setup File Gonverter for Windows

File  Help

- FSelect | P Convert 3 Glear

To Use 415x Setup File Converter

Click [Start] — All Programs — Agilent BISO0A EasyEXPERT
— 4155,4156 Setup File Converter

Create XTS for:

& B1500A
O 41558/C
O 41558/C with HPSMU
O 4156B/C
) 41568/ with HPSMU

Selected Files:

C ¥V THGM.MES

Start Conversion @ C:¥VTHGM.MES

ExportFile T Cr¥VTHGM.xts

SetupVersion : HP4155_C03.10
Conversion successfully completed.

|

To create XTS file:

The following procedure converts the 4155/4156 setup file (.DAT or .MES) and creates the .XTS file
in the folder the setup file is stored.

1. Click Select icon, or click File > Select Files to open the Select 4155/4156 MES Files or DAT

Files dialog box.

2. Specify the 4155/4156 setup files to convert. Multiple files can be selected.
3. Click Open on the Select 4155/4156 MES Files or DAT Files dialog box.

4. Click Convert icon, or click File > Convert Files.

To read XTS file, use the import function to read the created .XTS file on the EasyEXPERT.
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